Sage 100 Contractor 2014
(Formerly Sage Master Builder)
United States Edition
Product Overview
Version 19.3
## Contents

### Chapter 1: Welcome to Sage 100 Contractor ......................................................... 1
- Sage 100 Contractor—A better way to run your business ........................................ 1
- Sage 100 Contractor Printed and Printable Documentation ...................................... 1
- Printing Sage 100 Contractor Documentation ...................................................... 2
- Sage 100 Contractor In-product Help .................................................................. 2
- Customer Support and Resources .................................................................. 3
- Training Resources ......................................................................................... 6
- Business Partners ......................................................................................... 6
- Business Forms ............................................................................................ 6
- Sage 100 Contractor Add-on Modules ............................................................ 6
- Document Conventions and Notes ................................................................ 8

### Chapter 2: Companies, Security, and Users ....................................................... 10
- Working with Utilities .................................................................................. 10
- License Administration Tool .......................................................................... 10
- Security Groups and Users .......................................................................... 11

### Chapter 3: General Ledger ............................................................................. 17
- Chapter 1: General Ledger ........................................................................... 17
- Ledger and Subsidiary Accounts .................................................................... 17
- Company Departments ................................................................................ 23
- Checks and Bank Charges ........................................................................... 23
- Deposits and Interest .................................................................................. 24

### Chapter 4: Accounts Receivable ................................................................. 35
- Working with Accounts Receivable ............................................................. 35
- Invoices, Credits, and Statements ............................................................... 35
- Cash Receipts and Electronic Receipts ......................................................... 44
- Jobs ............................................................................................................. 47
- Receivable Clients ..................................................................................... 49
- Progress Billing .......................................................................................... 51
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loan Draw Requests</td>
<td>51</td>
</tr>
<tr>
<td>Unitary Billing</td>
<td>52</td>
</tr>
<tr>
<td>Time and Materials</td>
<td>52</td>
</tr>
<tr>
<td>Recurring Receivables</td>
<td>53</td>
</tr>
<tr>
<td><strong>Chapter 5: Accounts Payable</strong></td>
<td>54</td>
</tr>
<tr>
<td>Working with Accounts Payable</td>
<td>54</td>
</tr>
<tr>
<td>Payable Invoices/Credits</td>
<td>55</td>
</tr>
<tr>
<td>Work in Progress and Percentage Complete Accounting</td>
<td>56</td>
</tr>
<tr>
<td>Vendor Payments</td>
<td>58</td>
</tr>
<tr>
<td>Vendors (Accounts Payable)</td>
<td>62</td>
</tr>
<tr>
<td><strong>Chapter 6: Payroll</strong></td>
<td>74</td>
</tr>
<tr>
<td>Working with Payroll</td>
<td>74</td>
</tr>
<tr>
<td>Employees</td>
<td>74</td>
</tr>
<tr>
<td>Payroll Records</td>
<td>76</td>
</tr>
<tr>
<td>Compute Payroll</td>
<td>81</td>
</tr>
<tr>
<td>Direct Deposit</td>
<td>81</td>
</tr>
<tr>
<td>Posting Payroll to the General Ledger</td>
<td>83</td>
</tr>
<tr>
<td>Payroll Calculations</td>
<td>83</td>
</tr>
<tr>
<td>Workers’ Compensation</td>
<td>100</td>
</tr>
<tr>
<td>Employee Positions</td>
<td>101</td>
</tr>
<tr>
<td>Paygroups</td>
<td>101</td>
</tr>
<tr>
<td>Local Payroll Tax</td>
<td>102</td>
</tr>
<tr>
<td>Federal and State Filing</td>
<td>103</td>
</tr>
<tr>
<td><strong>Chapter 7: Project Management</strong></td>
<td>106</td>
</tr>
<tr>
<td>Working with Project Management</td>
<td>106</td>
</tr>
<tr>
<td>Project Work Center</td>
<td>107</td>
</tr>
<tr>
<td>Budgets</td>
<td>110</td>
</tr>
<tr>
<td>Job Costs</td>
<td>110</td>
</tr>
<tr>
<td>Change Orders</td>
<td>111</td>
</tr>
<tr>
<td>Cost Codes and Divisions</td>
<td>116</td>
</tr>
<tr>
<td>Purchase Orders</td>
<td>117</td>
</tr>
<tr>
<td>Subcontracts</td>
<td>118</td>
</tr>
<tr>
<td>Job-Complete Tracking</td>
<td>119</td>
</tr>
<tr>
<td>Proposals</td>
<td>119</td>
</tr>
</tbody>
</table>
Unitary Proposals .................................................................................................................. 120
Document Control .................................................................................................................. 120
7-8 Contact Manager ............................................................................................................ 125

Chapter 8: Reviewing and Reporting .................................................................................. 127
  Working with Review and Reporting .................................................................................. 127
  Selecting and Creating Reports ......................................................................................... 127
  Dashboard Reports ............................................................................................................. 132
  Form/Report Page Design ............................................................................................... 142
  Using Report Writer .......................................................................................................... 149
  Report Printing .................................................................................................................. 150
  Report Scheduling ............................................................................................................ 152
  Exporting Data to Microsoft Excel .................................................................................... 156
  Financial Review ............................................................................................................... 159
  Project Review .................................................................................................................. 163

Index ..................................................................................................................................... 164
Chapter 1: Welcome to Sage 100 Contractor

Sage 100 Contractor—A better way to run your business

Welcome to Sage 100 Contractor. Sage 100 Contractor is an integrated, construction-specific, estimating, accounting, and project management software solution. Whether you are a general contractor, a subcontractor, or service contractor, Sage 100 Contractor manages your business using one system.

Sage 100 Contractor provides many features that are beneficial for customers with complex environments that may include remote connections, many simultaneous users, and/or multiple companies.

Sage 100 Contractor Printed and Printable Documentation

Sage 100 Contractor and Your Business

*Sage 100 Contractor and Your Business* provides basic information about key relationships in your business and how they interact with Sage 100 Contractor. This book also explores Sage 100 Contractor’s underlying concepts for working with general ledger, accounts payable, accounts receivable, and more. In addition, you will find detailed information about Sage 100 Contractor general operational features, accounting, analysis, payroll, accounts receivable, accounts payable, and more.

Sage 100 Contractor Installation and License Administration Guide

The *Sage 100 Contractor Installation and License Administration Guide* provides explicit information about how to install Sage 100 Contractor and set up the software in your specific environment. It also provides information on how to set up and administer licensing. This guide is a “must read” for all systems administrators and business owners.

Sage 100 Contractor Product Overview

*Sage 100 Contractor Product Overview* provides background information to help you understand the core functionality of Sage 100 Contractor and how to use it to manage your business. If you are new to Sage 100 Contractor, then we highly recommend that you read the specific background information about the tasks that you will perform. If you are a company owner or administrator, we recommend that you read all the information in this guide.

Sage 100 Contractor User Guide

The *Sage 100 Contractor User Guide* is a printable-PDF version of the Sage 100 Contractor Help. You will find that the Sage 100 Contractor User Guide is the most comprehensive yet. It provides extensive explanation of Sage 100 Contractor functions and tools as well as hundreds of procedures for completing tasks.

Sage 100 Contractor Release Notes

The *Release Notes* document provides information about enhancements and previously reported issues in the software that have been resolved for the current release.

It also provides, where applicable, information and comments about recently discovered issues that have not yet been resolved before the latest software release.
Printing Sage 100 Contractor Documentation

Links to the printable documentation are located under the Home & Resources tab > Printable Documentation menu on the Sage 100 Contractor main window.

**IMPORTANT:** You must have the Adobe®Reader® installed on your computer to view and print Sage 100 Contractor guides. To download this free software for viewing and printing documents in PDF format, visit http://get.adobe.com/reader/

To print a Sage 100 Contractor printable document:
1. On the main window, click Home & Resources tab > Printable Documentation.
2. From the menu list, select the printable document you want to open. Adobe Reader opens and loads the guide.
3. From the File menu, click Print.
4. To print a section of pages, from the Adobe Reader Print window, select Print Range > Pages from, and type a range of pages.

Sage 100 Contractor In-product Help

Using Help

The in-product Help system is integrated with Sage 100 Contractor and accessible from the Help menu. On the Help menu, you can click Contents and Index, About This Window F1, and Quick Links Shift+F1.

Contents and Index opens the Help system to the main page. From this Help window, you have access to the entire Help system.

When you are on a Sage 100 Contractor window, clicking About This Window or pressing the F1 key launches a Help window that provides information about the currently active Sage 100 Contractor window.

Clicking Quick Links or pressing Shift+F1 opens a Help window that provides a list of topics directly related to the currently active window.

About the Help navigation

The window opens automatically with the left-hand navigation pane in view displaying three tabs.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Navigation/Search Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents</td>
<td>A table of contents displays a list of headings and subheadings with lists of all the topics in the Help.</td>
</tr>
<tr>
<td>Index</td>
<td>The index displays subjects by keywords and sub-keywords.</td>
</tr>
<tr>
<td>Search</td>
<td>By typing in a keyword and clicking List Topics, the system searches all Help topics for the entered words.</td>
</tr>
</tbody>
</table>
### Button | Action
--- | ---
Back | Opens the topic viewed previously.
Forward | Opens the next topic in a previously viewed sequence.
Home | Loads the Help title page.

---

**Customer response system for Help topics**

To improve our in-product Help documentation, we are soliciting a response based on your experience using the Help topics. We want to know, “Did this topic help you?” We will review your comments and consider them when making changes to our documentation.

When you respond, your responses are sent via the Internet to our Web-based collection system. Please understand that when you respond, no personally identifiable information is collected. We cannot respond to customers individually.

![NOTE:](image)
The Web pages connected to the customer response system for in-product Help topics appear only if you are logged on to or have access to the Internet.

---

**Customer Support and Resources**

**Before you contact Customer Support**

Before you decide to contact the customer support call center, be sure to take advantage of the resources available to you. These services are available 24 hours a day, 7 days a week.

**Sage 100 Contractor Help**

From anywhere within the software, you can access this comprehensive library of easy-to-find topics to learn more about specific procedures, topics, fields, or buttons.

**Sage Knowledgebase**

Depending on your Sage service plan, we also offer a web-based Sage Knowledgebase and online user community forums at [www.sagecre.com](http://www.sagecre.com) or through the in-product menu. Our staff maintains an extensive knowledge database of questions and answers covering everything from frequently asked questions to more complex problems and solutions. In addition, we keep all product reference documentation available in the Knowledgebase. This online tool is the same tool we use in our customer support call center to help answer your call.

**To access the Technical Support Knowledgebase:**

2. On the Welcome page, in the left column, click **Knowledgebase Search** to open a list of products.
3. Complete **Step 1** by selecting Sage 100 Contractor from the list of products.
4. Complete **Step 2** by entering a search term in the box.
5. Click **Search**. The search results appear below the box.

**Sage 100 Contractor InfoCenter**

Find Sage 100 Contractor software notices and all the information you need, such as industry news, products, services, new enhancements, tips, training, special offers and more.
Technical Documentation Available

A number of guides are included in the software. Access important release information such as system requirements, software enhancements, quickly and easily. Click the Home & Resources tab > Printable Documentation or Resources > Printable Documentation if you have Activity Centers hidden to see the available PDF files. You can also find the PDF files in the Documentation folder in \Program Files (or Program Files (x86))\Sage\Sage 100 Contractor\.

Sage 100 Contractor Virtual Conference

Interact with and learn from Sage Construction and Real Estate senior leadership, product experts, and fellow customers online. Get the latest information on product updates as well as network and share experiences with your peers. Check the Sage 100 Contractor InfoCenter at http://www.na.sage.com/sage-100-contractor/infocenter-news for current virtual conference information.

Contacting Customer Support

Contact Customer Support in the United States and Canada at:

Toll free: 800-866-8049
Or 503-690-6775

www.sagecre.com

Hours of Operation

Telephone support is available Monday through Friday from 6 a.m. to 5 p.m. Pacific Time with the exceptions listed below.

- Every Thursday from 2 p.m. to 3 p.m. Pacific Time, closed for staff meetings.
- Standard United States holidays.
- Quarterly company meetings.

You can also submit your request for customer support online 24 hours a day, seven days a week by logging on to http://na.sage.com/us/sage-construction-and-real-estate. Our customer support team will reply to your questions during normal support hours.

Any additional closures will be communicated by our regular customer email newsletters.

When You Contact Customer Support

Depending on your Sage service plan, you may be able to contact the Sage Customer Support Call Center to work with one of our highly trained customer support professionals. Before you call, be sure to have the following information on hand so we can handle your call efficiently.

<table>
<thead>
<tr>
<th>Question</th>
<th>How to Find the Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is your Sage client ID number?</td>
<td>Your client ID number can be found on correspondence you receive from Sage. If you do not know your Sage client ID, contact the person at your company who maintains your relationship with Sage.</td>
</tr>
<tr>
<td>What software version are you using?</td>
<td>To find the version, open Sage 100 Contractor; click Help &gt; About Sage 100 Contractor and note the number listed.</td>
</tr>
<tr>
<td>Question</td>
<td>How to Find the Answer</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>What application or area in the software are you calling about?</td>
<td>On the menu list, identify the application and number where are you are work (i.e. Selecting Invoices to Pay in 4-3-1, Accounts Payable Vendor Payments).</td>
</tr>
<tr>
<td>How can we help you?</td>
<td>Walk through the exact steps you completed with as much detail and accuracy as possible.</td>
</tr>
<tr>
<td>Is there an error message?</td>
<td>Write down the exact wording of the message.</td>
</tr>
<tr>
<td>Can you reproduce the issue?</td>
<td>Were you able to walk through the same steps that led to the problem and see whether it happened again?</td>
</tr>
<tr>
<td>Is this the first time the problem has happened? Does the problem occur on one workstation or several?</td>
<td>Ask other users if they have experienced the same problem. Have them test at their workstation to see if they experience the same problem. Also, have the original user try other workstations to see whether the problem is specific to that user.</td>
</tr>
<tr>
<td>Has anything changed with your software, hardware, or workflow?</td>
<td>Ask your network administrator for technical information regarding anything that may have changed behind the scenes: upgrades to Sage 100 Contractor, new third-party software installations, moving of data from one server to another, new printers or print driver installation, or anything else that might affect the network.</td>
</tr>
<tr>
<td>Does the problem happen in the sample data sets?</td>
<td>Select [File&gt; Open Company], then change the drive letter on the dropdown to C:, select Sample Company.</td>
</tr>
<tr>
<td>What kind of network are you using?</td>
<td>If you do not know, contact your network administrator.</td>
</tr>
<tr>
<td>What operating system is on your computer?</td>
<td>For Vista: Click [Start], type winver in the ‘start search’ window and click [OK].</td>
</tr>
<tr>
<td>What printers and print drivers are installed?</td>
<td>If you do not know, contact your network administrator.</td>
</tr>
<tr>
<td>When was your last backup?</td>
<td>If you do not know, contact your network administrator.</td>
</tr>
</tbody>
</table>

**Responding to You**

Our analysts work with you to respond accordingly to the urgency of your issue. Call urgencies range from a simple explanation of software settings to critical situations in which work is stopped or data integrity is compromised. Some calls may warrant further research and followup, in which case our support analyst will place your call in his/her in-progress work list. At every step of the way, we work with you to until a resolution or agreement can be reached.

Depending on your Sage Service plan, you may check the status or update, or even create a new support ticket online:

2. Click the [Customer Support] button.
4. Next, select the Support tab and choose the [Self Service] button.
Training Resources

When you choose to take online classes from Sage or work with a Sage business partner, you will learn how to use Sage 100 Contractor to support your business. Contact your business partner to find out about training options or visit Sage University at: https://sageu.csod.com.

Online Classes

Online classes help you maximize your use of Sage 100 Contractor. Online classes are a convenient training option for your company and new users to learn more about Sage 100 Contractor so you can get the most out of the software. You can select from classes on all aspects of Sage 100 Contractor, including project management, estimating, scheduling, service management and payroll. Each online class is led by an instructor with years of experience using Sage 100 Contractor. During the class, you will be able to follow along as the instructor demonstrates functions and workflows in Sage 100 Contractor. In the online live session, you can ask questions and benefit from hearing answers to other students’ questions.

For more information, visit https://sageu.csod.com.

Getting Started as a New User

We recommend that all new users should begin with our New Customer Training (NCT) series, which is included in our Essentials Training Package in recorded format for 24/7 access. If you prefer live online training led by an instructor, you can register for the Realtime Learning version of these NCT courses. For more information, visit https://sageu.csod.com.

Business Partners

To serve you better, Sage 100 Contractor products and services are available to you through an authorized network of business partners. Business partners have local expertise and regional knowledge working with contractors in the region.

Your business partner is available to serve you, from simple how-to questions and hands-on demonstrations, to installation, implementation, and training. They’re fully equipped to help you get where you want to be. For more information, contact your Sage 100 Contractor business partner.

Business Forms

Sage 100 Contractor is designed to work with generic checks and forms that are available from many sources. There is no single vendor that customers must use; however, you can get a complete portfolio of forms, tax forms, and checks through Sage Construction and Real Estate Forms by calling 800-760-7929 or by visiting www.sagecreforms.biz.

Sage 100 Contractor Add-on Modules

There are currently 5 add-on modules for use with Sage 100 Contractor: “Estimating," "Equipment," "Document Control," "Inventory," and the combined “Service Receivables/Inventory.”

Estimating

The Sage 100 Contractor Estimating Basic module allows you to stay on top of the estimating process from start to finish thanks to multiple takeoff options, industry-specific pricing databases, and integration with Sage 100 Contractor accounting modules. By automating and streamlining your estimating processes, you'll ensure that every detail is accounted for and your cost projections are accurate.

Global variables, formulas, and templates make your estimating process easier and more accurate. You can selectively factor in cost increases, lock prices to prevent accidental edits, and add notes for clarity. Windows functionality (such as
cut, copy, and paste) allows you to import blocks of information from other estimates with just a few clicks of the mouse. All grids are Microsoft® Excel® compatible—you will not have to learn a new interface if you have been using spreadsheets. After the takeoff is complete, you can generate the budget, the proposal, requests for proposals, purchase orders, and subcontracts. You can even email them directly to your subs and suppliers without printing them out.

With the data import feature, you can import a parts list or update prices directly from your suppliers. The simple assembly tools help you build new assemblies without leaving your takeoff (available in 9-5 Takeoffs). With just a few mouse clicks, you can copy, adjust, or create assemblies from scratch.


You can also step up to the next level with Sage Estimating Standard and Extended versions, powered by trade-specific cost databases, enabling you to turbo-charge takeoffs and final proposals. Input your own costs into a pre-built database or choose a database pre-populated with costs. For more information about Sage Estimating, visit http://na.sage.com/sage-estimating.

**Equipment**

Build your bottom line by better managing equipment. Track and charge all equipment costs directly to your jobs, helping your company recoup these outlays. Sage 100 Contractor equipment management includes:

- Job allocation capabilities. Improve job cost data—and job profitability analysis—by allocating equipment costs to specific jobs.
- Maintenance reports. Take advantage of down time and optimize your schedule with up-to-the-minute equipment maintenance schedule reports.
- Financial information. Make more informed decisions by analyzing depreciation information with automatically created reports and disbursements.
- Analysis reports. Use cost, maintenance, and revenue records to quickly determine equipment profitability.
- Rent, lease, or buy analysis. Compare ownership, lease, or rental options to make the right equipment decisions for your company.
- Cost recovery analysis. Determine the optimal cost recovery rate for each piece of equipment.

For more information on the Equipment add-on module, visit http://na.sage.com/sage-100-contractor/modules/service-management.

**Document Control**

Complete project documentation with all the forms you need. Avoid disputes and communicate effectively with employees, customers, and subcontractors with Sage 100 Contractor document control capabilities. Create and track responses to critical project documents such as:

- Requests for Information (RFIs). Document your requests and match to information received.
- Transmittals and submittals. Track all correspondence and replies.
- Plan records. Maintain plan revisions and document the delivery of critical reports to all parties.
- Daily field reports. Generate a complete diary of job site information including payroll, subcontract, units complete, equipment use, meetings, incidents, and more.
- Punch lists. Effectively and completely close each phase of every job with up-to-the-minute to-do lists, including who is assigned to the work and who is responsible for payment.

**Inventory**

Keeping track of inventory items is easy with integrated estimating, purchase orders, accounts payable, job-costing, and service work orders. Whether you need to track inventory for a central warehouse or for a number of locations and service trucks, Sage 100 Contractor Inventory can handle it.

Inventory also can manage both basic stock and serialized items for all locations, bin numbers, Materials Safety Data Numbers (MSDN), manufacturer identification, and multiple vendors with different order numbers for the same part.

Truck restocking can be run from the work orders completed each day so that your warehouse staff can restock trucks at night after your service technicians bring them in.

You can move inventory in Sage 100 Contractor from one location to another, apply inventory to a job, re-price inventory, post shrinkage, or create finished goods inventory from stock items and labor. A template feature can save repetitive transactions for future use.

Resource reports from service work orders let you see which items will be needed in the future, making the ordering easy. And since Estimating integrates into Inventory, your estimators will always know if items are in stock and what your latest price is for any item.


**Service Receivables and Inventory**

Service Receivables include service contracts, service routes, service dispatch, on-call work orders, quotes, point-of-sale and billing-of-service work and materials. This option is integrated with the Inventory module for automatic decrementing of inventory from work orders. You can maintain your service truck inventory with parts assigned to truck or warehouse inventory.

Service dispatch is displayed in 15-minute, hourly or daily increments. Work orders are displayed with user-definable color codes showing client, priority, and ZIP Code. You can review information about equipment installed at the client’s site. Items can be billed individually or as part of an assembly. The flat-rate billing option allows you to create and print your own price book for technicians to use. The same parts and assemblies databases are used for estimating and for service, making it easy to keep your entire system updated.

Service Receivables seamlessly integrates with payroll to eliminate the need for duplicate entry of labor hours.

**Document Conventions and Notes**

**Understanding documentation conventions**

Standard text formats are used in all the guides  to help you find information.
<table>
<thead>
<tr>
<th>Convention</th>
<th>Definition</th>
</tr>
</thead>
</table>
| **Bold**   | Indicates a component such as a menu, menu command, dialog box, check box, button, list or option.  
Indicates the names of ledger accounts, account ranges, and reports.  
Indicates the names of operators and fields.  
Indicates the syntax of queries. |
| **Courier Bold font** | Indicates text that you must type into Sage 100 Contractor.  
Indicates the names of expressions and functions. |
| Courier font | Indicates the name of a file or a folder. |
| Key1+Key2 | The plus (+) sign indicates that you should press and hold down the first key while you press the second key. For example, Alt+C indicates that you should press the Alt key and hold it while you press the C key; then release both. |
| **Italic** | Indicates the titles of printed or printable documents.  
Indicates variable values or parameters within expressions. |
| (See links) | (Help only) Indicates that there is a hypertext link to a topic related to that step in the procedure. Look for it in the links list at the end of the procedure. |
| How? | (Help only) Indicates that there is a hypertext link to a specific procedural topic. |

**About note styles and their meaning**

There are four levels of notes in this guide: **Caution!**, **Important**, **Note**, and **Tip**.

**CAUTION:** Read all information presented in a caution note. It advises you that failure to take or avoid a specific action could result in a loss of data.

**IMPORTANT:** This type of note provides information essential to the completion of a task. You can disregard the information in a regular note and still complete a task, but you should not disregard an important note.

**NOTE:** A note provides positive information that emphasizes or supplements important points of the main text. The information in notes may only apply in special cases, such as memory limitation or details that apply to specific versions of Sage 100 Contractor.

**TIP:** A tip is a type of note that helps you apply the techniques and procedures described in the text to their specific needs. A tip may suggest alternative methods that may not be obvious and help you understand the benefits and capabilities of Sage 100 Contractor.
Chapter 2: Companies, Security, and Users

Working with Utilities

The 7-Utilities windows enable you to setup security, create users, create companies, and to perform maintenance functions. The supervisor user with exclusive access rights must perform many of these tasks.

List of 7-Utilities Windows

- **7-1 Create New Company**—Create a new blank company or copy selected data from an existing open company to create a new company.

- **7-2 Company Information**—Enter company information into the system, such as address, license numbers, tax numbers, direct deposit information, and more.

- **7-3 Company Security**—Contains two sub-menu windows:
  - **7-3-1 Security Groups**—Create security groups and set security for Save, Delete, Void, Print Checks, and more.
  - **7-3-2 User List**—Set up a list of users in the current company. To save time, you can also copy user defaults.

- **7-4 Rebuild Indexes**—Rebuilds the database indexes for the company that is currently open.

- **7-5 Update Databases**—Rebuilds the database indexes for all the companies that located in the current company's drive.

- **7-6 Repair Database**—Opens the Support Password window. This is only need to repair damaged databases. You need to contact Customer Support for assistance. Database damage can be caused by a power failure or hard disk failure.

  **IMPORTANT:** The maintenance task carried out in **7-6 Repair Database** requires contact with Customer Support.

- **7-7 Scheduled Reports Manager**—View and delete events recorded when scheduled reports are executed.

- **7-8 Contact Manager**—7-8 Contact Manager allows you to add and update 3-5 Jobs (Accounts Receivable), 3-6 Receivables Clients, and 4-4 Vendors (Accounts Payable) contact records in your Outlook contacts .

- **7-9 Alerts Manager**—Use 7-9 Alerts Manager to view, created, edit, and import custom alerts and program alerts that are viewable in the Dashboard and email.

License Administration Tool

License Administration window

Use the License Administration window to view and maintain your licensing information. This includes the number of license uses, the users who are logged on to Sage 100 Contractor, and licensing events.
Your Sage 100 Contractor software automatically retrieves license information from Sage every day. The licenses give you access to the various modules of Sage 100 Contractor. As you purchase or remove license activations, the Sage license server automatically updates this information in your system. You can also select to update the licensing information from Sage on demand.

**Security Groups and Users**

**Security features of Sage 100 Contractor**

Sage 100 Contractor provides a variety of security features that allow you to restrict access to data in each company. You can do the following:

- Create a list of users and passwords for each company. This list provides the means to restrict access to individual companies. Restricting access to a company also restricts access to its archive.
- Create groups of users. Security groups provide a way to collect users together in meaningful sets such as project managers, payables clerks, or payroll clerks. With groups established, you can then assign each user to up to five security groups.
- Control the admission of users to windows through security groups and assign access rights to each security group.
- Control items within windows such as text boxes, lists, check boxes, and grid columns. By limiting what information a security group can enter or view in a window, you also restrict access to that same information in queries and reports. For example, you might not want to allow the payroll clerks security group access to salaries and wage rates in the employee files. The payroll clerks will not be able to view salaries and wage rates in the employee files, or while entering timecards, or by running any payroll reports.

Each company in Sage 100 Contractor can use different user names, passwords, security groups, and access rights. You only have to set up security groups and access rights one time for each company. As you add or remove users from the **User List**, you can simply assign or reassign users to the proper security groups.

**IMPORTANT:** Many actions in Sage 100 Contractor can only be performed when logged on as supervisor. When setting up security, it is critical that you add a password for the user name supervisor.

**About security groups**

Use the **7-3-1 Security Groups** window to set up security groups for your company’s employees.

Security groups let you control users’ ability to open windows as well as perform specific actions within a window. The **7-3-1 Security Groups** window contains a grid with numbered rows on the left and eight columns:

- Group# (User input is required to save the record.)
- Group Name (User input is required to save the record.)
- Save
- Delete
- Void
- Chg Period
- Print Checks
- Notes
When you set up user groups, you type a group number and group name. Then you determine whether or not that group will have rights to **Save, Delete, and Void** records, as well as to change the accounting period and print checks. You may use the Notes column to add any pertinent information about each group.

While you might create security groups for specific employees, it is a good idea to build each security group for the tasks performed by the employee. This allows you to add or remove employees from security groups rather than having to build new security groups for each new employee.

As the company size increases, the need for additional security groups increases. For example, a large company has an office staff that includes several accounts payable clerks, an accounts receivables clerk, a payroll clerk, a controller, project managers, and estimators. In this company, six different security groups are set up to accommodate the specific needs of the employees engaged in six different task areas.

In addition to creating task-oriented security groups, it is a good idea to create one security group with full access to the entire program. This allows owners or managers to log in with full access, but prevents unauthorized access to program features that only a user logged in as supervisor can use.

It is important to consider the scope of tasks performed by users as well as the number of users that access Sage 100 Contractor. Before designing security groups, examine which users need access to specific windows in Sage 100 Contractor. After you set up the security groups, you can then set up window and menu-level security.

For example, a small company has three clerks: a general accounting clerk, an accounts payable and accounts receivable clerk, and a payroll clerk. For this company, it is only necessary to create three security groups. The first group, titled **Payroll Clerk**, only provides access to payroll operations. The second group, titled **A/P A/R Clerk**, provides access to accounts payable and accounts receivable operations. The third group, titled **General Ledger Clerk**, provides access to general ledger operations not covered by accounts payable and accounts receivable.

Consider the following before setting up security groups:

- Do you need to create separate security groups for employees who perform specific tasks? For example, does your company have a payables clerk who only enters payables data?
- Do you need to create separate security groups for accounts payable, accounts receivable, and payroll supervisors, or can you just create one group for the supervisors?
- Do estimators perform different tasks than project managers?
- Do you need to provide differing levels of access to owners, controllers, or managers?
- Are you going to use the Sage 100 Contractor API to integrate with other programs? If so, create a security group named **API** with a group number such as 51.

**IMPORTANT:** To use the Sage 100 Contractor API program, you must create an API security group that is named exactly **API**. At least one user must be added to the API security group. You have to set rights to save, void, etc.

About setting field properties

You launch the **Field Properties** window by pressing the F7 key when in another data entry window, for example, 4-2 **Payable Invoices/Credits**. In the **Field Properties** window, you can set up the default properties for almost any text box, check box, grid cell, or column within a window. You can set the following options:

- **Default Entry to:** Provides a list of entries from which you can select the default. Enter the default data, or click the item in the list you want to appear as the default entry.
- **Permit Access to:** Lets you select which user groups have access to a window, text box, list, or grid column. If no user groups are selected, then all user groups have access. If the user groups appear shaded, then you cannot restrict access.
• When a user group is not granted access to a window, that user group cannot open the window. In addition, the user group cannot access the information by printing documents or reports.

• When a user group is not granted access to a text box or list, that user group cannot enter or access information in that text box or list, or access the information using a query, quick list, or Lookup window. In addition, the user group cannot access the information by printing documents or reports.

• When a user group is not granted access to a grid column, that grid column is hidden from view and is not accessible by the user group. In addition, the user group cannot access the information by printing documents or reports.

• **Skip During Entry:** During data entry, Sage 100 Contractor skips over the field or list. You can still enter data when you select it.

• **Require Entry:** Requires an entry, or Sage 100 Contractor will not save the record.

• **Require List Match:** Requires that the entry match an item on the Quick List.

• **Require Unique:** Prevents users from entering duplicate information. This is available for indexed text boxes that let you enter character-based information.

  • When you select this property for the Invoice# box in 3-2 Receivable Invoices, 6-6-1 Purchase Orders, or 6-7-1 Subcontracts, Sage 100 Contractor ignores records that have status 5-Void.

  • When you select this property for the Work Order and Invoice# boxes in 11-2 Work Orders/Invoices/Credits, Sage 100 Contractor ignores records that have status 5-Void.

  • When you select this property for the Invoice# box in 4-2 Payable Invoices, Sage 100 Contractor ignores records that have status 5-Void for a given vendor. You can set up a vendor to use duplicate invoice numbers.

• **Lock After Save:** Prevents users from editing the information after saving the record. Only users logged in as supervisor can edit the information.

• **Lock Quick List:** Prevents users from editing a Quick List. Only users logged in as supervisor can edit the information.

• **Check Spelling:** Checks the spelling when you move to another text box or cell. If Sage 100 Contractor finds a misspelled word, it displays the Spelling dialog box.

• **Mixed Case:** Allows text entry in upper and lower case.

• **Upper Case:** Displays text only in upper case.

• **Lower Case:** Converts entry to lower case text.

• **User Defined Field Type:** Lets you select the type of information the field accepts.

• **System Description:** Displays the default description of the field.

• **User Description:** Lets you change the description of the field. To display the system description again, delete the user description.

• **System Prompt:** Displays the default prompt that appears in the status bar at the bottom of the window.

• **User Prompt:** Allows you to change the default prompt in the status bar at the bottom of the window. When the user prompt is deleted, the system prompt is restored.

**Setting up properties**

Using the F7 key, you can set up the default properties for almost any text box, list, check box, grid cell, or column within a window.
**IMPORTANT:**
- Access to set up these properties is limited to the supervisor user.
- You cannot restrict access to system-required fields.

For example, you may want to autopopulate certain fields in a window to speed up the work. In some cases, it is essential for certain fields to be hidden from view for business purposes.

### About the 7-3-2 User List window

The **7-3-2 User List** window controls major features dealing with users and program security.

If you are a supervisor user, you can use the grid in this window to set up a list of user names for each company folder to help control access to Sage 100 Contractor.

By setting up security groups and assigning the groups to user names, you can further limit access to certain modules or windows, and text boxes, lists, and columns within windows.

Because Sage 100 Contractor determines access through the user names, a user can log on to Sage 100 Contractor from any workstation in a network environment.

By selecting the **Display Passwords** check box, a supervisor user can view, set and/or change users’ passwords.

If you want certain users to only see the job-related information for the jobs they manage, you can assign them to job-level security using the Subject to Job Security column.

**NOTE:** Any user can be a member of the API security group; however, we recommend that you create a specific user to use the API, for example, “APIUser.”

### About the supervisor user

When you log on to Sage 100 Contractor as supervisor, you have access rights to the entire Sage 100 Contractor application.

**IMPORTANT:** To maintain security, we strongly recommend that you set up a password for the supervisor user. Be sure to write it down and keep it in a safe place.

Following is a list of actions you can only perform when logged on to Sage 100 Contractor as supervisor:

- Create security groups in **7-3-1 Security Groups**.
- Grant access rights to security groups for windows and items within windows such as text boxes, lists, and grid columns in **7-3-1 Security Groups**.
- Grant job-level security to specific users in **7-3-2 User List**.
- Use the F7 key to display the **Field Properties** dialog box to set the individual security properties for a text box, list, check box, or grid column, as well as set security for certain menu commands from the main menus. You can also customize the window, set defaults in specific fields, and set system user prompts.
- Create user names and passwords, and assign user names to security groups in **7-3-1 User List**.
- Create new companies in **7-1 Create New Company**.
- Make and save changes to the General Ledger in **1-8 General Ledger Setup**.
- Archive the accounting at the fiscal year-end in **1-6 Period/Fiscal Year Management**.
- Close payroll at the calendar year-end, which starts on **5-4-5 Close Payroll Year**.
- 15 -

- Restrict posting to specific accounting posting periods, for example, 4-2 Payable Invoices/Credits and other windows.

About window and menu-level security

Window-level security lets you limit a security group’s ability to open specific windows within Sage 100 Contractor. You can set up window-level security on a menu command that opens a window or sub-level window.

Suppose a small company has three security groups: General Ledger Clerk, A/P A/R Clerk, and Payroll Clerk. Using the window and menu-level security, you can allow only members of the General Ledger Clerk group access to windows related to general ledger operations; the A/P A/R Clerk group access to windows and accounts receivable operations; and the Payroll Clerk group to payroll operations.

For menu commands that open a window, Sage 100 Contractor only allows access by users in the selected security groups and applies the access rights.

For menu commands that open a different menu item, Sage 100 Contractor only allows access by users in the selected security groups. For example, you can provide the General Ledger Clerk group access through menu 1-General Ledger. However, this does not apply the access rights to the items under menu 1-General Ledger.

About access rights regarding window and menu-level security

**CAUTION:** Without window and menu-level security set up, Sage 100 Contractor gives all access rights to the user opening the window.

When you assign a user to a security group, that user gains the access rights associated with its security group. Sage 100 Contractor applies the access rights only when you have set up window-level and menu-level security on a menu command that opens a window.

Suppose a security group titled General Ledger Clerk has been assigned only the right to save and delete records. Each window under the general ledger—1-1 Checks/Bank Charges, 1-2 Deposits/Interest, 1-3 Journal Transactions, 1-4 Recurring Journal Transactions, 1-5 Bank Reconciliation, 1-6 Period/Fiscal Year Management, 1-7 Ledger Accounts, 1-8 General Ledger Setup, and 1-9 Company Departments—is then set up with window and menu-level security. Only the General Ledger Clerk group has the ability to open those windows.

- Example 1: When Gerald (in the General Ledger Clerk group) opens the 1-1 Checks/Bank Charges window, the access rights only permit him to save and delete records.
- Example 2: A security group titled Payroll Clerk has been assigned the rights to save records, change posting periods, print checks, and void or delete records. Each window under payroll is set up with window and menu-level security. Only the Payroll security group has the ability to open those windows.
- Example 3: When Dianna (in both the General Ledger Clerk and Payroll Clerk groups) opens any of the payroll windows, she has the access rights assigned to the Payroll Clerk group. And when Dianna opens any of the general ledger windows, she has the access rights assigned to the General Ledger Clerk group.

To set up window and menu-level security

1. Log on to the company as supervisor.
2. Select the menu command, and then press F7.
3. Select the groups to which you want to provide access.
4. Click OK.
**About exclusive access**

While users in a network environment can simultaneously work in the same company’s data, some operations require access to a company be restricted to a single user.

For example, exclusive access is required when rebuilding indexes, copying a company to create a new one, or archiving the accounting at the fiscal year-end. To protect the data, limit the access of a company to a single workstation during rebuilding indexes and archiving the fiscal year.
Chapter 3: General Ledger

Chapter 1: General Ledger

Working with General Ledger

As the backbone of the accounting system, General Ledger pulls together information from Payroll, Accounts Receivable, Accounts Payable, Inventory, Service Receivables, Equipment Management, and other features. You can also make direct entries for cash, checks, deposits, journal transactions, and recurring transactions.

A tight audit trail creates a well-protected system from accounting to job costs and automatically audits all stored balances back to their original entries.

General Ledger maintains true subsidiary ledgers with lookup windows for each controlling account to simplify data entry to all 12 accounting periods for the current fiscal year, and you can control posting to any period. Entries made to the prior year automatically update the prior year’s ending balances as well as the current year’s beginning balances.

TIP: Sage 100 Contractor devotes an entire program section to major accounting reports in 2-Accounting Reports.

Ledger and Subsidiary Accounts

About general ledger accounts

In the 1-7 General Ledger Accounts window, you can view a summary of activity for an account broken down by fiscal period. As an aid to organizing the financial data, you can use subsidiary accounts or departments.

You can manually enter a budget for each ledger account that takes into consideration the activity of each period within the fiscal year. Over the course of the fiscal year, you can generate reports detailing the budget versus actual account activity.

Sage 100 Contractor also stores period balances for the previous fiscal year. When you archive at the fiscal year-end, Sage 100 Contractor transfers the period balances from the This Year column to the Last Year column.

Comparisons between the account activity of the current year and the budget or account activity for the prior year provide a valuable way for you to analyze the company finances. The comparisons enable you to create budgets with greater accuracy, determine areas in the company that are over or under budgeted, and compare projections to the actual activity.

Because the 1-7 General Ledger Accounts window only displays account activity, you cannot enter adjusting entries in this window. If you need to correct a period balance, you can enter the transaction using the 1-3 Journal Transactions window.

In ledger accounts, you can organize data using departments or subsidiary accounts. Departments allow you to group data across the income and expense accounts, whereas subsidiary accounts allow you to divide data under a single, controlling ledger account. Sage 100 Contractor also allows you to set up summary accounts, which allow you to combine ledger accounts for financial reports.
Learning more about ledger accounts

Ledger accounts are divided into two categories: permanent accounts (also called balance sheet accounts) and temporary accounts (also called profit and loss or income statements). Assets, liabilities, and equity accounts are referred to as permanent accounts. With permanent accounts, a period’s ending balance carries forward to become the beginning balance for the following period. Therefore, the period balances provide you with a running total over the course of a fiscal year.

The income and expense accounts are referred to as temporary accounts. With temporary accounts, the balance for each period is recorded separately. When a period closes, the following period starts with a zero balance. Temporary accounts only provide the activity for each individual period and not the year to date.

When you choose a pre-built chart of accounts, Sage 100 Contractor creates the ledger accounts. You can then edit the ledgers to create the type of accounts needed. When you post the first transaction to a company’s books, Sage 100 Contractor locks the system of ledger account ranges. To change the account number for a ledger account after having posted a transaction to it, create a new ledger account manually and transfer the balance through an adjusting journal entry.

You can rename a ledger account at any time. Sage 100 Contractor uses the short name for Picklists and most accounting reports, and uses the long name for the Balance Sheet, Financial Report, and Income Statement reports.

Subsidiary: If an account uses departments or subsidiary accounts, the departments or subsidiary accounts must be set up before posting transactions. In the Subsidiary list, click departments or subsidiary accounts.

Summary Account: Using summary accounts, you can combine multiple ledgers into a single ledger for generating a financial report in 2-8 Financial Reports. When you generate a financial report, Sage 100 Contractor looks to the Summary Account box in each ledger. If Sage 100 Contractor finds an account number, it combines the balance of that account into the indicated summary account.

Account Type: Displays the account range to which an account belongs and whether the account maintains a debit or credit balance. Ledger accounts that fall within specific account ranges are assigned certain properties:

- Ledgers in the Cash Accounts range cannot use subsidiary accounts.
- When posting to WIP Assets or Direct Expense ranges, Sage 100 Contractor requires you to create job costs before posting transactions.
- When posting to equipment accounts, Sage 100 Contractor requires you to create equipment costs.

Starting Balance: Displays the account balance at the beginning of the fiscal year, and that balance does not change by posting transactions to period zero.

Beginning Balance: Displays the account balance at the beginning of the fiscal year. The beginning balance is adjusted to reflect any postings made to period zero. Temporary accounts start with a $0 balance, and permanent accounts carry forward the ending balance from the prior fiscal year.

Ending Balance: Displays the ending balance as it appears in period 12 for permanent accounts. It is important to note that with temporary accounts, Sage 100 Contractor displays the total of all period balances. Posting to period 0 changes the beginning balances of the active company, and changes the ending balances in the archived company.

CAUTION: Once set up and saved, you cannot delete a chart of accounts, and you cannot edit it after you have entered a transaction. Call Customer Support or your business partner if you need more information.

General Ledger Setup

Accounting setup considerations

Before you begin to set up your general ledger and other parts of accounting, there are several things that you should consider. For example, what is your startup date? It is going to take days and perhaps a couple of weeks to set up your
company, so you need to have a startup date for your company in Sage 100 Contractor. You also must know your company’s fiscal year-end. In addition, you’ll need to consider the amount of information that you plan to bring into Sage 100 Contractor and its level of detail.

Here is a list of suggested information:

- **Balance sheet and income statement as of now:** If it’s currently mid-year, you have to merge the income statement from Sage 100 Contractor with the prior system for year-to-date reporting.

- **Balance sheet as of beginning of fiscal year and year-to-date activity as of Sage 100 Contractor start date:** You do not need month-by-month income statements, and you do not need prior year history.

- **Balance sheet as of the beginning of the fiscal year and activity for each month:** You do not need details. All detailed information must come from your prior system.

- **Balance sheet as of beginning of fiscal year and all transactions:** Starting up your accounting this way requires a lot of work unless only a few hundred entries need to be made.

In addition, you need the following information:

- A chart of accounts
- Listing of open accounts payable invoices
- Listing of accounts receivable invoices (including fully paid) for jobs that are in progress
- Job information: names, clients, and addresses
- Contract amounts
- Payroll information regarding employee balances, unions, company deductions, local taxes, and so forth.

**CAUTION:** Once set up and saved, you cannot delete a chart of accounts, and you cannot edit it after you have entered a transaction. Call Customer Support or your business partner if you need more information.

**About general ledger setup**

One of the first tasks when creating a new company in Sage 100 Contractor is to set up the general ledger structure. When you select a pre-built ledger, Sage 100 Contractor creates the ledger accounts for you.

You can also set up the general ledger manually. If you choose to enter the account ranges, controlling accounts, and posting accounts manually, Sage 100 Contractor will not create the ledger accounts. You will then need to create each ledger account in the 1-7 General Ledger Accounts window.

**CAUTION:** Once set up and saved, you cannot delete a chart of accounts, and you cannot edit it after you have entered a transaction. Call Customer Support or your business partner if you need more information.

**NOTE:** Unless you have prior experience setting up general ledgers, it is a good idea to choose a pre-built chart of accounts.

**Pre-built chart of accounts**

When you select the pre-built chart of accounts, Sage 100 Contractor automatically sets up the account ranges, controlling account numbers, posting account numbers, and then creates the ledger accounts. You can then modify the ledger setup to meet your particular needs. However, you will then need to edit the ledger accounts to match any changes made in the 1-8 General Ledger Setup window.

You can select from four different pre-built charts of accounts:
General Contractor Accounts (Four-Digit or Five-Digit)
- Subcontractor Accounts (Four-Digit or Five-Digit)
- Home Builder Accounts
- Remodeler Accounts

After setting up the chart of accounts, you can edit account numbers, delete unnecessary accounts, and set up controlling accounts for subsidiary accounts or departments in the 1-7 Ledger Accounts window. If you change a controlling or posting account number in 1-8 General Ledger Setup, you must also change the ledger account number.

**CAUTION:** You cannot delete a chart of accounts after you set it up and save it, and you cannot edit it after you have entered a transaction. Call Customer Support or your business partner if you need more information.

### About posting periods

Use the Posting Period window to select the period where you want to post your transactions.

In any accounting transactions window, such as 4-2 Payable Invoice/Credits, you can post individual transaction records to a different posting period. For example, if you need to post a transaction to period 1 of a new fiscal year, but you are still currently in period 12 of the current fiscal year, use this window to post the transaction to period 1 of the new fiscal year.

**NOTE:** If you want to change the default posting period for all transactions, you can only change it using 1-6 Period and Fiscal Year Management > Change Period.

Period 1 of the next fiscal year becomes available only after you advance your current fiscal period to **period 12**. Advance your current period to **period 1** to make periods 2 through 12 available for the next fiscal year.

### To use Posting Period:

Select the period to which you want to post transactions and click **[Select]**.

### Important Posting Period features

The following bullet points describe some of the features related to posting periods:

- Accounting transaction windows contain a **Change the posting period** button that displays the posting period to which you are posting transactions. By changing the posting period, you can post transactions to the specified period until you change the period again or close the window. When the window opens again, the posting period is set to the current default posting period.

- Users at different workstations can work in the same window and post to different periods. For example, while Andy and Melissa are entering invoices in the **Accounts Payable Invoices** window, Andy finds a few invoices that need posting to a previous period. While Melissa continues entering invoices in the current fiscal period, Andy can change the fiscal period and enter those invoices.

- When you change the posting period to something other than the default current posting period, Sage 100 Contractor changes the color of the **Posting Period** button to yellow.

- At the end of the period, open **1-6 Period and Fiscal Year Management > Change Period** and advance the current default posting period to the next one.

- When advancing to the next posting period, the program performs a complete audit of the books. If you discover audit errors, you can view them and possibly repair the ledger balances at that time rather than at the end of the fiscal year.

**IMPORTANT:** We strongly recommend that you recalculate balances to repair discrepancies if they are discovered during audits at the end of each posting period. Repairing audit errors as you advance to the next posting period is much more efficient than waiting until year-end to repair a year’s worth of audit errors.
You can restrict users from posting transactions to previous or future periods.

If you have an archive from a previous year, you can post transactions to the archive; however, you must open the archive company first. Sage 100 Contractor does not post entries simultaneously to period 12 of an archive company and period 0 of the current company.

When using Sage 100 Contractor across a network, changing the current period using 1-6 Period and Fiscal Year Management > Change Period affects all workstations that access Sage 100 Contractor.

About inventory valuation methods

This functionality is available only if you have the Inventory Add-On Module.

IMPORTANT: We recommend that you consult with your accountant and tax advisor before selecting an inventory valuation method in Sage 100 Contractor.

Inventory valuation methods handle the accounting aspects of an inventory account. Your inventory valuation method determines the value of used inventory, which impacts the inventory general ledger account. The actual physical movement of inventory is not dictated by your inventory valuation method selection. In other words, inventory parts can be used in any order regardless of the valuation method used.

Sage 100 Contractor provides three different inventory valuation methods:

- Weighted Average Cost (WAC)
- Last-in First-out (LIFO)
- First-in First-out (FIFO)

About starting balances

You can enter the starting balances for asset and liability accounts by posting a journal transaction—usually to period zero. As journal transactions can contain up to 999 lines, it is possible to enter most starting balances in a single journal transaction. Enter each account balance on a separate line.

Larger companies may not be able to enter the balances in one transaction. If you need to enter two journal transactions, use a clearing account to create a balanced entry.

At the end of the first transaction, enter the clearing account number and the amount necessary to balance the transaction. In the second journal transaction, finish entering the starting balances. Then at the end of the second transaction, enter the clearing account number and the amount necessary to balance the transaction. After you complete the entry of the starting balances, the clearing account returns to a zero balance.

About dedicated accounts

Sage 100 Contractor does not let you post journal transactions directly to the Accounts Receivable, Accounts Payable, Service Receivables, or Inventory ledger accounts; you can only post to those accounts through invoices. Therefore, entering the starting balances is a two-part process.

During the first part of the process, the Accounts Receivable, Accounts Payable, Service Receivables, and Inventory balances are posted to clearing accounts. Later, the individual open invoices are posted against the clearing accounts, thereby moving the balances into the proper accounts.

Similarly, you cannot directly post to the Inventory ledger account. Normally, you move inventory into the accounting system through payable invoices. For startup purposes, however, it is necessary to post a journal transaction to an Inventory clearing account. Later, the inventory is posted against the clearing account and allocated to specific inventory locations and parts, thereby moving the balances into the Inventory ledger account.
In this portion of the setup process, post the starting balances to the clearing accounts. If you are using a pre-built general ledger structure, Sage 100 Contractor already has the necessary clearing accounts established. At the fiscal year-end, you can delete the setup clearing accounts, as they are no longer needed.

**IMPORTANT:** After posting the invoice and allocations for inventory, your clearing accounts should have a zero balance. If not, review your data to find out why.

### Working With Ledger Accounts

#### About account ranges

You can set up the ranges for the ledger accounts. The **Account Range** boxes determine the overall range of accounts for the entire chart of accounts. If you are creating a chart of accounts manually, indicate the lowest and highest account numbers in the range. Then set the individual accounts ranges within the chart of accounts. The range for a chart of accounts usually begins with one (100, 1000, or 10,000) and ends with eight (800, 8000, or 80,000). You can create ledger accounts that use up to ten digits. The range of the largest chart of accounts that you can create is 1,000,000,000 to 9,999,999,999.

When an account is set up, its account number cannot exceed the range limit. Suppose the **Current Liabilities** range of accounts is from 200 to 249. You cannot create a current liability using an account number below 200 or above 249.

**NOTE:** You cannot use decimals in the account numbers.

#### About controlling accounts

A controlling account is a ledger account in the general ledger that summarizes the balances for a group of similar subsidiary accounts. With specific, dedicated controlling accounts, the program uses the accounts you designate to automatically post certain transactions to the correct ledger accounts.

When you select a pre-built chart of accounts, Sage 100 Contractor assigns the account numbers to the ledger accounts. You can change the account numbers during setup; each account number must fall within the correct range.

Under **Controlling Accounts**, Sage 100 Contractor uses the accounts you designate to automatically post certain transactions to the correct ledger accounts. For example, when you post a receivable invoice, you do not need to supply the accounts receivable ledger account. After posting a transaction to the general ledger, Sage 100 Contractor locks the account numbers for the accounts under **Controlling Accounts**. The account numbers will appear shaded.

You can change the account numbers on the **Receivables**, **Payables**, **Equipment**, and **Inventory** tabs whether or not you have posted transactions. If you change the account number on the **Receivables**, **Payables** or **Equipment** tabs, you will have to move the balances to the new account through a journal transaction.

### Subsidiary Accounts

#### About subsidiary accounts

Using subsidiary accounts, you can arrange financial information into related categories under a single ledger account, providing quick access to specific information. A ledger account that uses subsidiary accounts is known as the controlling account. Asset and liability accounts primarily use subsidiary accounts, though you can also use subsidiary accounts with income and expense accounts.

Suppose that you want to track telephone expenses. You can split the telephone account into subsidiary accounts such as **Basic Service**, **Long Distance**, **Cellular**, and **Paging**. The **Telephone** ledger account then provides you with the overall expenses as well as a breakdown of the expenses by the subsidiary accounts.

Sage 100 Contractor automatically sets up subsidiary accounts for accounts receivable, accounts payable, and service receivables using the job, vendor, and client numbers as the subsidiary account numbers. However, Sage 100 Contractor
About same of Departments create cleared. balance.
You departments, After accounts profitable, account, Company ledger balance. You accounts subsidiary does cannot
IMPORTANT: departments, charges, you set 1- Check/Bank charges, and Vendor payments.
Before you create departments, you must designate ledger accounts to accept departments.
Departments and subsidiary accounts both provide tools to evaluate the profit and loss for companies. Both arrange data in meaningful ways; however, there are significant differences in how the data is used. A single controlling account uses a set of subsidiary accounts tailored to the controlling account. In contrast, income and expense controlling accounts share the same set of departments, and each controlling account that uses departments has the same set of subsidiary accounts.

Company Departments

About Company Departments

Company departments help organize income and expense data and provide a means to evaluate the profit and loss for a company. Departments and subsidiary accounts both arrange data in meaningful ways, but with a significant difference in how the data is used. While a single controlling account uses a set of subsidiary accounts tailored to the controlling account, income and expense controlling accounts share departments.

With departments in place, you can analyze your income and expenses. For example, to determine which departments are profitable, you can generate a departmental income statement. You can also view a department balance for either all ledger accounts or for a specific ledger account.

After you set up the controlling accounts and create your list of departments, you can add the departments to the controlling accounts. Because Sage 100 Contractor simultaneously updates departments to all controlling accounts, you can add departments, or change the department names or numbering structure at any time.

IMPORTANT: Before you create departments, you must designate ledger accounts to accept departments.

You cannot transform a ledger account into a controlling account if that ledger account has had any activity or carries a balance. The ideal time to create departments is at the start of a new fiscal year after all account balances have been cleared. If necessary, however, you can create departments for a ledger account in the middle of the fiscal year. To do this, create a new controlling account to handle departments, and transfer the balance from the ledger account into the departments in the new controlling account.

Departments and subsidiary accounts both provide tools to evaluate the profit and loss for companies. Both arrange data in meaningful ways; however, there are significant differences in how the data is used. A single controlling account uses a set of subsidiary accounts tailored to the controlling account. In contrast, income and expense controlling accounts share the same set of departments, and each controlling account that uses departments has the same set of subsidiary accounts.

Checks and Bank Charges

About checks and bank charges

Using 1-1 Checks/Bank Charges, you can produce general ledger checks, transfer funds between cash accounts, enter bank charges, and cancel check numbers. When entering a check, you can break down costs by creating separate line items, and you can even post each item to a different ledger account. To pay a vendor, however, you create the check through 4-3 Vendor Payments.
Suppose you want to issue a check to a telephone company for last month’s bill. To indicate to Sage 100 Contractor that a check will be printed for the transaction, you type a placeholder consisting of four zeros (0000) in the Check# box. Then when selecting check records for printing, you indicate the check number at which you want to begin printing. As Sage 100 Contractor prints checks, it substitutes the placeholder in the posted record with the appropriate check number.

You can also enter transactions that do not require printed checks. For example, you might issue a hand written check and will not need to print a check. In this case, you enter the check number you issued in the Check# box.

In the grid, you can itemize the expenses and post them to different expense accounts. When you indicate a direct expense account, equipment expense account, or WIP account Sage 100 Contractor requires you to create a cost record.

**About posting to period 0**

When you want to enter the startup balances and invoices for a new company or when you want to adjust the beginning balances for a company, post to period 0. Period 0 is not part of the fiscal year. Therefore, Sage 100 Contractor does not include transactions posted to period 0 in any year-to-date reports.

> **TIP:** Sage 100 Contractor posts the transactions to the selected fiscal period until you change the period again or close the window.

When you post to the asset or liability accounts in period 0, Sage 100 Contractor adjusts the beginning balances. If you post to income or expense accounts in period 0, Sage 100 Contractor adjusts the beginning balance of the Retained Earnings ledger account because income and expense accounts do not have beginning balances.

Posting to period 0 does not affect the data in your archive company. Change archive company totals by opening the archive company and making changes directly. When you change data in an archive, make new backups of the archived data. The archived records are your permanent records.

**Deposits and Interest**

**About deposits and interest**

You can enter deposits and accrued interest for checking or savings accounts in the 1-2 Deposits/Interest window. When you enter a deposit, enter individual checks or accrued interest as separate line items. If you have cash receipts for receivable or service invoices, enter these transactions using the 3-3-1 Cash Receipts window.

**About deposits on jobs**

Some contracts require a client to supply a deposit before work can begin. When you receive the deposit, you need to decide how to enter the deposit, as well as when and how to apply the deposit when invoicing the client. This often depends on the terms agreed upon in the contract. The following outlines the most common methods for handling job deposits:

You can enter the check for the job deposit in the 1-2 Deposits/Interest window. If you only receive a few deposits each fiscal year, deposit the check to the checking account and credit the Deposits on Jobs account. If you receive numerous deposits, create a subsidiary account for each deposit using the job number as the subsidiary account number. This enables you to track deposits independently.

You can enter the job deposit as a receivable credit in the 3-2 Receivable Invoices/Credits window, debiting the Deposits on Jobs account and crediting the accounts receivable account. You can enter the deposit as an open credit, assigning it invoice status 1-Open, and invoice type 2-Memo.

Later, you can apply the credit as you enter receivable invoices or you can apply the credit as you enter receipts in the 3-3-1 Cash Receipts window. The credit affects the statement balance, but does not affect the contract balance.
TIP: By entering the job deposit as a credit, you can supply the client with a copy of the credit. This allows the client to see how you applied the job deposit to invoices. Another way to inform the client about the job deposit is to send the client a statement detailing the activity for the job.

Transferring Funds Among Accounts

You can transfer funds between accounts in the 1-1 Checks/Bank Charges or the 1-2 Deposits/Interest window. When you transfer funds directly from one account to another, Sage 100 Contractor creates a single record for the transfer. The record of the transfer appears in the check reconciliation of both accounts until you clear it from one account or the other. After clearing the transaction for one account, it does not appear in the reconciliation for the other account. As this might prove confusing, it is a good idea to use a clearing account when transferring funds.

While using a clearing account requires a few extra steps, this type of transfer has a distinct advantage over the direct method. To transfer the funds using a clearing account requires you to enter two transactions. When reconciling bank statements, each account then has a transaction to clear. If you decide to use a clearing account for this purpose, create a clearing account in the Cash Accounts range in the general ledger.

About clearing accounts

Some transactions can become quite complex. With clearing accounts, you can create transactions that prove you have posted the amounts correctly. In addition, clearing accounts provide a means of posting transactions or balances to accounts that normally do not allow direct posting. Clearing accounts do not carry a balance for any length of time. If you want to hold a transaction in an account, use a suspense account.

Before posting a transaction, make sure the clearing account does not contain a balance. Posting a transaction to a clearing account moves a balance into the account. To move the balance from the clearing account, post a transaction or series of transactions against the clearing account. When the account balance reaches zero, you have completely posted the balance.

Suppose that you have transferred money from a general checking account to a payroll checking account. Using a clearing account, you would create a transaction in each account.

<table>
<thead>
<tr>
<th>Window of entry</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checks/Bank Charges</td>
<td>Clearing</td>
<td>General Checking</td>
</tr>
<tr>
<td>Deposits/Interest</td>
<td>Payroll Checking</td>
<td>Clearing</td>
</tr>
</tbody>
</table>

To create a clearing account:

1 Open 1-7 General Ledger Accounts.
2 In the data control box, enter the ledger account number in the cash accounts range of 1000 to 1999.
3 In the Short Name box, enter a brief description of the clearing account.

IMPORTANT: If an account uses departments or subsidiary accounts, the departments or subsidiary accounts must be set up before posting transactions. In the Subsidiary list, click 1-Subaccounts or 2-Departments.

4 As required, in the Subsidiary list, click 1-Subaccounts or 2-Departments.
   You can assign a cost type to ledger accounts, providing an additional way to verify transactions are posted to the proper accounts. When you post a transaction that has cost types, Sage 100 Contractor compares the transaction’s cost type with the ledger account cost type. If the cost types do not match, Sage 100 Contractor provides a warning, but does not prevent posting the transaction.

5 In the Cost Type list, click the cost type you want to assign the ledger account.
6 On the **File** menu, click **Save**.

**To enter clearing account transfers:**

1 Open 1-1 **Checks/Bank Charges**. In the **Account** box, enter the source account.

2 In the **Check#** box, enter the bank transaction number or a dummy transaction number.

3 In the **Date** box, enter the date of transfer.

4 In the **Description** box, enter a brief statement about the transfer.

5 In the **Vendor** box, enter the vendor number.

6 In the **Status** list, click **1-Open**.

7 In the grid, do the following:
   a  In the **Account** cell, enter the clearing account to which you are transferring funds.
   b  If the account selected has subsidiary accounts, enter the number in the **Subaccount** cell.
   c  In the **Debit Amount** cell, enter the amount of the transfer.

8 On the **File** menu, click **Save**.

9 Open 1-2 **Deposits/Interest**. In the **Account** box, enter the destination account number.

10 In the **Deposit#** box, enter the bank transaction number or a dummy transaction number.

11 In the **Date** box, enter the date of the transfer.

12 In the **Description** box, enter a brief statement about the transfer.

13 In the **Status** list, click **1-Open**.

14 In the grid, do the following:
   a  In the **Account** cell, enter the clearing account from which funds originate.
   b  If the account selected has subsidiary accounts, enter the number in the **Subaccount** cell.
   c  In the **Credit Amount** cell, enter the amount of the transfer.

15 On the **File** menu, click **Save**.

**TIP:** You can verify the complete transfer of funds by viewing the clearing account balance in 1-7 **General Ledger Accounts**.

**To enter direct transfers:**

1 Open 1-1 **Checks/Bank Charges**.

2 In the **Account** box, enter the source account.

3 In the **Check#** box, enter the bank transaction number or a dummy transaction number.

4 In the **Date** box, enter the date of transfer.

5 In the **Description** box, enter a brief statement about the transfer.

6 In the **Vendor** box, enter the vendor number.

7 In the **Status** list, click **1-Open**.

8 In the grid, do the following:
   a  In the **Account** cell, enter the account to which you are transferring funds.
b) In the Debit Amount cell, enter the amount of the transfer.

9 On the File menu, click Save.

**NOTE:** You can also use 1-2 Deposits/Interest to transfer funds. Because you are making a deposit, enter the destination account in the Account# box. Then in the Account column, enter the account number from which the funds originate.

### About suspense accounts

Suppose your company receives a corporate tax refund, and you want to deposit the check, but you do not know how to correctly post the transaction. The correct approach is to deposit the check and credit it to a suspense account in the Cash Accounts range. The amount remains in the suspense account until you determine where to post the credit.

Suspense accounts provide a temporary location where you can post a transaction until you determine the proper accounts. Similar in function to a clearing account, suspense accounts allow transactions to pass through the account. When you post transactions to a suspense account, however, the transactions can remain for an extended time until you determine the proper accounts.

It is a good idea to use a suspense account in the account range to which you will eventually post the transactions. For example, you are not sure how to post a transaction related to equipment. You can use a suspense account in the Equipment range of ledger accounts.

You can transfer funds between accounts in the 1-1 Checks/Bank Charges or the 1-2 Deposits/Interest window. When you transfer funds directly from one account to another, Sage 100 Contractor creates a single record for the transfer. The record of the transfer appears in the check reconciliation of both accounts until you clear it from one account or the other. After clearing the transaction for one account, it does not appear in the reconciliation for the other account. As this might prove confusing, it is a good idea to use a clearing account when transferring funds.

While using a clearing account requires a few extra steps, this type of transfer has a distinct advantage over the direct method. To transfer the funds using a clearing account requires you to enter two transactions. When reconciling bank statements, each account then has a transaction to clear. If you decide to use a clearing account for this purpose, create a clearing account in the Cash Accounts range in the general ledger.

### About clearing accounts

Some transactions can become quite complex. With clearing accounts, you can create transactions that prove you have posted the amounts correctly. In addition, clearing accounts provide a means of posting transactions or balances to accounts that normally do not allow direct posting. Clearing accounts do not carry a balance for any length of time. If you want to hold a transaction in an account, use a suspense account.

Before posting a transaction, make sure the clearing account does not contain a balance. Posting a transaction to a clearing account moves a balance into the account. To move the balance from the clearing account, post a transaction or series of transactions against the clearing account. When the account balance reaches zero, you have completely posted the balance.

Suppose that you have transferred money from a general checking account to a payroll checking account. Using a clearing account, you would create a transaction in each account.

<table>
<thead>
<tr>
<th>Window of entry</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checks/Bank Charges</td>
<td>Clearing</td>
<td>General Checking</td>
</tr>
<tr>
<td>Deposits/Interest</td>
<td>Payroll Checking</td>
<td>Clearing</td>
</tr>
</tbody>
</table>
About suspense accounts

Suppose your company receives a corporate tax refund, and you want to deposit the check, but you do not know how to correctly post the transaction. The correct approach is to deposit the check and credit it to a suspense account in the Cash Accounts range. The amount remains in the suspense account until you determine where to post the credit.

Suspense accounts provide a temporary location where you can post a transaction until you determine the proper accounts. Similar in function to a clearing account, suspense accounts allow transactions to pass through the account. When you post transactions to a suspense account, however, the transactions can remain for an extended time until you determine the proper accounts.

It is a good idea to use a suspense account in the account range to which you will eventually post the transactions. For example, you are not sure how to post a transaction related to equipment. You can use a suspense account in the Equipment range of ledger accounts.

Journal Transactions

About journal transactions

Use the 1-3 Journal Transactions window to review most accounting records. You can also enter adjusting journal entries and change the status of bank account records. You cannot, however, enter transactions or adjusting journal entries for the Accounts Payable, Accounts Receivable, Service Receivables, Inventory.

Best practices in accounting procedures require that you do not void transactions that have been processed by the bank. Therefore, it is not possible to void transactions with a status of 2-Cleared.

NOTE: You can create a template for journal transactions from the File menu from an existing record or from scratch.

Recurring Transactions

About recurring journal transactions

Every business has transactions that occur on a regular calendar basis. You can set up any transaction as a recurring transaction if it consistently posts the same amount on a regular basis. However, Sage 100 Contractor does not automatically post the recurring transactions to the general ledger. You retain complete control over posting the transactions. You can even set a reminder to prompt users in a specific security group when it is time to post recurring transactions.

Look at the posting date of a transaction to determine when to post the transaction. After posting the transaction, Sage 100 Contractor advances the posting date based on the transaction cycle. The transaction date does not control or affect the period to which you are posting the transaction. If you need to post a recurring transaction to a different period, change the posting period.

Examples of recurring transactions

The best transactions to set up on a recurring basis are those with amounts that do not vary and post on a regular cycle. Recurring transactions cannot be set up for direct expenses, equipment expenses, inventory, or service receivables.

<table>
<thead>
<tr>
<th>Transaction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recurring Payments</td>
<td>Regular payments such as rents, vehicle insurance, janitorial services, and subscriptions or dues.</td>
</tr>
<tr>
<td>Transaction</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pre-paid Expenses</td>
<td>Payments made for a time longer than a single period, such as a quarterly vehicle insurance payment that you need to expense monthly. Create a recurring transaction to post the monthly expense rate, rather than the quarterly rate.</td>
</tr>
<tr>
<td>Depreciation</td>
<td>You can depreciate items such as office equipment on a monthly basis. After obtaining the annual depreciated amount from your company accountant, calculate the monthly depreciation. Then set up a transaction to post the monthly depreciation. You can depreciate the value of equipment used on a job in the 8-6 Equipment Depreciation window.</td>
</tr>
</tbody>
</table>

**Bank Reconciliation**

**About bank reconciliation**

**IMPORTANT:** When your cursor is in the grid area of the 1-5 Bank Reconciliation window, no function keys except F1 are available. You may launch the calculator (F3) after displaying the 1-5 Bank Reconciliation window by clicking in the Statement Cutoff Date text box and then pressing F3.

The 1-5 Bank Reconciliation window, similar to a check register, displays transactions that have not cleared. As you compare the bank statement to the transactions in 1-5 Bank Reconciliation, clear the transactions listed on the bank statement.

You can display transactions using a specific date. In the Statement Cutoff Date box, enter the statement ending date to display all transactions through the specified date. Sage 100 Contractor does not display transactions entered after the indicated date.

Sage 100 Contractor displays transactions in transaction number order. If a check number falls out of numbered sequence, Sage 100 Contractor displays an asterisk (*) next to the transaction number.

After clearing transactions, save the changes. Cleared items do not appear in the 1-5 Bank Reconciliation window.

The Statement Beginning Balance box displays the balance as of the last reconciliation. The amount in the Statement Beginning Balance box does not change until you have cleared transactions and saved the changes.

When you display records for a checking account, the Statement Ending Balance box displays the balance as of the last reconciliation. As you change the status of transactions, the amount in the Statement Ending Balance box changes. A P displayed with a transaction in the Record# column indicates that the transaction is from a prior year.

After clearing the transactions, the ending balance in 1-5 Bank Reconciliation should match the ending balance of your bank statement. After reconciling the account with the statement and you save the changes, Sage 100 Contractor rolls the amount in the Statement Ending Balance box to the Statement Beginning Balance box.

**NOTE:** When saving a reconciliation as Final, the records are updated permanently. You cannot undo a reconciliation once you have clicked [Final].

Sage 100 Contractor lets you save a trial reconciliation that is only partially completed. You can then return later to finish the reconciliation.

**TIP:** The default location when saving the Bank Reconciliation Report as a .pdf file is \MB\your company\Reports. You can save it to a different location.

**About clearing outstanding bank transactions**

Before entering outstanding transactions, you may need to clear existing transactions. Such transactions are usually the result of entering the beginning and period balances.
For the first time reconciliation for a new company, work on only one account at a time. For each bank account, enter the open bank transactions that are part of the startup ledger balances. If you have written checks or made deposits that are not included in the startup ledger balances, do not enter them at this time. Wait until you have finished entering all start up data.

Because the effect of the outstanding bank transactions are already encompassed by the ledger account balances set up earlier, post the transactions to a clearing account in the period prior to the current period. Suppose you are setting up during period 7. Post each open transaction to period 6. Then post the journal transaction to the end of period 6.

Working on the outstanding items for one bank account at a time helps prevent startup errors. After entering the checks and deposits, enter the journal transaction to zero out the clearing account. Compare your results to the last reconciliation. Then proceed to the next bank account. You can use the same clearing account to enter the balances for each bank account.

**About reconciliation errors**

When you cannot reconcile an account with the bank statement, you need to determine the cause of the error. You can display all open records when you eliminate the statement cutoff date. This allows you to immediately search for transactions assigned to an incorrect date or period.

**Common reconciliation errors**

The following table lists some common reconciliation errors.

<table>
<thead>
<tr>
<th>Type of Error</th>
<th>Correction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incorrect posting</td>
<td>If you posted a transaction with an incorrect amount, the transaction amount between the reconciliation report and bank statement differs.</td>
</tr>
<tr>
<td>Incorrect bank posting</td>
<td>Checks occasionally clear the bank for a different amount. Look at the magnetic coding at the base of the check to determine the amount paid by the bank. Compare this amount to the amount appearing on the bank statement and to the actual amount for which the check was written.</td>
</tr>
<tr>
<td>Incorrect dates</td>
<td>If a transaction appears on the bank statement but does not appear in the 1-5 Bank Reconciliation window, you might have posted the transaction with incorrect dates. To locate the transaction, use 1-3 Journal Transactions and search for the missing transaction.</td>
</tr>
<tr>
<td>Missing entries</td>
<td>When charges or credits appear on the bank statement but do not appear in your records, post the charges and reopen 1-5 Bank Reconciliation.</td>
</tr>
<tr>
<td>Returned items</td>
<td>If the bank returns a check due to insufficient funds, reverse the check and post the charge for insufficient funds.</td>
</tr>
<tr>
<td>Forged items</td>
<td>While rare, it is possible that someone has altered a check amount. Another possibility is that someone has stolen check forms and forged checks.</td>
</tr>
<tr>
<td></td>
<td>It is important to identify forgery and alert the bank, thereby eliminating additional problems and preserving your ability to recover lost funds.</td>
</tr>
</tbody>
</table>

Sage 100 Contractor includes separate year-end processes:

- A process for closing payroll
- A process for advancing the fiscal year
- A process for archiving data in General Ledger

For many companies, the fiscal year end is the same as the calendar year end on December 31, while other companies have a fiscal year end other than December 31. Throughout this document we provide steps for both your fiscal year end and your calendar year end.
The fiscal and calendar year end can be a busy time. To keep your ledgers current and accurate, audit your books monthly. Sage recommends performing an additional audit several weeks before your year end to resolve any errors before beginning transactions for the next fiscal year. However, as of the 19.2 release, if you are on period 12 of your current fiscal year, you can begin entering transactions for period 1 of the new fiscal year even if you are still resolving auditing errors.

After you resolve any audit errors and archive your data, make at least two backups of your data for your permanent records.

The time required to complete your year-end processes depends on many factors, such as the size of your company, any audit errors, and any accounting adjustments. If all of the following conditions are true, you may be able to finish your year end in a few hours:

- You have already prepared backup.
- You have been keeping up with accounting period audits.
- You only have repairable period audit errors.

### About 1-6 Period and Fiscal Year Management

The **1-6 Period and Fiscal Year Management** window provides options for advancing to the next fiscal year and archiving data from your previous fiscal accounting year. You use this window to advance from one fiscal period to the next.

If you are on period 12 of your current fiscal year, use this window to advance to the first period of the next fiscal year.

**TIP:** Period 1 of the next fiscal year is available while you are still on your current year. You can begin entering transactions for period 1 of the next fiscal year by selecting the next available fiscal year from the **Posting Period window**. Periods 2-12 become available when you advance to the next fiscal year by clicking **[Change Period]**.

**NOTE:** This window replaces the "close year" function in previous releases. Beginning with version 19.2, Sage 100 Contractor no longer requires you to close your fiscal year.

### What happens when you advance the fiscal year?

Beginning with version 19.2, Sage 100 Contractor no longer requires you to close your books at the end of the fiscal year. When you advance the fiscal year (from period 12 of the current year to period 1 of the next fiscal year), Sage 100 Contractor audits your accounting records to verify that valid, balanced transactions support the account balances. If no errors are present, Sage 100 Contractor advances the accounting period to period 1 of the next fiscal year. Periods 2-12 of the new fiscal year become available.

If you are on period 12 of your current fiscal year, you can begin entering transactions for period 1 of the new fiscal year by selecting **Period 1** from the **Posting Period** window or by changing the company period in **1-6 Change Period**.

Sage 100 Contractor does not archive your data automatically when you advance the fiscal year. You can archive your data after advancing the fiscal year by clicking **[Archive Fiscal Year]** from within the 1-6 Period and Fiscal Year Management window.

### Change Posting Periods

**About the Change Period window**

Use the **Change Period** window to change the default current posting period for the entire program. If you are on period 12 of your current fiscal year, the window allows you to select period 1 of the next fiscal year. This feature replaces the "close year" requirement for previous Sage 100 Contractor releases. Instead of closing your fiscal year, select period 1 of the next fiscal year. You can then archive your data at your earliest convenience.
Click the arrow key to the right of the **Change Period to** box **Posting Period** window to select the default period and fiscal year.

When you advance to the next posting period or a future posting period, for example from period 1 to period 2 or 2 to 9, the program performs an audit automatically. The audit results are logged in the **Audit History** window. After the audit has been completed, you click the button to change the period.

To change the posting period, under **Period Selection**, type a period number or click the arrow button to open the **Posting Period** window from which you can select a posting period.

**TIP:** No audit is performed when you go backward, for example, from period 2 to period 1.

**Standard posting procedures and reporting**

If you do not have standard posting procedures, it is a good idea to establish them for your company. For example, post any corrections to the current fiscal period unless there are other reasons not to do so. Set a date when you change the period each month. You can post to prior accounting periods after changing the period, but it is essential to change prior periods so that reports are accurate.

Suppose you have issued financial reports to a lender based on information from period 3. Now in period 5, you find that you need to make a correction related to data in period 3. Posting the corrections to period 3 changes the data in that period, which impacts the financial reports you have already produced and sent to the lender. To avoid any problems this might cause, it is better to post the corrections to the current fiscal period.

**Audit the Books**

**About the Audit Books window and auditing the books**

When you audit the books of a company, Sage 100 Contractor verifies that the accounts are balanced and that valid transactions support the balances.

You can audit the books at any time by opening **1-6 Period and Fiscal Year Management > Audit Books** and clicking the **Audit Books** button. When you audit the books, the program does not make any changes, but it does log any errors using the **Audit History** function.

When you advance to a new period in the future, the program audits the books automatically as part of the process to change the default posting period.

When you start a new company or suspect data corruption, it is a good idea to audit the books and recalculate balances. If unbalanced data exists, the program alerts you so that you can correct the errors as early as possible.

**TIP:** Additional entries cannot fix imbalances and errors. If recalculating balances does not fix the errors, you may have accounting errors that can only be fixed with the help of Customer Support.

**About audit errors**

When you advance to the next posting period, click the **Audit Books** button, or archive a fiscal year, Sage 100 Contractor audits the books to verify that valid, balanced transactions support each account balance. If the books are out of balance, then the program notifies you that there are audit errors.

Sage 100 Contractor tracks audit errors in a log. You can access the log from the **View Audit History** link on the **1-6 Period and Fiscal Year Management** window.

**Period Audit Errors**

Some audit errors refer specifically to periods. If period audit errors exist, the **Audit** report displays them prominently. For example, a period audit error will contain the word **Period** in the row.
You can resolve most period audit errors by recalculating the ledger balances. To recalculate the ledger balances, open 1-6 Period and Fiscal Year Management > Recalculate Balances, and then click Recalculate Balances.

**Audit Errors Requiring Customer Support Assistance to Repair**

Any remaining audit errors cannot be repaired by clicking Recalculate Balances on 1-6 Period and Fiscal Year Management > Recalculate Balances. These audit errors might originate in accounts receivable, jobs, vendors, service clients, equipment, or other areas of the program where transactions originate.

⚠️ **CAUTION:** Resolving remaining audit errors after a repair requires assistance from Customer Support. You can contact them at 800-866-8049. Be prepared to provide your company name, telephone number, and the company contact person. At that time, a Customer Support technician may request additional reports to help determine the cause of the error.

Additional audit error reports are now included with Sage 100 Contractor to assist Customer Support technicians in identifying the transaction sources of audit errors.

**Recalculate Balances**

**About the Recalculate Balances window and repairing the balances**

Clicking Recalculate Balances recalculates and repairs the ledger balances, audits, and may resolve period audit errors. For example, if you notice “Period” errors on the error report, clicking Recalculate Balances often resolves them.

Resolving remaining audit errors after a repair requires assistance from Customer Support. You can contact them at 800-866-8049. Be prepared to provide your company name, telephone number, and the company contact person. At that time, a Customer Support technician may request additional reports to help determine the cause of the error.

During the repair, Sage 100 Contractor recalculates account and subsidiary account balances. In addition, Sage 100 Contractor recalculates balances for jobs, vendors, service clients, and equipment.

**To repair the ledger balances:**

1. Open 1-6 Period and Fiscal Year Management.
2. Click the Recalculate Balances button.

**IMPORTANT:** After completing the ledger balance repair, Sage 100 Contractor audits the books. Resolving remaining audit errors after a repair requires assistance from Customer Support. You can contact them at 800-866-8049. Be prepared to provide your company name, telephone number, and the company contact person. At that time, a Customer Support technician may request additional reports to help determine the cause of the error. There are specific audit error reports to help Customer Support technicians identify the transactions related to some audit errors.

**Audit History**

**About the Audit History window**

You access this window from 1-6 Period and Fiscal Year Management by way of the View Audit History link located at the bottom-left of the window. Every time you initiate an audit, the program logs audit history in the window’s grid.

The Audit History window displays three columns, Date, User Name, and Audit Results. The results displayed can be:

- **Audit successful**—No errors were found.
- **Repair successful**—Errors were found and repaired when the balances were recalculated.
- **[n] errors detected**—A number of errors that couldn’t be repaired and were logged.
The Audit History window also provides menu commands for saving your audit history in several file formats and for printing the audit history file.

**Archive Fiscal Year**

The following tasks are performed during this step in the wizard.

- Preparation
- General Maintenance
- Archive your data: Archives 12 periods of data in one company

You can click [Next] only when all tasks have been completed successfully.

**To archive your data:**

1. From the introductory window, click [Next] then click [Preparation] to begin.
   A progress bar shows next to each task as it is running.
   When completed, each task displays one of the following icons:
   - The green ✓ icon indicates that the task ran successfully.
   - An orange ! icon indicates that the task has issues that should be reviewed before continuing.
   - A red ✗ icon indicates that the task “failed” and you cannot continue until the issue is resolved. Click View Results link to display detailed information about the error.

2. Click [Next].

3. Select one or more maintenance options you want to perform prior to archiving then click [Next].

4. Type a name for the company archive in the Enter name for the company archive box. The box cannot contain any special characters.

   **NOTE:** If the archive folder already exists, it must be empty. Click [Yes] to continue the process or click [No] to go back to the window.

5. Click [Archive Data] to begin the archive process.

6. Click [Close] to finish the archiving process.
Chapter 4: Accounts Receivable

Working with Accounts Receivable

Using Sage 100 Contractor’s robust accounts receivable system, you can receive payments, customize invoices, statements, overdue reminders, and more to present your clients with professional and personalized documents. You can also use the sales information in the client database to track customers from initial contact to job completion.

Sage 100 Contractor provides call sheets and aging reports to improve collection efficiency. For example, you can produce aging reports at any time, which can reflect the end of any prior fiscal period to match financial reports for the same period.

The billing options available are contract, progress (American Institute of Architects, or AIA, format; custom and generic) unitary, and time and materials billing, plus loan draws.

Each billing option offers records of prior and current billing application; prior ones are maintained in full detail so that you can examine earlier transactions for amounts carried forward.

Invoices, Credits, and Statements

The 3-2 Receivable Invoices/Credits window lets you enter transactions that affect receivable accounts. You can create invoices or credit invoices, track retention, or view a history of payments for a specific invoice.

You can also create a simple invoice based on the percentage of work completed for the contract. This type of billing is suitable for subcontractors or small projects.

The Receivable Invoices window also provides the ability to enter taxable and non-taxable items on an invoice at the same time. When you enter a tax district number in the Tax District text box, you can select the items to tax in the Taxable column. If you leave the Tax District text box blank, Sage 100 Contractor assumes each item is non-taxable.

About receivable invoice status

The status of a receivable record indicates its location in the process.

**IMPORTANT:** You can change the status of records assigned status 1-Open, 2-Review, or 3-Dispute to another of the first three status settings. However, you cannot assign status 4-Paid or 5-Void.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Open</td>
<td>Indicates a record posted to the general ledger.</td>
</tr>
<tr>
<td>2-Review</td>
<td>Indicates the management or bookkeeping staff should review the record.</td>
</tr>
<tr>
<td>3-Dispute</td>
<td>Indicates a record disputed by the client.</td>
</tr>
<tr>
<td>4-Paid</td>
<td>Indicates a record paid in full.</td>
</tr>
<tr>
<td>5-Void</td>
<td>Indicates a voided record.</td>
</tr>
</tbody>
</table>
NOTE: When an invoice or credit is fully paid, Sage 100 Contractor automatically assigns status **4-Paid**. If you void the record, Sage 100 Contractor automatically assigns status **5-Void**.

**About receivable invoice types**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Contract</td>
<td>Use type <strong>1-Contract</strong> when the invoice affects the billing for the contract. A receivable invoice assigned type <strong>1-Contract</strong> increases the job balance, and a credit invoice with this type reduces the job balance.</td>
</tr>
<tr>
<td>2-Memo</td>
<td>Use type <strong>2-Memo</strong> when the invoice does not affect the job billing for the contract. For example, when you enter a job deposit as a credit invoice, assign it <strong>2-Memo</strong> so that the credit does not affect the invoiced to date amount. You can also use this type with bad debts. Entering a credit invoice assigned <strong>2-Memo</strong> does not reduce the invoiced to date amount, but clears the debt.</td>
</tr>
</tbody>
</table>

**Entering receivable invoices**

You can review the record totals before saving the invoice or credit. On the **Options** menu, click **Calculate**.

You can provide part numbers on an invoice. Sage 100 Contractor only includes the parts on the invoice, and does not use the part information elsewhere.

When you enter a tax district number in the **Tax District** text box, you can select which items to tax. In the **Taxable** column, type Yes if the item is taxable, or No if the item is non-taxable.

**To enter a receivable invoice**

1. Open **3-2 Receivable Invoices/Credits**.
2. Do the following:
   a. In the **Invoice#** text box, enter the invoice number.
   b. In the **Date** text box, enter the date of the invoice.
   c. In the **Job** text box, enter the job number.
   d. If the job uses phases, enter the phase number in the **Phase** text box.
   e. In the **Description** text box, enter a brief statement about the invoice.
   f. In the **Due Date** text box, enter the invoice due date.
   g. In the **Discount Date** text box, enter the due date by which you must receive payment for the client to receive the discount.
   h. In the **Status** list, click the invoice status.
   i. In the **Type** list, click the invoice type. The contract affects the invoiced balance when **Type 1-Contract** is selected. Type **2-Memo** does not affect the invoiced balance.
In the grid, do the following:

a. In the Description cell, enter a brief statement about the item.
b. In the Quantity cell, enter the quantity of items.
c. In the Price cell, enter the price for a single item.
d. In the Account cell, enter the ledger account number.

Repeat step 3 for each item.

In the Discount text box, enter the discount for early payment.

On the File menu, click Save.

In the Retention text box, enter the amount of retention.

**Voiding receivable invoices**

If you discover an invoice was entered incorrectly, determine the best method to correct the error. For example, if the error is in the header information, you can edit the information contained in any of the text boxes, except in the Job and Tax District text boxes, and re-save the record.

When the invoice contains an incorrect job number, tax district, ledger account, or amount, void the invoice and then re-enter it with the correct information. By voiding and re-entering the invoice, you create a clear audit trail.

There are also circumstances when you cannot void the original record. For example, you cannot void a credit invoice that has been applied in full, or an invoice posted to period 0. Because you cannot void these types of transactions, it is necessary to enter an adjusting invoice.

Before voiding an invoice, reverse all the payments posted to it. You can then enter the invoice correctly and reapply the payments.

You can void a receivable invoice with an assigned status of 1-Open, 2-Review, or 3-Dispute.

When voiding an invoice that contains discretionary taxes, Sage 100 Contractor also voids the tax amount. If the voided invoice reduces the discretionary taxes below the billing maximum, Sage 100 Contractor continues to calculate the discretionary taxes until the tax maximum is met.

**To void a receivable invoice**

1. Open 3-2 Receivable Invoices/Credits.
2. Using the data control, select the record.
3. If an amount appears in the Paid text box, reverse the payments.
4. On the Edit menu, click Void Invoice.

**Creating invoices based on contract balances**

You can create a receivable invoice for a job based on the amount of work completed. Using the original contract amount or the new contract amount and the amount you have invoiced to date, Sage 100 Contractor determines the balance remaining on the contract.

When you supply the percentage of the contract that is completed, Sage 100 Contractor computes the amount to bill. This method is similar to progress billing, but does not provide a detailed breakdown by cost code of the progress. Instead, the invoice contains a single line describing the percentage of work completed and the invoice amount. This method of billing is best suited for subcontractors.

**To create an invoice based on the contract balance**
1. Open 3-2 Receivable Invoices/Credits.
2. Enter the invoice.
3. On the Options menu, click Contract Summary.
4. Choose the type of invoice you want to create by selecting the Percentage of Contract or Percentage of New Contract option.
5. In the Percent Complete text box, enter the total amount of the contract that is completed.
6. The Amount to Bill text box displays the computed amount. You can edit both figures if necessary.
7. Click OK.

**NOTE:** Sage 100 Contractor automatically increments the new contract amount as change orders are approved. The amount billed does not change, but the percent billed changes since it is determined from the new contract amount.

### About receivable credits

**IMPORTANT:** You cannot reverse a credit invoice after applying it to an invoice. If you apply a credit invoice to the wrong invoice, make adjusting invoice entries to correct the error.

Many situations could cause you to enter a credit invoice. Suppose a client provides a prepayment on a job, or overpays an invoice. In either case, it is necessary to reduce the accounts receivable.

When you save a credit invoice, Sage 100 Contractor reduces the job balance. However, the credit invoice retains status 1-Open until you apply it against other invoices in the 3-3-1 Cash Receipts window. After you have applied the credit balance to other invoices, Sage 100 Contractor assigns the credit invoice status 4-Paid.

You can also apply a credit invoice to an invoice at the time you save the record. If the invoice is fully paid by means of the credit invoice, Sage 100 Contractor changes the status of the invoice to 4-Paid. If the invoice still has a balance after applying the credit, the invoice status is not changed. Likewise, if the entire amount of the credit is applied, the status of the credit invoice changes to 4-Paid. If a credit invoice still has a balance after applying it to an invoice, the status of the credit invoice remains unchanged. You can then apply the remaining credit invoice balance to other invoices in the 3-3-1 Cash Receipts window.

### Recalculating invoices or credits

After making changes, you can recalculate the new totals.

**To recalculate an invoice or credit**

To calculate the invoice balances, on the Options menu, click Calculate.

### About receivable credits

**IMPORTANT:** You cannot reverse a credit invoice after applying it to an invoice. If you apply a credit invoice to the wrong invoice, make adjusting invoice entries to correct the error.

Many situations could cause you to enter a credit invoice. Suppose a client provides a prepayment on a job, or overpays an invoice. In either case, it is necessary to reduce the accounts receivable.

Here are some points to consider:

- When entering cash receipts, you can apply the credit invoice.
- You can review the record totals before saving the invoice or credit. On the Options menu, click Calculate.
You can provide part numbers on an invoice. Sage 100 Contractor only includes the parts on the invoice, and does not use the part information elsewhere.

When you enter a tax district number in the Tax District text box, you can select which items to tax. In the Taxable column, type Yes if the item is taxable, or No if the item is non-taxable.

When you save a credit invoice, Sage 100 Contractor reduces the job balance. However, the credit invoice retains status 1-Open until you apply it against other invoices in the 3-3-1 Cash Receipts window. After you have applied the credit balance to other invoices, Sage 100 Contractor assigns the credit invoice status 4-Paid.

To enter a credit invoice

1. Open 3-2 Receivable Invoices/Credits.

2. Do the following:
   a. In the Invoice# text box, enter the credit invoice number.
   b. In the Date text box, enter the date of the invoice.
   c. In the Job text box, enter the job number.
   d. If the job uses phases, enter the phase number in the Phase text box.
   e. In the Description text box, enter a brief statement about the invoice.
   f. In the Due Date text box, enter the invoice due date.
   g. In the Discount Date text box, enter the due date by which payment must be received for the discount to apply.
   h. In the Status list, click the invoice status.
   i. In the Type list, click the invoice type.

3. In the grid, do the following:
   a. In the Description cell, enter a brief statement about the item.
   b. In the Quantity cell, enter the quantity of items as a negative amount.
   c. In the Price cell, enter the price for a single item.
   d. In the Account cell, enter the ledger account number.

4. Repeat step 3 for each item.

5. On the File menu, click Save.

You can also apply a credit invoice to an invoice at the time you save the record. If the invoice is fully paid by means of the credit invoice, Sage 100 Contractor changes the status of the invoice to 4-Paid. If the invoice still has a balance after applying the credit, the invoice status is not changed. Likewise, if the entire amount of the credit is applied, the status of the credit invoice changes to 4-Paid. If a credit invoice still has a balance after applying it to an invoice, the status of the credit invoice remains unchanged. You can then apply the remaining credit invoice balance to other invoices in the 3-3-1 Cash Receipts window.

To enter a credit invoice and apply it to an invoice

1. Open 3-2 Receivable Invoices/Credits.

2. Do the following:
   a. In the Invoice# text box, enter the credit invoice number.
   b. In the Date text box, enter the date of the invoice.
   c. In the Job text box, enter the job number.
d. If the job uses phases, enter the phase number in the Phase text box.

e. In the Description text box, enter a brief statement about the invoice.

f. In the Reference# text box, enter the receivable invoice number to which you want to apply the credit.

g. In the Due Date text box, enter the invoice due date.

h. In the Discount Date text box, enter the due date by which must be received for the discount to apply.

i. In the Status list, enter the invoice status.

j. In the Type list, enter the invoice type.

3. In the grid, do the following:

   a. In the Description cell, enter a brief statement about the item.

   b. In the Quantity cell, enter the quantity of items as a negative amount.

   c. In the Price cell, enter the price for a single item.

   d. In the Account cell, enter the ledger account number.

4. Repeat step 3 for each item.

5. On the File menu, click Save.

About statements

NOTE: If you have purchased the Service Receivables Add-on Module, invoices from Service Receivables are also included on the Client Contract Statement.

A statement summarizes the activity of invoices, payments, credit invoices, and retention for a job. Statements help keep clients informed of the financial activity for a job. It is a good idea to print the statements at the end of each month and send them to your clients.

When printing a statement, Sage 100 Contractor automatically generates a receivable invoice using the finance rate from the job record. The statement only includes the finance amount in the statement if the Calculate Finance Charges check box has been selected. Service receivable finance charge invoices, however, are based on the finance rate defined for client in 3.6 Receivable Clients.

You can create the finance charges by printing the statements, or you can click the Print preview and Drilldown (when available) button to review it before printing it. You can also print a single statement for a client with whom you have multiple job contracts. The Client Contract Statement lists the invoices by job and provides the total amount and remaining balance of each invoice.

NOTE: In some states, it is illegal to charge finance charges on top of finance charges. To exclude finance charges from a statement, in the 3.4 Report Printing window, clear the Calculate Finance Charges check box. You can create a separate finance charge statement manually in 3.2 Receivable Invoices/Credits.

Accounts Receivable Retention

Many job contracts include retention. When you create a receivable invoice, Sage 100 Contractor withholds retention at the rate specified in the job file. If you do not set up a default rate in the job file, you can withhold a flat amount on each individual invoice.

Posting an invoice declares the gross amount of the invoice as income. However, a percentage of the gross amount is withheld as retention, so the client is actually billed for the net amount (gross invoice amount – retention = net invoice amount). Therefore, retention is already declared as income but is not yet due. Consequently, Sage 100 Contractor does not include retention in the invoice aging, and does not apply finance charges to it.
When you are ready to bill the client for retention, it is not necessary to create a new invoice. The retention has already been declared income, so you only need to release the retention that has been withheld. You can release retention on each invoice individually, or you can release the retention for the entire job at one time. Having released the retention, you can then send the client a statement reflecting the amount that is due your company.

Changing retention rates for jobs

In the 3-5 Jobs (Accounts Receivable) window, you can change the retention rate for a job contract simply by entering the new rate in the Retention Rate text box. Sage 100 Contractor will calculate retention for all new invoices using the new rate, while existing invoices maintain the previously calculated retention.

You can also apply the new retention rate to all existing job invoices. When you increase the retention rate, Sage 100 Contractor calculates the new amount of retention based on the gross invoice amount. If the invoice balance is smaller than the calculated retention, Sage 100 Contractor adjusts the retention accordingly. For example, the retention is increased from 5% to 10% for a job and the change is applied to all job invoices. A $1,000 invoice is 95% paid and the remaining $50 balance is for retention. Because the invoice is already 95% paid, Sage 100 Contractor cannot recalculate retention at the 10% rate on this invoice. Consequently, Sage 100 Contractor does not change the retention for the invoice.

Applying a decreased retention rate can also affect previous invoices. While retention is decreased, the net balance due on invoices can increase. Suppose you decrease the retention from 10% to 5% for a job and apply the decrease to all job invoices. The net amount due for a $1,000 invoice was originally $900, but is changed to $950. If client had paid $900, the client now owes an additional $50, and the last $50 is withheld as retention.

To change the retention rate for a job:

1. Open 3-5 Jobs (Accounts Receivable), and then select the job.
2. In the Retention Rate text box, enter the new rate.
3. If the new retention rate only applies to new invoices, go to step 5.
4. On the Update menu, click Recalculate Retention.
5. In the New Due Date for Invoices text box, enter the due date you want to assign the invoices.
6. Under Select Recalculation Option, do one of the following:
   a. Select to update Only invoices with Retention, or
   b. Select to update All invoices.
7. Click OK.
8. On the File menu, click Save.

Entering retention as a flat rate for accounts receivable invoices

You can add a retention rate to the entire job which applies a single retention rate to all the job invoices. You can also enter retention to individual invoices as a flat rate.

To enter retention as a flat rate for accounts receivable retention:

1. Open 3-2 Receivable Invoices/Credits.
2. Locate the invoice to which you want to add retention.
3. Under the grid, locate the Retention box, type an amount, and the press Enter key.
4. Select File > Save.
Releasing retention for jobs

To release retention for a job:

1. Open 3-5 Jobs (Accounts Receivable), and then select the job.
2. Under the Terms area, select the Retention Rate value, and then click the Delete key.
3. On the Update menu, click Recalculate Retention.
4. On the Recalculate Retention window in the New Due Date for Invoices box, type a new due date.
5. Under the Recalculation Option area, do one of the following:
   a. Select to update Only invoices with Retention, or
   b. Select to update All invoices.
6. Click OK.
7. On the File menu, click Save.

TIP: You can verify that retention has been released by clicking the Invoices button (bottom of the window) and reviewing the Net Due amount.

Releasing retention for jobs and printing statements

When you bill a customer for retention for a job that is 100 percent complete, it is not necessary to create a new invoice. The retention is included on the invoices created from 3-7 Progress Billing applications. This three-part procedure shows you how to release retention, print a progress billing report, and then print a job statement to request final payment.

IMPORTANT: All past due accounts receivable invoices must have been collected before completing this procedure.

Part 1—To close the current bill, release retention, and print a progress billing report

1. Open 3-7 Progress Billing.
2. Open the last application with a Status 3-Posted for the job.
3. Click Next.
4. To the message, Reminder: A new record will be created and this one will become Closed. Do you want to continue? click Yes.
5. Be sure to note the amount in the Retention Rate box.
6. From the Update menu, select Release Retention.
7. To the message, This will reset all retention rates to zero and recalculate the application. Do you want to continue? click Yes.
8. On the Calculate grid, choose a method to calculate the Progress Billing and click OK.
   NOTE: The Retention Total amount becomes the Current Due amount.
9. From the File menu, select Save.
10. From the File menu, select Recall.
11. From the Options menu, select Submit Application.
12. From the File menu, select Print.
13. Print the appropriate Progress Billing report, reports 21—42, and send this report to your customer to show the retention amount is now due.


NOTE: The final application remains in Submitted status because there is not an invoice amount to post.

Part 2—To recalculate the retention and due dates

IMPORTANT: If you complete this part and have not received payments for amounts outside of retention, the current balance due will reflect retention and any outstanding amounts. This could be perceived that current receivables are overstated.

1. Open 3-5 Jobs (Accounts Receivable), and select the job.

2. In the Terms section of the window, clear the Retention Rate.

3. From the Update menu, select Recalculate Retention.

4. On the Recalculate Retention window, enter the New Due Date for Invoices and select the appropriate Recalculation option.

5. Click OK, and to the message to confirm the number of open invoices found, click OK again.

6. From the File menu, click Save.

7. Then, on the 3-5 Jobs (Accounts Receivable) window, click the Invoices button and review the Net Due amount to verify the retention has been released.

Part 3—To print a 3-4 Statement for detailed billing information

1. Open 3-4 Statements.

2. Select the 21-Job Statements report.

3. In the Job# box, type the job number.

4. Select the Include Paid Invoices check box.

5. Select the Include Payment History check box.

6. From the File menu, click Print.

7. On the Statement Variables window, type the Statement Date, and click OK.

8. The statement prints showing all outstanding amounts due, including the released retention.


About accounts receivable retention

Many job contracts include retention. When you create a receivable invoice, Sage 100 Contractor withholds retention at the rate specified in the job file. If you do not set up a default rate in the job file, you can withhold a flat amount on each individual invoice.

Posting an invoice declares the gross amount of the invoice as income. However, a percentage of the gross amount is withheld as retention, so the client is actually billed for the net amount (gross invoice amount – retention = net invoice amount). Therefore, retention is already declared as income but is not yet due. Consequently, Sage 100 Contractor does not include retention in the invoice aging, and does not apply finance charges to it.

When you are ready to bill the client for retention, it is not necessary to create a new invoice. The retention has already been declared income, so you only need to release the retention that has been withheld. You can release retention on each
invoice individually, or you can release the retention for the entire job at one time. Having released the retention, you can then send the client a statement reflecting the amount that is due your company.

Cash Receipts and Electronic Receipts

About cash receipts

In the 3-3-1 Cash Receipts window, you can enter payments for invoices, discounts for early payment of invoices, and overpayments. You can also reverse payments using this window.

If you have a merchant account with Sage Payment Solutions, you can use the 3-3-2 Electronic Receipts window to enter credit card and ACH payments electronically for your clients.

For information about electronic receipts, see See "About electronic receipts"

Applying receipts

To process receipts, you display client invoices in the 3-3-1 Cash Receipts window, select the invoice being paid, and then enter the amount of the payment and any applicable discount or overpayment. If the payment includes a credit invoice, you enter a negative amount for that invoice.

If a client pays more than the net amount of an invoice but less than the invoice balance, Sage 100 Contractor applies the payment to the retention. For example, suppose you created an invoice for $1000 minus 10% retention, resulting in a net total of $900. The client, however, sends a $950 payment. After entering the payment in cash receipts, the total balance due is $50 and the Retention column shows a balance of $50. It is important to note that this is not a substitute for releasing retention.

Entering overpayments

When a client pays more than the total balance of an invoice, you can enter the additional money as an overpayment. The total amount of the Paid and Discount cells must equal the amount in the Balance cell before Sage 100 Contractor allows you to enter the overpayment. When you save the cash receipts, Sage 100 Contractor reduces the job balance by the amount of the overpayment. In addition, the invoice now carries a negative balance and acts as a credit invoice.

Suppose a client informs you that he is going on vacation for a few weeks. The client wants to make sure you have enough money to continue building while he is gone, so instead of paying the $5,000 he was billed, he pays $10,000. For the invoice, enter $5,000 in the Paid cell and $5,000 in the Overpayment cell. After saving transactions, the invoice now carries a -$5,000 balance. The next time you invoice the client, you can apply the credit.

Applying discounts

Sometimes clients receive a discount for early payment. Sage 100 Contractor automatically determines whether a discount is available based on the due date you indicated on the invoice. When a discount is available, it is shown in the Discount Available text box. If a discount is not available, you can still apply a discount to an invoice.

About reversing payments and discounts

The Cash Receipts window also allows you to reverse payments and discounts. To reverse payments, you enter a negative amount in the Paid column and in the discount column, if the client took a discount.

If the reversal is for a credit invoice, you enter a positive amount in the Paid column.

About electronic receipts

If you have a merchant account with Sage Payment Solutions, you can use the 3-3-2 Electronic Receipts window to enter credit card and ACH payments electronically for your clients.
NOTE: Before you can process electronic receipts, you must enter your Sage Payment Solutions merchant ID and merchant key, as well as the general ledger account associated with your merchant account, on the Electronic Receipts Setup tab in the 7-2 Company Information window.

Processing electronic receipts is very similar to processing cash receipts using the 3-3-1 Cash Receipts window, with a few notable differences:

- You process an electronic receipt for one client at a time. Therefore:
  - You need to enter only the Client number in the transaction header.
  - You display invoices for the selected client in the grid.
- If you use the company option to store client information in the Sage Exchange Vault:
  - You can select Save payment information to save payment information that you enter for a transaction and client securely in the Sage Exchange Vault.
  - If you processed a payment for the client previously, you can choose to use the same payment method as before.
- If you also saved the client’s payment information in the vault:
  - If the last payment method was a credit card, the option Use last credit card is displayed instead of Use last payment method. If you select this option, when you click Process and Post, the credit card details stored in the vault for this customer appear on the Sage Exchange integration screen. You can change the credit card information on the Sage Exchange screen.
  - If the last payment method was ACH, the option Use last bank account appears instead. If you select this option, when you click Process and Post, the banking information stored in the vault for this customer appear on the Sage Exchange integration screen. You can change the banking information on the Sage Exchange screen.

CAUTION: If you do not want to use the same payment method used previously for the customer, you must clear the Use last credit card or Use last bank account option before you submit the payment to Sage Payment Solutions. If one of these options is selected when you click Process and Post, you will not be able to change the payment method in Sage Exchange.

- Rather than clicking Save to store receipt transactions, you use the following icons or Options menu items:
  - You click Process and Post to process a receipt electronically through Sage Payment Solutions, where it will be deposited to your bank account, and post the transaction to your Sage 100 Contractor General Ledger.
  - You click Post to post a transaction to your Sage 100 Contractor general ledger that you entered directly through the Sage Virtual Terminal or using another payment processing service.

Applying receipts

To process receipts, you display client invoices the 3-3-2 Electronic Receipts window, select the invoice being paid, and then enter the amount of the payment and any applicable discount or overpayment. If the payment includes a credit invoice, you enter a negative amount for that invoice.

If a client pays more than the net amount of an invoice but less than the invoice balance, Sage 100 Contractor applies the payment to the retention. For example, suppose you created an invoice for $1000 minus 10% retention, resulting in a net total of $900. The client, however, sends a $950 payment. After entering the payment in cash receipts, the total balance due is $50 and the Retention column shows a balance of $50. It is important to note that this is not a substitute for releasing retention.
**Entering overpayments**

When a client pays more than the total balance of an invoice, you can enter the additional money as an overpayment. The total amount of the **Paid** and **Discount** cells must equal the amount in the **Balance** cell before Sage 100 Contractor allows you to enter the overpayment. When you save the cash receipts, Sage 100 Contractor reduces the job balance by the amount of the overpayment. In addition, the invoice now carries a negative balance and acts as a credit invoice.

Suppose a client informs you that he is going on vacation for a few weeks. The client wants to make sure you have enough money to continue building while he is gone, so instead of paying the $5,000 he was billed, he pays $10,000. For the invoice, enter $5,000 in the **Paid** cell and $5,000 in the **Overpayment** cell. After saving transactions, the invoice now carries a –$5,000 balance. The next time you invoice the client, you can apply the credit.

**Applying discounts**

Sometimes clients receive a discount for early payment. Sage 100 Contractor automatically determines whether a discount is available based on the due date you indicated on the invoice. When a discount is available, it is shown in the **Discount Available** text box. If a discount is not available, you can still apply a discount to an invoice.

**About Sage Payment Solutions**

Using Sage Payment Solutions with Sage 100 Contractor saves you time, helps you get paid faster, and eliminates the need to enter payment information twice. Simply enter your customer’s check or credit card payment details once in Sage 100 Contractor, and the payment will be processed in Sage 100 Contractor and Sage Payment Solutions, in one easy step.

With the integration between Sage 100 Contractor and Sage Payment Solutions, you can process check and credit card transactions without storing your customers’ sensitive card information in your database. Sage Exchange transmits check and credit card details through a secure connection to Sage Payment Solutions, where they are stored in a PCI-compliant vault, protecting you from exposure to non-compliance penalties and credit card fraud.

In addition to providing integrated payment processing, Sage Payment Solutions also offers gift and loyalty card programs, merchant cash advances and loans, non-profit and healthcare payment solutions, and more.


**Electronic receipt processing workflow**

1. Open a Sage Payment Solutions account, linking it to the bank account to which you want to Sage Payment Solutions to deposit funds.
2. When you have received your Merchant ID and Merchant ID from Sage Payment Solutions, enter these credentials on the Electronic Receipts Setup tab in the **7-2 Company Information** window. Also on this tab:
   - Enter the Sage 100 Contractor ledger account that represents the bank account used to receive deposits from Sage Payment Solutions.
   - Specify whether to allow client credit card and bank account information to be securely stored in the Sage Exchange Vault.
3. Use the **3-3-2 Electronic Receipts** window to record and post credit card receipts and ACH checks in your Sage 100 Contractor general ledger and to transfer the payment details to Sage Exchange.
   Alternatively, you can use the Electronic Receipts window to keep your Sage 100 Contractor ledger up to date by recording and posting receipts that you entered directly in Sage Exchange using Sage Virtual Terminal.
4. Use the **1-3 Journal Transactions** window to view the journal entry created for an electronic receipt, to view details of an electronic receipt, and to print a copy of an electronic receipt.
Jobs

When you create a job in the 3-5 Jobs (Accounts Receivable) window, Sage 100 Contractor creates a record containing job-related information such as important contract dates, job financial information, and job-related contacts. In addition, the 3-5 Jobs (Accounts Receivable) window provides a variety of tools to help you manage contracts, such as pre-liens and lien releases. You may also create phases or bid items to divide work into more manageable sections.

Billing information such as the client, job architect, engineer, or project lender, may also be included as part of the job record. For example, when you supply the client number, Sage 100 Contractor includes the client information on invoices printed for that job. If you include the architect or engineer’s name in the job record when using progress or unitary billing, Sage 100 Contractor uses that information when creating a progress or unitary bill. If you include the lender, Sage 100 Contractor uses the lender information when creating a loan draw document. You can also set job level security for each job.

You may manage all your jobs directly from your Project Work Center. You may also create a desktop shortcut to Project Work Center and place it on the Sage 100 Contractor Desktop. This gives you the power to access all your job-related data from one place.

Phases

**NOTE:** Job phases, in contrast to bid items, affect estimates and some billing items and follow through the entire job.

**IMPORTANT:** Phase 0-None is merely a place holder representing the fact that you are not using phases. To use phases, you must begin with phase 1 or higher.

Using phases in a job affects all its aspects, for example:

- Job schedules
- The job budget
- All document control
- Purchase orders
- Subcontracts
- Change orders
- Proposals
- Project management reports and analysis
- Job costs
- Change orders
- Payables
- Billing

Phases organize jobs and can represent different sections of a job, such as different buildings or lots. You can also use phases to distinguish different types of work, such as change orders or site work. Because phases flow through the entire job, they do not restrict which billing methods you can use.

Suppose a contract is for the construction of five houses. To track costs that benefit the entire project, create a phase for the project costs. Then create a phase for each lot. The list of phases might look like following:
Phases can include the billing amount and model number. The billing amount represents the total amount you are billing for the phase. When working on subdivisions, you can track which model home to build on each lot by assigning the appropriate model number to each phase.

You can also include a unit of measure and quantity measured in each phase. To continue the example above, the plans provide the total square footage for each house; therefore, enter square feet as the units and the total square footage of the house as the quantity.

**Bid Items**

***IMPORTANT***: Bid items, in contrast to job phases, only affect estimates and some billing items and do not follow through the entire job.

Bid items provide a way to divide estimates into smaller parts. You use bid items to segment estimates into smaller units and/or to satisfy external requirements for bidding and billing a job. Bid items affect these line items: Daily Field Reports, Proposal, and Unitary Billing.

Bid items can be entered in either 9-5 Takeoffs or in 3-5 Jobs (Accounts Receivable). There are four bid item types: 1-Base Bid, 2-Allowance, 3-Alternate, and 4-Change Order. Bid items may follow the general schema of the Construction Specifications Institute (CSI), such as 1-General Conditions, 2-Site Work, 3-Concrete, etc., or they may be specific to your business needs.

Bid items can provide a solution when a client or lender requires you to submit a proposal based on bid items. Some contractors even use bid items internally as another way to track project data. The bid item categories can differ from job to job and are not necessarily determined by types of work performed. After the list of bid items is set up for a job, you can use the bid items when creating an estimate budget and proposal. In addition, you can create unitary bills by bid item. You can also use the Item Code column to reference alphanumeric codes, which are required by many projects.

You can provide overhead and profit rates for each bid item. When you calculate a takeoff the first time, Sage 100 Contractor applies the appropriate overhead and profit rates to the extended costs of the assemblies and parts listed under each bid item. You can update or change the overhead and profit rates from the Bid Items window at any time.

**Examples of bid items**

Some jobs require contractors to use bid items as a means of breaking apart costs into different categories. Bid items can vary greatly from job to job. Some jobs might only use a few bid items, while others might use well over 100 bid items.

The following example illustrates a short list of bid items for the repair of a water system:

<table>
<thead>
<tr>
<th>Phase #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>Project costs</td>
</tr>
<tr>
<td>200</td>
<td>116 Maple Street</td>
</tr>
<tr>
<td>300</td>
<td>124 Maple Street</td>
</tr>
<tr>
<td>400</td>
<td>130 Maple Street</td>
</tr>
<tr>
<td>500</td>
<td>140 Maple Street</td>
</tr>
<tr>
<td>600</td>
<td>160 Maple Street</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Row</th>
<th>Item#</th>
<th>Item Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>None</td>
<td>1—Base Bid</td>
</tr>
</tbody>
</table>
Some jobs require a more extensive list of bid items. The following example illustrates a more comprehensive list for the construction of an elementary school:

<table>
<thead>
<tr>
<th>Row</th>
<th>Item#</th>
<th>Item Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>None</td>
<td>1—Base Bid</td>
</tr>
<tr>
<td>2</td>
<td>1000</td>
<td>General requirements</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>2000</td>
<td>Rough grading/utilities</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>3000</td>
<td>Site concrete</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>5000</td>
<td>Paving</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>6000</td>
<td>Landscaping</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>7000</td>
<td>Foundation slabs</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>8000</td>
<td>Wood framing</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>9000</td>
<td>Insulation</td>
<td></td>
</tr>
</tbody>
</table>

Paygroups for Jobs

Companies that work different prevailing-wage jobs at the same time can use paygroups to manage the wage and benefit requirements for each job. For each prevailing-wage job, you can set up a table of paygroups and employee positions.

When you enter a job number on a timecard, Sage 100 Contractor looks at the job record to determine if it contains a table of paygroups. Sage 100 Contractor then compares the employee’s position number from the employee record with the position number assigned to each paygroup in the job record. When Sage 100 Contractor matches the employee’s position with a position assigned to a paygroup, it inserts the paygroup in the timecard line.

Because Sage 100 Contractor uses employee positions to determine the correct paygroup, it is important to assign a different employee position to each paygroup in the table. Otherwise, Sage 100 Contractor uses the first paygroup it finds with the correct position, ignoring other paygroups that contain the same employee position.

In some companies, employees perform different types of work over the course of a job, and a single paygroup cannot cover the different wages and benefits paid based on the type of work performed. Therefore, it is necessary to set up the list of job-specific paygroups differently.

Receivable Clients

Use the 3-6 Receivable Clients window to store information about past, current, and future clients as well as manage the sales process and track client related issues. To help manage sales, you can keep track of referrals, appointments, and call
back dates. You can even keep track of when you last mailed a brochure to a client. In addition, you can set up customized lists to provide information about the lead source, region, company size, and to which mailing list they have been assigned.

Using information from the client database, you can create all kinds of client-related documents and reports. For example, the Greeting text box, in which you can enter a personalized greeting such as the owner’s nickname, provides a way to personalize documents. When creating the form design, you can insert a field representing the information in the Greeting text box. Then when you print the document, Sage 100 Contractor replaces the field with the information from the Greeting text box.

**Tax Districts and Tax Entities**

Most states and many cities impose taxes on sales. The seller must add the tax to the selling price and then pay the taxes to the government. In the construction trades, contractors are usually not responsible for collecting taxes. However, certain types of work require contractors to collect and remit sales taxes to the appropriate government agency. The Tax Districts window provides the flexibility necessary to manage, compute, and report the individual sales taxes levied by state, county, and municipal governments.

When you create an invoice, Sage 100 Contractor determines the sales taxes from the indicated tax district. A tax district is comprised of a group of tax entities to which you report the taxes collected within that particular region. Before you can create a tax district, you must create the tax entities.

After you have set up the various tax entities, you can build different tax districts from them. For a given tax district you can include five tax entities, indicate which cost types are taxable, and indicate whether profit is taxable. To calculate taxes, Sage 100 Contractor separately computes the tax for each entity contained in the tax district, but on the invoice provides a total of the taxes.

Suppose a contractor works in a given state. In the state the sales tax rate is 7.25 percent, and in addition, a given county has a 0.25 percent sales tax rate. Before creating a tax district, the tax entities, titled (State) and (Name) County, are set up, each with its specified rate. The contractor then creates tax district 1-(Name) County, CA, which contains the tax entities (State) and (Name) County. When setting up job records for projects in the county, the contractor can include the tax district. Later when entering invoices, Sage 100 Contractor automatically uses tax district 1-(Name) County, CA and computes the appropriate state and county taxes.

You can also set up tax entities to compute discretionary surtaxes. When calculating the taxes for a job, both the sales tax and the discretionary surtax apply until the total of the taxable items on the billing invoice(s) equal or exceed the maximum. At that time, the discretionary surtax no longer applies, and only the sales tax continues to apply.

Sales tax requirements differ from region to region. In one region you might not have to report any sales tax, while in another region you might need to report taxes on everything but subcontract work. Before setting up the tax districts, consult the local tax agencies to determine the correct tax rates.

**Lead Management**

Use the Sales and Marketing tab in the 3-6 Receivable Clients window to manage clients and sales leads. You can provide information such as the date when you received the sales lead, indicate the source of the lead, and determine which mail list to use for that particular client.

Using the client information, you can create custom reports to examine your customer base, create targeted customer newsletters or marketing campaigns, or even create a mailing list for holiday cards.
Progress Billing

About progress billing for jobs

The 3-7 Progress Billing window provides a system for creating progress billings, with each new application building on the previous submitted application for a job. Then under each job, Sage 100 Contractor assigns each application its own application number. Most progress bills are printed on AIA certificates.

Creating a progress bill requires that you provide some basic information in the Progress Billing Setup window. You can provide the name of the architect and the architect’s job number for the project, as well as the income posting account, tax district number, retention rates, and a maximum for retention.

To create an application, import the cost codes or divisions from the job’s budget or proposal. You can then select several ways to automatically update the cost information from the job cost records. When you select the Percent from Costs option, Sage 100 Contractor displays the actual job costs and calculates the percent of work completed by comparing the job costs against the budget. You can instead select either the From Cost Amounts or From Billing Amounts option to display only the amounts for each cost code.

When you create an application, Sage 100 Contractor assigns it status 1-Open. After you have submitted the application, submit the record in Sage 100 Contractor by clicking the Submit button. Sage 100 Contractor then changes the application’s status to 2-Submitted. When the billing is approved, post the billing by clicking the Post button. Sage 100 Contractor creates an invoice, posts it to the general ledger, and then changes the application’s status to 3-Posted. When you want to create the next application, click the Next button. Sage 100 Contractor assigns the posted application status 4-Closed, moves the costs from the Current Quantity column to the Previous Quantity column, and advances the number in the Application# text box.

You can also update the costs of the change work to the progress bill. You can either incorporate the changes to the costs in the cost codes or divisions, or include the total amount of the change order as a separate line item.

Loan Draw Requests

About loan draw requests

The 3-8 Loan Draw Requests window provides a system for creating loan draw applications. For each job, you create a series of applications with each new application building on the previous application submitted to the lender. Under each job, Sage 100 Contractor assigns each application its own application number.

To create the first loan draw application, import the cost codes from the job’s budget or proposal. You can then select from several ways to automatically update the cost information from the job cost records. When you select the Percent from Costs option, Sage 100 Contractor displays the actual job costs and calculates the percent of work completed by comparing the job costs against the budget. You can instead select the From Cost Amounts or From Billing Amounts option to display only the amounts for each cost code.

If the lender requires specific classes that differ from your cost codes, you can manually enter the lender’s classes. However, there is no relationship between the lender’s classes and your cost codes. Therefore, you will have to update the loan draw applications manually.

When you create an application, Sage 100 Contractor assigns it status 1-Open. After you have submitted the application to the lender, submit the record in Sage 100 Contractor by clicking the Submit button. Sage 100 Contractor then changes the application’s status to 2-Submitted. When you want to create the next application, click the Next button. Sage 100 Contractor assigns the submitted application status 4-Closed, and then creates the next application in the series.
In the **6-4-1 Change Orders** window, you can also automatically update the costs of the change work to the loan draw application. You can either incorporate the changes to costs in the individual cost codes, or include the total amount of the change order as a separate line item.

**Unitary Billing**

**About unitary billing for jobs**

With certain types of work, it is more difficult to estimate the amount of work necessary to complete the job. For example, with grading or excavation work it proves easier for a contractor to bill for the number of units of earth moved. The **Unitary Billing** window provides a system for creating a series of unit-based applications, with each new application building on the previous application for a job.

Creating a unitary bill requires that you provide some basic information in the **Unitary Billing Setup** window. You can provide the name of the architect and the architect’s job number for the project, as well as the income posting account, tax district number, and the retention rate.

To create an application, import the bid items from the job’s unitary proposal. You can then enter the number of units of work completed. If change orders are issued, you can also enter the units of change. When you calculate the application, Sage 100 Contractor determines the billing amount based on the units of change and the units of work completed.

When you create an application, Sage 100 Contractor assigns it status **1-Open**. After you have submitted the application, submit the record in Sage 100 Contractor by clicking the **Submit** button. Sage 100 Contractor then changes the application’s status to **2-Submitted**. When the billing is approved, post the billing by clicking the **Post** button. Sage 100 Contractor creates an invoice, posts it to the general ledger, and then changes the application’s status to **3-Posted**. When you want to create the next application, click the **Next** button. Sage 100 Contractor assigns the posted application status **4-Closed**, moves the costs from the **Current Quantity** column to the **Previous Quantity** column, and advances the number in the **Application#** text box.

**Time and Materials**

**3-10 Time and Materials**

**About time and materials billing**

You can bill clients on a cost-plus basis, which is the cost for time and materials plus overhead and profit. Sage 100 Contractor uses the job cost records as the basis for the billing amounts on the time and materials (T&M) invoices.

When setting up a job for T&M billing, you can:

- Assign separate overhead and profit markup rates to each cost type.
- Assign a shown markup rate to each cost type.
- Assign a hidden markup rate to each cost type. When you calculate T&M invoices, Sage 100 Contractor adds the hidden markup to the job cost. The other markups shown, overhead and profit, are computed on top of the new billing amount. The hidden markup does not appear on the T&M invoice.
- Assign wage rate and equipment rate tables to the job. You can use the tables in place of using labor and equipment costs plus hidden markup. In addition, you can set a minimum daily charge, which is the minimum number of hours per laborer, or you can set the minimum units per piece of equipment to charge.

Suppose you own a backhoe and determine it is necessary to charge a minimum of three hours to recover the costs of ownership, maintenance, and mobilization. At a job site, you only use the backhoe for one hour. When you allocate the equipment use, Sage 100 Contractor bills the client for three hours instead of one.
Consider the following additional points:

- If equipment records contain rental billing rates, Sage 100 Contractor creates the job cost with the rental billing rate in the **Billing Amount** text box and with the **Override** check box selected. The program uses this amount when calculating the T&M Invoices even if an **Equipment Rate** table is selected for the T & M job.

- If you want to use the T & M **Equipment Rate** table you must either: (1) clear the **Override** check box on the job cost record and exclude billing rates from the equipment record before the job cost records are created; or (2) enter the job cost record directly into **6-3 Job Cost** record.

- If equipment records do not contain billing rates when you calculate the T & M invoices, Sage 100 Contractor replaces the billing amount with the rate from the **Equipment Rate** table. If an **Equipment Rate** table is not assigned to the T&M job, Sage 100 Contractor replaces the billing amount with the cost plus hidden markup.

### Recurring Receivables

**About recurring receivables**

In the **3-11 Recurring Receivables** window, you can set up recurring receivable transactions. Only transactions that have a consistent amount from invoice to invoice and post on a regular basis make good candidates for being set up as recurring receivables.

Sage 100 Contractor does not automatically post recurring receivable transactions; you retain complete control of when to post transactions. You can even set a reminder to prompt users in a specific security group when it is time to post the recurring transactions.

Look at the posting date of a transaction to determine when to post the transaction. After posting a transaction, Sage 100 Contractor advances the posting date based on the transaction cycle. The transaction date does not control or affect the period to which you are posting the transaction. If you need to post a recurring transaction to a different period, change the posting period.

To prevent the possible duplication of invoice numbers, Sage 100 Contractor assigns a unique invoice number to each recurring receivable transaction. The invoice number is actually the combination of a record number and an invoice sequence number.
Chapter 5: Accounts Payable

Working with Accounts Payable

This section of Sage 100 Contractor, 4-Accounts Payable, contains the following subsections:

- **4-1 Payable Reports**—You can run reports to gather and analyze data about your payables. For more information, see

- **4-2 Payable Invoice/Credits**—You can enter transactions, create invoices or credit invoices that affect vendors, track and release retention, view a history of payments for specific invoices, and print and post two-party checks. For more information, see

- **4-3 Vendor Payments**—You can print (single-party or two-party) checks, vouchers, and lien waivers for payable invoices and apply credit invoices to invoices. For more information, see

- **4-4 Vendors (Accounts Payable)**—You can access to vendor information for payable invoices, 1099 balances, ordering materials, and subcontract management. Create a vendor record for each business that sends you invoices and each business to which you owe money or make regular payments. For more information, see

- **4-5 Vendor 1099**—The program tracks and maintains balances for the 1099 reports. Including the vendor number on a vendor check or general ledger check, increases the 1099 balance for that vendor. Voiding the check, decreases the 1099 balance by the check amount for that vendor.

- **4-6 Recurring Payables**—You can set up recurring payable transactions that have a consistent amount from invoice to invoice and post them on a regular basis. This feature allows you to retain complete control of when to post transactions.

- **4-7 Credit Card Management**—You can set up the accounting to manage your business credit cards as part of your regular accounting. Features include setting up accounts, entering receipts, reconciling statements, and paying your credit card bill.

Using the Accounts Payable tools in Sage 100 Contractor, you can manage payable invoices with an accounts payable system that is fully integrated with purchase orders, subcontracts, change orders, job costing, and inventory functions. For example, you can enter a purchase order number to complete your invoice entry in one step. The payable invoice window automatically fills in and performs job costing to ensure that you’re not overcharged or receiving items that you have not approved.

The system automatically posts recurring invoices for expenses such as rent, loan payments, and vehicle purchases. You can track Workers’ Compensation, liability insurance, and license expiration dates of subcontractors. You can even track individual subcontracts, enabling you to manage retention and prevent payment in case there is a dispute.

You can select from a wide variety of check and voucher formats or create your own. Choose multiple check stubs or special check reports to list all invoices paid and automatically generate lien releases with checks or vouchers. You can make partial payments and designate multiple payees on any invoice, and then you can decide which credits to apply to a payment prior to running checks. You can run aging reports “as of” the end of any prior period to match financials even after the period has been closed. The extensive reporting options include compliance reports and 1099 forms.

Most businesses use credit cards for purchases and payments and Sage 100 Contractor helps you manage your credit card accounts. You can create and edit card issuer accounts and then and manage your receipts and charges. Then you can follow those tasks with reconciling your statements and monitoring your payments.
Payable Invoices/Credits

About payable invoices

In the 4-2 Payable Invoices/Credits window, you can enter transactions that affect vendor accounts. You can create payable invoices or credit invoices, track and release retention, or view a history of payments for a specific invoice.

Another critical tool for managing vendors is the ability to print and post two-party checks. From the 4-2 Payable Invoices/Credits window, you can access the Secondary Payees window to manage such invoices. Secondary payees are most often involved with subcontractor invoices because they have sub-vendor suppliers who have lien rights to the project. It is critical to ensure that these suppliers get paid. The use of two-party checks provides this assurance.

A number of other features enhance record entry. When you select the Manufacturer Details option, Sage 100 Contractor includes the manufacturer’s name and part number in the description of each part. To help manage inventory, select the Allow Freight/Variance option to post variances in material or freight costs. When you have finished entering records, use the batch list to verify the invoice totals against the actual invoice totals. The Use PO Sales Tax option is enabled automatically. If you enter an invoice using information from a purchase order, the sales tax is calculated automatically.

Some states do not require subcontractors to carry Workers’ Compensation insurance. In these states, the subcontractors use the general contractor’s insurance policy for the duration of the job, and the general contractor deducts the cost of coverage from payments to the subcontractor. Check with your state for compliance requirements as the laws vary in each state. When entering a payable invoice for a subcontractor, you can calculate the cost of coverage and add it to the invoice as a credit.

Use the Remove Paid/Void Invoices option to remove paid or voided invoices meeting the following criteria:

- The status is Paid or Void.
- The invoice does not have a job number.
- Associated payments have been posted prior to the current year.

About payable credits

There are many circumstances when you might have to enter a credit invoice. Suppose you return materials to a vendor. With the return of the materials, it is necessary to reduce the accounts payable.

When you save a credit invoice, Sage 100 Contractor reduces the vendor balance. However, the credit invoice retains status 1-Open until you apply it against other invoices in the Vendor Payments window. After you have applied the credit balance to other invoices, Sage 100 Contractor assigns the credit invoice status 4-Paid.

You can also apply a credit invoice to an invoice at the time you save the record. If the invoice is fully paid by means of the credit invoice, Sage 100 Contractor changes the status of the invoice to 4-Paid. If the invoice still has a balance after applying the credit, the invoice status is not changed. Likewise, if the entire amount of the credit is applied, the status of the credit invoice changes to 4-Paid. If a credit invoice still has a balance after applying it to an invoice, the status of the credit invoice remains unchanged. You can then apply the remaining credit invoice balance to other invoices in the Vendor Payments window.

**IMPORTANT:** You cannot reverse a credit invoice after applying it to an invoice. If you have applied a credit invoice to the wrong invoice, make reversing entries to correct the error.
Sales and Use Taxes

Using the purchase order sales tax

When you enter a new invoice using information from a specific purchase order, the sales tax defaults from the selected purchase order to the new invoice in the 4-2 Payable Invoices/Credits window. The sales tax appears in the grid and calculates into the total. If changes are made to the Quantity or Price columns in the grid, the Sales Tax and Total amounts are recalculated automatically.

If necessary, you can overwrite the imported sales tax amount in the grid manually. If you do that, however, Sage 100 Contractor no longer computes the sales tax for the record automatically if you make any subsequent changes to the Quantity or Price.

NOTE: Each line item on a purchase order is not independently designated as taxable or non-taxable. The entire purchase order is subject to one designation and the sales tax from the purchase order will be imported to the invoice accordingly.

You can choose to clear the Use PO Sales Tax option and then calculate and add the sales tax to the invoice manually.

To deactivate the Use PO Sales Tax option:

1. Open 4-2 Payable Invoices/Credits.
2. On the Options menu, click Use PO Sales Tax.

About use taxes for payable invoices

Some states levy a use tax on out-of-state purchases. Sage 100 Contractor adds two lines to the invoice. The first line for the use tax debits the same ledger and subsidiary accounts indicated on the first row. For example, if the first row debits the Materials ledger account, the use tax also debits the Materials ledger account.

The second line for the use tax debits a negative amount to the Sales Tax Payable account, increasing the balance. The Sales Tax Payable account is set up on the Receivables tab in the 1-8 General Ledger Setup window.

Work in Progress and Percentage Complete Accounting

About work in progress (WIP)

Many contractors refer to any project in the process of completion as a work-in-progress (WIP). You can print a WIP report for any job to determine the WIP adjustment for percentage complete accounting. Using this adjustment, you can post a transaction that allows you to compare the revenue generated during a given fiscal period to the expenses incurred during the same fiscal period.

WIP also refers to a method of accounting used with speculative projects. Because the contractor owns the project, the contractor must declare improvements to the property as an asset. When the contractor sells the property, he or she then declares the revenue and expense.

Work in progress accounting

CAUTION: Consult your accountant for detailed information about WIP transactions before proceeding to use WIP accounting.

Contractors who own and develop projects sometimes use a different method of accounting than those who develop projects for a client. When a contractor is involved in speculative work, bookkeepers or accountants often use work-in-progress (WIP) accounting. Because the company owning the project is performing the work, the company cannot expense
the costs incurred during improvement of the property. While improvements do not generate income, they increase the value of the asset.

In WIP accounting, when you improve the property the costs incurred are posted to WIP accounts, located in the asset range of the general ledger. Liabilities, such as loans, post to the standard liability accounts until the sale of the property. Upon completion and sale of the project, the expenses and income are declared.

**IMPORTANT:** If you have turned on the **WIP Verification** for job costs, and are posting job costs to a job that is marked **Post expenses to WIP asset account**, you cannot post to a direct expense account. A message appears: **WIP Posting is not = to job costs.** You must correct your posting before you can save.

**IMPORTANT:** If you have turned on the **WIP Verification** for job costs, and are posting job costs to a WIP (Asset) ledger account for a job that is marked for **Post expenses to WIP asset account**, a message appears: **WIP Posting is not = to job costs.** You must correct your posting before you can save.

When you create the asset accounts for a speculative project, designate at least one WIP account in the asset range. It is far more common, however, to establish a ledger account for each cost type such as labor, materials, or equipment. The pre-built ledger account structures supplied with Sage 100 Contractor include WIP accounts. If your company is working on several speculative projects, set up subsidiary accounts using the job number as the subsidiary account number.

**About percentage complete accounting**

Using percentage complete accounting, also referred to as over/under billing, you declare income during the period that you earn it, determined by the percentage of work completed. The percentage complete accounting method allows you to compare the expenses and income generated during the same period. Otherwise, reports such as income statements provide a misleading view of the profitability because it contains the expenses for the current period and income for previous periods.

Instead of determining the WIP adjustment manually, you can print the **6-1-7 Over/Under Billing Report** to determine the over or under billing for any job currently in progress. Because the report calculates the WIP adjustment, you only need to post the necessary journal transactions.

Sage 100 Contractor uses the following process to determine the WIP adjustment. To establish the percentage of work completed, the program divides the accumulated costs by the amount of the current budget. Then to determine the income earned, it multiplies the revised contract (the amount of the original contract plus approved change orders) by the percentage of work completed. Finally, the program subtracts the total amount of the receivable invoices assigned type 1-Contact from the amount of income earned. The resulting amount is the WIP adjustment.

For example, a contractor is working on a home remodel that was budgeted at $100,000 and contracted for $150,000. With $50,000 in costs at the time of billing, the project is 50% complete. The contractor has therefore earned 50% of the contracted amount, which is $75,000. As the contractor has not previously billed anything for the project, there are no billed invoices to deduct from the earnings. The resulting $75,000 WIP adjustment is posted in the **1-3 Journal Transactions** window.

Usually an **Over Billing** account is set up in the **Payable** range of accounts and an **Under Billing** account is set up in the **Receivable** range of accounts. In addition, an **Over/Under Billing** account is set up in the **Income** range of accounts. When you have determined the amount of the WIP adjustment, post a journal transaction. If the WIP adjustment is a positive amount, debit the receivable account and credit the income account. If the WIP adjustment is a negative amount, credit the payable account and debit the income account.

**NOTE:** Some companies reverse the WIP adjustment in the subsequent fiscal period.
Vendor Payments

About vendor payments

This section of Sage 100 Contractor includes 4-3-1 Select Invoices to Pay and 4-3-2 Pay Vendors. Using these windows, you can select invoices to pay or print checks, vouchers, lien waivers, or use ACH payments for payable invoices. You can also apply credit invoices to invoices.

You can open 4-3-1 Select Invoices to Pay window, and then using the Invoices Selection window, set the criteria by which to populate the window grid with invoices.

After opening the 4-3-2 Pay Vendors window, you can use the Payee check boxes to select vendors to pay. The invoices are totaled by vendor.

You can print several reports directly from text links on the window:

- Print Set to Pay Report
- Print check transmittals
- Print lien waivers

Using the Pay By box, you can select to pay by:

- Check
- Voucher
- Credit Card
- ACH Payment

About the Invoice Selection window

When you click 4-3-1 Set Invoices to Pay on the menu tree, the program displays the Invoice Selection window overlaying the 4-3-1 Set Invoices to Pay window. You use the Invoice Selection window to set the criteria by which the invoices will be displayed in the 4-3-1 Set Invoices to Pay grid area.

The window offers six sets of criteria. The following list describes some examples of what you find:

- Under Selection Criteria: Vendor, Job, Due Date, Disc. Date
- Under Pay Options: Exclude Vendors with Overdue Certificates, Pay Retentions
- Under Sort: Record#, Vendor, Job, Vendor/Job
- Under Status: Open, Review, Dispute
- Under Sort By: Number, Name
- Under Display: All Invoices, Job Invoices Only

TIPS:

- Save a specific combination of criteria by clicking Defaults > Save.
- If you do not select any criteria, the programs selects all Open invoices.
About 4-3-1 Select Invoices to Pay

When you open 4-3-1 Select Invoices to Pay, the program displays the Invoice Selection window first with the primary window in the background. This allows you to set the criteria by which you will select invoices. After you select the criteria and click OK, the program populates the 4-3-1 Select Invoices to Pay window with invoices.

The window contains five buttons providing tools for working with the selected invoices.

When you click:

- **Open**—Assigns the status of Open to selected invoices.
- **Review**—Assigns the status Review to selected invoices.
- **Pay**—Sets selected invoices to pay their full default amount.
- **No Pay**—Removes the set to pay amount for the selected invoices.
- **Past**—Sets selected invoices to pay with a discount, even if they are past the discount date.

To pay the full invoice balance, select the invoice and click the Pay button. If you do not want to pay the entire balance of the invoice, enter a different amount. For example, you can make partial payments to vendors and their second payees by entering a Set To Pay amount for any amount less than the stated invoice.

If an invoice was previously set to pay and you decided not to pay it at this time, then select the invoice, and click the No Pay button.

When the invoices are displayed, select an invoice and enter the amount to pay and any applicable discount. If the invoice has already been set to pay, that amount appears on the Set To Pay column. When you set an invoice to pay, Sage 100 Contractor deducts the available discount from the invoice balance and displays the result in the Set To Pay column.

If the payment date to receive a discount has passed, Sage 100 Contractor displays past in the Discount column next to the discount amount and does not deduct the discount from the invoice balance. To take the discount, select the invoice, and click the Past button instead of the Pay button.

**IMPORTANT:**
- You must save your changes in order for the program to recognize the Set To Pay amount.
- If vendors’ certificates are expired, invoices will not appear unless you clear the Exclude Vendors with Overdue Certificates check box on the Invoice Selection window.
- If you select Exclude Vendors with Overdue Certificates and have indicated Yes in the Stop Pay text box in the Certificates window in 4-4 Vendors (Accounts Payable), the program excludes the vendors from the invoice selection in 4-3-1 Select Invoices to Pay.

About 4-3-2 Pay Vendors

Using the 4-3-2 Pay Vendors window, you can print checks, vouchers, and lien waivers for payable invoices. You can also pay by ACH payment or print zero dollar checks.

In addition to printing regular, single-party checks, you can print two-party checks with a secondary payee. When working with secondary payees, the grid displays the secondary payee name appended to the vendor, along the word “and.” This is similar to the way the payee appears on the printed check.

When you open the 4-3-2 Pay Vendors window after setting invoices to pay using 4-3-1 Set Invoices to Pay, the selected vendors appear in the grid area. When you select a vendor using the Payee check box, the program displays the amount in the Total Selected for Payment box. Then you select a method of payment. You can pay by check, voucher, credit card, or ACH payment. You can click the Change the posting period button in the top right to change the posting period.
Printing Reports and Waivers

The window displays three text links:

- **Print Set to Pay Report**—Opens the 4-3-1 Report Printing window with the 21-Set to Pay Report selected.
- **Print Check Transmittals** - Opens the 4-3-2 Report Printing window with the 21-Check Transmittal Report selected.
- **Print Lien Waivers**—Opens the 4-3-3 Report Printing window with the 21-Lien Waiver selected.

Printing vendor payment checks

Before printing vendor payment checks, consider these two points:

- If applicable and before printing checks, you must print lien waivers. Click the Print lien waivers text link in the lower-left corner of the window.
- If the amount of payment to a vendor results in a zero amount through the application of a credit, you must print a $0 check. Printing the $0 check is necessary to complete the invoice payment process. In the Report Printing window, select the Print $0 Checks check box.

**CAUTION:** Only print accounts payable checks from one company and from one computer at a time. Printing accounts payable checks from one company and more than one computer at a time may cause duplicate check numbers and duplicate payments.

To print vendor payment checks:

1. **Open 4-3-2 Pay Vendors.**
   The total invoices of the vendors you have selected using 4-3-1 Set Invoices to Pay appear in the grid area.

2. **Click the Select All button,** or alternatively select vendors individually.

3. **Click the Pay By drop-down arrow,** and select either to pay by check, voucher, or credit card.

4. **Click OK.**

   a. If you are paying by check, on the 4-3-5 Report Printing window, select the Report Form that suits your business. Your choices are 21-Open Stub, 22-Formatted Stub, and 23-No Job Stub. Then click the Print records icon. When you print checks, Sage 100 Contractor creates ledger transactions. You can also specify the sorting of the invoices on your check stub. Select the option to sort the invoices in the 4-3-5 Report Printing window. Sage 100 Contractor prints the invoice numbers on the check stub; however, sometimes more than one check stub is required to print all the invoices. You can print additional check stubs with void checks to complete the printing of the invoices. In the Report Printing window, select the Multiple Checks check box.

   b. If you are paying by voucher, on the 4-3-4 Report Printing window, select the appropriate Report Form and click the Print records icon.

   c. If you are paying by credit card, the program displays the Credit Card Selection window. Specify a Card Issuer Account, a Credit Card, a Trans#, a Trans Date, and click OK.

About vendor payment reports

The 4-3-2 Pay Vendors window provides text links to these reports.
### Lien Waivers and Vouchers

#### About lien waivers

A lien waiver is a document signed by a contractor, subcontractor, or other supplier of goods or services stating that the supplier has been paid for the work performed or goods supplied and waiving the supplier’s right to file a claim against the property.

In the 3-5 Jobs (Accounts Receivable) window, you can track the lien waivers that you receive for each job. You can also print lien waivers for vendors receiving payment through the 4-3 Vendor Payments window.

**IMPORTANT:** You must print lien waivers before printing payable checks or vouchers. You can also save the lien waiver as a PDF file and reprint it later.

#### Printing lien waivers

You can print lien waivers for subcontractors to sign upon receipt of payment. The waiver details the invoices, invoice balances, and amount paid. The generic text can be modified so that the lien waiver complies with your state requirements.

**IMPORTANT:** You must print lien waivers before printing payable checks or vouchers. You can also save the lien waiver as a PDF file and reprint it later.

**To print a lien waiver:**

1. Open 4-3-1 Set Invoices to Pay.
2. On the Invoice Selection window under Selection Criteria, select criteria with which to populate the grid area on 4-3-1 Set Invoices to Pay.
3. On 4-3-1 Set Invoices to Pay for each invoice, enter the amount you want to pay in the Set to Pay box.
4. Click File > Save, and then open 4-3-2 Pay Invoices.

---

<table>
<thead>
<tr>
<th>Report</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Set to Pay report</td>
<td>Review the invoices for each vendor that you have set to pay. The report provides the invoice balance, invoice retention, discount available, and the amount set to pay for each invoice. The report also summarizes the data for each vendor and provides grand totals.</td>
</tr>
<tr>
<td>Print check transmittals</td>
<td>Lists the invoices that you are paying. When the list of invoices is too long to fit the checkstub, you can supply the vendor with a check report. The Minimum Number of Invoices box on the Check Transmittal Minimum Invoice Number window controls the minimum number of invoices that the payment references. To set a minimum number before writing a check, enter a number in the Minimum Number of Invoices box. Leave the box blank if you do not need to set a minimum number of invoice references. When you print the Check Transmittal Report, Sage 100 Contractor determines which checks meet the minimum and prints a report for each.</td>
</tr>
<tr>
<td>Print lien waivers</td>
<td>Displays the lien waiver information for the contractor for invoice or invoices that are set to pay.</td>
</tr>
</tbody>
</table>

**NOTE:** The check report uses the set-to-pay information; therefore, you must print the check report before printing the vendor checks.
5 Select the check boxes of the invoices for which you want print lien waivers, and then click the text link, Print Lien Waivers.

6 On the 4-3-3 Report Printing window on the Report Criteria tab, select the report number, report form, and set the criteria.

7 On the toolbar, click one of the printing options, such as the Print records icon.

**Paying by vouchers**

Lending institutions use vouchers to control the job expenditures of a contractor’s speculative work. When you are ready to pay materials suppliers and subcontractors, print and send the vouchers to the lender. The lender then pays the vendors based on the amounts indicated on the vouchers.

Because the lender is making the payments, vouchers do not affect your cash balance. They do, however, affect the balance of your Loan Payable account.

**To pay by voucher:**

1 Open 4-3-2 Pay Vendors.
   Invoices that you have selected using 4-3-1 Set Invoices to Pay appear in the grid area.

2 Click the Select All button, or alternatively select invoices individually.

3 Click the Pay By drop-down arrow, and select pay by Voucher.

4 Click [Pay Vendors].

5 On the 4-3-5 Report Printing window, select the appropriate Report Form and click the Print records icon.

6 Enter a transaction to record the loan disbursement.

7 Select the [Update 1099 Balance] check box to add the voucher to the 1099 balances when printing vouchers.

8 Click [OK].

> **TIP:** The vouchers work like checks in that you can print vouchers to paper. The program displays these options: Post ALL vouchers, Post vouchers through voucher#, or Do not post any vouchers.

**Vendors (Accounts Payable)**

**About 4-4 Vendors (Accounts Payable)**

Vendor records provide quick access to vendor information for payable invoices, 1099 balances, ordering materials, and subcontract management. Create a vendor record for each business that sends you invoices and each business to which you owe money or make regular payments. These vendors may include subcontractors, architects, engineers, and lenders.

In the 4-4 Vendors (Accounts Payable) window, you can review vendor-related information such as subcontracts, purchase orders, and invoices. You can also record any additional certificates a vendor is required to supply.

You would select the Internal Vendor check box to keep track someone you need in the vendor database, but not someone from whom you get invoices. Flagging a vendor as “internal” cause the program to display a message if you try to enter a payable invoice for that vendor.

Examples of internal vendors are architects, engineers, or other professionals who are involved with projects that you work on, but you are not the one contracting with them because you are not the general contractor or owner. You might, however, want to keep that information in the job record.

Internal vendors may also be fictitious entities, such as a generic lumber supply or generic tile subcontractor. You might want to use that entity for putting a “type” of vendor on parts for estimating and bid request reasons.
About vendor certificates and expiration dates

You can track the expiration dates for Workers’ Compensation, liability insurance, contractor’s licenses, and other required certificates and licenses. When you enter a certificate or license, always enter an expiration date. If you do not have a date, enter one that is obviously expired such as 01/01/1980. Later, you can determine which vendors have insurance or licenses that have expired.

IMPORTANT: The 4-1-5-31 Vendor Worker’s Comp Report requires that the Workers’ Compensation insurance certificate information be in Row 1 of the Certificates window grid.

You can control whether you receive a warning that a certificate has expired when creating a subcontract. You can also stop payment to a vendor if a certificate has expired.

When selecting vendor invoices for payment, you can exclude vendors with expired licenses. You can also print documents that you can send to vendors with expired licenses, requesting the new expiration dates to update your records. When you do not need dates for vendors such as lending institutions, leave the text boxes blank.

Reports on vendor certificates and expiration dates

You can run insurance reports to view which vendors have current and/or expired certificates. How?

- 4-1-1-41 Insurance Report
- 4-1-1-42 Insurance Report–by Vendor Type
- 4-1-1-43 Insurance Report–Alpha
- 4-1-1-46 Insurance Report–with Notes
- 4-1-1-47 Insurance Report–by Vendor Type; with Notes
- 4-1-1-48 Insurance Report–Alpha; with Notes

Setting up Workers Compensation rates for payable invoices

Some states do not require subcontractors to carry Workers’ Compensation insurance. In these states, the subcontractors use the general contractor’s insurance policy for the duration of the job, and the general contractor deducts the cost of coverage from payments to the subcontractor. Check with your state for compliance requirements as the laws vary in each state.

Sage 100 Contractor uses the Workers’ Compensation account indicated on the Payables tab in the General Ledger Setup window to post payable invoice transactions.

To set up a Workers’ Compensation rate for payable invoices:

1 Open 4-4 Vendors (Accounts Payable).
2 Using the data control, select the vendor.
3 Click the Invoice Defaults tab.
4 In the Work Comp Rate box, enter the rate at which you are charging the subcontractor.
5 On the File menu, click Save.
6 Open 1-8 General Ledger Setup.
7 On the Payables tab, enter the ledger account to which you are posting the charge to subcontractors in the Workers’ Compensation box.
8 On the File menu, click Save.
TIP: The credit does not appear on the Workers’ Compensation report, which only uses data from payroll records. To track and report the costs, create a separate Workers’ Compensation ledger account.

Secondary Payees

The **Secondary Payees** window provides a way to add secondary payees to invoices. Secondary payees are most often involved with subcontractor invoices because they have sub-vendor suppliers who have lien rights to the project. It is critical to ensure that these suppliers get paid. The use of two-party checks provides this assurance.

There are several ways to enter the secondary payee. You can do so when you enter a new subcontractor’s invoice in the **4-2 Payable Invoices/Credits** window by entering the name and amount payable to each supplier in the **Secondary Payees** window. You can also add one or more secondary payees to existing vendor invoices.

You will notice upon looking at the **Secondary Payees** window that it has three main parts: the grid, the vendor line, and the totals line.

<table>
<thead>
<tr>
<th>Grid Columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary Payee</td>
<td>The name for the second party that will appear on the two-party check.</td>
</tr>
<tr>
<td>Amount</td>
<td>The total amount that should be paid on two-party checks to the payee.</td>
</tr>
<tr>
<td>Paid</td>
<td>The total amount of payment made to this payee. This column is not editable.</td>
</tr>
<tr>
<td>Balance</td>
<td>The <strong>Amount</strong> minus the <strong>Paid</strong> as calculated by Sage 100 Contractor. This column is not editable.</td>
</tr>
<tr>
<td>To Pay</td>
<td>The amount scheduled for a two-party check. This column allows you to enter or edit the amount.</td>
</tr>
</tbody>
</table>

The vendor line appears under the grid. The information in the vendor line reflects information related to the grid columns for the vendor on the invoice.

<table>
<thead>
<tr>
<th>Vendor Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Name</td>
<td>Displays the vendor name and the invoice information that applies directly to the vendor.</td>
</tr>
<tr>
<td>Amount</td>
<td>The amount is reduced as entry is made in the <strong>Amount</strong> column in the grid. In other words, the vendor receives whatever funds remain after the secondary payee(s) are paid.</td>
</tr>
<tr>
<td>Paid</td>
<td>The total amount of payment that has been made directly to the vendor.</td>
</tr>
<tr>
<td>Balance</td>
<td>The <strong>Amount</strong> minus the <strong>Paid</strong>. It is likewise adjusted whenever the <strong>Amount</strong> on this line changes.</td>
</tr>
<tr>
<td>To Pay</td>
<td>The amount scheduled for payment directly to the vendor. This text box allows you to enter or edit the amount.</td>
</tr>
</tbody>
</table>

The totals line appears under the double line and reflects the entire invoice. The **To Pay** total reflects the sum of all **To Pay** amounts on this window. Upon saving it is sent back to its corresponding field at the bottom of the **4-2 Payable Invoices/Credits** window.

Retention values are not reflected on this window. Retention that is entered on **4-2 Payable Invoices/Credits** is held against the vendor’s balance. You cannot hold a portion of the invoice retention against a secondary payee. However, you can pay 90% on one check and the remaining 10% on a later check.

Discounts are not reflected on this screen. They are applied against the vendor’s balance. You cannot apply a portion of the invoice’s discount against the balance of a secondary payee.

After saving the information in the **Secondary Payees** window and subsequently the **4-2 Payable Invoices/Credits** window, the next logical step could be to print and post the checks using the **4-3 Vendor Payments** window. You will
notice that the single invoice appears in the grid as multiple lines with the second payee lines directly under the vendor’s portion. When you sort the grid, these lines stay together.

Here is an example. Suppose you subcontracted the electrical work on the construction of a home. Upon completion of the job, the subcontractor sends an $8,500 invoice, the amount of the contract. The invoice lists three suppliers and the associated costs: a materials supplier—$2,000; a lighting supplier—$1,500; and an equipment supplier for a backhoe to perform ground work—$300. To ensure that each of the subcontractor’s suppliers is paid, you can print a two-party check for each supplier.

When you print checks from the 4-3 Vendor Payments window, Sage 100 Contractor prints four checks based on the amounts in the Secondary Payees window. A check to the subcontractor and materials supplier for $2,000; a check to the subcontractor and lighting supplier for $1,500; a check to the subcontractor and equipment supplier for $300; and a check to the subcontractor for $4,700, which is the vendor’s portion that is not attributed to a second payee.

**NOTES:**
- No information on the Secondary Payees window may be edited when the invoice has a status of 4-Paid or 5-Void.
- You can add multiple additional secondary payees to an invoice.
- You can change amounts to be paid to secondary payees as long as no payment has been made.
- You can change the name of the secondary payee as long as no payments have been made.
- You can remove secondary payees as long as no payments have been made.

**Entering payable invoices that include secondary payees**

In your contracting work, you receive a payable invoice from a new vendor for their work. Part of the invoice is to be paid as a two-party check to one of their suppliers. Use the following procedure to handle this situation.

**NOTES:**
- You must manually click the Wk/Comp button and the Use Tax button in order for the record to calculate the vendor’s workers’ compensation rate and use tax rate. You can set up the use tax rate and the compensation rate on the Invoice Default tab of 4-4 Vendors (Accounts Payable).
- Payable invoice status can be: 1-Open, 2-Review, 3-Dispute, 4-Paid, or 5-Void.
- Payable invoices can have two different types: 1-Contract and 2-Memo.
- Payable invoices can be saved as: Save, Save/Set To Pay, and Save/Autocost.
- If you enter an invoice using information from a purchase order, the sales tax will automatically default into the invoice. You can choose to deactivate the automatic sales tax feature and to enter the sales tax manually.

**To enter a payable invoice that includes a secondary payee**

1. Open 4-2 Payable Invoices/Credits.
2. Do the following:
   a. In the Invoice# box, enter the invoice number.
   b. If the invoice is for a purchase order, in the Order# box enter the purchase order number.
   c. If the invoice is for a subcontract, in the Contract# box enter the subcontract number. You can turn on an option to verify the contract balance against the invoice.
   d. In the Vendor box, enter the vendor number.
e In the **Job** box, enter the job number.

f If the job uses phases, enter the phase number in the **Phase** box.

**g** In the **Description** box, enter a description.

**h** In the **Invoice Date** box, enter the date of the invoice.

i In the **Due Date** box, enter the invoice due date.

**j** In the **Discount Date** box, enter the discount due date. This is the last day by which the vendor can receive payment for you to receive a discount.

**k** In the **Shipping#** box, enter the shipping tag or ticket number.

**l** In the **Reference#** box, enter an invoice or credit number to apply this entry to.

**m** In the **Status** list, click the invoice status.

**n** In the **Type** list, click the invoice type.

3 In the grid, do the following:

a In the **Description** cell, enter a brief statement about the item.

b In the **Price** cell, enter the price per unit.

c In the **Account** cell, enter the ledger account number.

4 Repeat step 3 for each item.

5 Below the grid, in the **Discount** box, enter the discount for early payment. By default, Sage 100 Contractor calculates the discount amount using the rate from the vendor record.

6 In the **Retention** box, enter the amount of retention. By default, Sage 100 Contractor calculates the retention (if applicable) using the rate from the subcontract, which is found on 6-7-1 **Subcontracts**.

7 Click the **Secondary Payees** button. The **Secondary Payees** window opens.

8 In the **Second Payee** column, enter the name of the secondary payee.

9 In the **Amount** column, enter the amount payable to the secondary payee.

10 Click the **Save** toolbar button, which saves your entries and closes the window.

11 When considering Workers’ Compensation rates and use tax:

   - If the vendor is set up with a Workers’ Compensation rate, and you want it to be calculated with this record, click the **Wk/Comp** button.

   - If the vendor is set up with a use tax rate and you want it to be calculated with this record, click the **Use Tax** button.

**IMPORTANT:** You have to manually click the **Wk/Comp** button and the **Use Tax** button in order for the record to calculate the vendor’s Workers’ Compensation rate and use tax rate. You can set up the use tax rate and the Workers’ Compensation rate on the **Invoice Details** tab of 4-4 **Vendors (Accounts Payable)**.

12 In **4-2 Payable Invoices/Credits**, click **Save**.

### Adding secondary payees to existing payable invoices

**NOTE:** You can add secondary payees as long as the amount does not cause the vendor’s balance to become negative.

In your contracting work, you receive and enter a payable invoice from a existing vendor for subcontract work. You enter and save the invoice, which exists in your database with a record number. Subsequently the contractor informs you that a
portion of that invoice should be paid as a two-party check to one of the vendor’s suppliers. Use the following procedure to handle this situation.

To add a secondary payee to an existing payable invoice

1. Open 4-2 Payable Invoices/Credits.
2. Using the data control, locate and open the existing invoice.
3. Click the Secondary Payees button. The Secondary Payees window opens.
4. In the Secondary Payee column, enter the name of the secondary payee.
5. In the Amount column, enter the amount to be paid to the secondary payee.
6. Click the Save toolbar button, which saves your entries and closes the window.
7. In the 4-2 Payable Invoices/Credits window, click Save.

Increasing amounts payable to second payees

IMPORTANT: You can increase the amount payable to secondary payees as long as the amount does not cause the vendor’s balance to become negative.

In your contracting work, you enter and save a payable invoice from a vendor for their work. The invoice is to be paid with one check going to the vendor in addition to a two-party check going to one of their suppliers. The vendor requests that you increase the amount of the two-party check. Use the following procedure to handle this scenario.

To increase the amount payable to a second payee

1. Open 4-2 Payable Invoices/Credits.
2. Using the data control, locate and open the existing invoice.
3. Click the Secondary Payees button.
4. The Secondary Payees window opens.
5. In the Amount column, increase the payable amount.
6. Click the Save button.
7. Open 4-3 Vendor Payments to print and post the checks.

Decreasing amounts payable to secondary payees

IMPORTANT: The amount to be paid to secondary payees cannot be decreased to less than the amount already paid.

In your contracting work, you enter and save a payable invoice from a vendor for their work. The invoice is to be paid with one check going to the vendor in addition to a two-party check going to one of their suppliers. The vendor requests that you decrease the amount of the two-party check. Use the following procedure to handle this situation.

To decrease the amount payable to a second payee

1. Open 4-2 Payable Invoices/Credits.
2. Using the data control, locate and open the existing invoice.
3. Click the Secondary Payee button.
4. The Secondary Payee window opens.
5. In the Amount column, decrease the payable amount.
6  Click the Save button.

7  Open 4-3 Vendor Payments to print and post the checks.

About secondary payees

The Secondary Payees window provides a way to add secondary payees to invoices. Secondary payees are most often involved with subcontractor invoices because they have sub-vendor suppliers who have lien rights to the project. It is critical to ensure that these suppliers get paid. The use of two-party checks provides this assurance.

There are several ways to enter the secondary payees. You can do so when you enter a new subcontractor’s invoice in the 4-2 Payable Invoices/Credits window by entering the name and amount payable to each supplier in the Secondary Payees window. You can also add one or more secondary payees to existing vendor invoices.

You will notice upon looking at the Secondary Payees window that it has three main parts: the grid, the vendor line, and the totals line.

<table>
<thead>
<tr>
<th>Grid Columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary Payee</td>
<td>The name for the second party that will appear on the two-party check.</td>
</tr>
<tr>
<td>Amount</td>
<td>The total amount that should be paid on two-party checks to the payee.</td>
</tr>
<tr>
<td>Paid</td>
<td>The total amount of payment made to this payee. This column is not editable.</td>
</tr>
<tr>
<td>Balance</td>
<td>The Amount minus the Paid as calculated by Sage 100 Contractor. This column is not editable.</td>
</tr>
<tr>
<td>To Pay</td>
<td>The amount scheduled for a two-party check. This column allows you to enter or edit the amount.</td>
</tr>
</tbody>
</table>

The vendor line appears under the grid. The information in the vendor line reflects information related to the grid columns for the vendor on the invoice.

<table>
<thead>
<tr>
<th>Vendor Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Name</td>
<td>Displays the vendor name and the invoice information that applies directly to the vendor.</td>
</tr>
<tr>
<td>Amount</td>
<td>The amount is reduced as entry is made in the Amount column in the grid. In other words, the vendor receives whatever funds remain after the secondary payee(s) are paid.</td>
</tr>
<tr>
<td>Paid</td>
<td>The total amount of payment that has been made directly to the vendor.</td>
</tr>
<tr>
<td>Balance</td>
<td>The Amount minus the Paid. It is likewise adjusted whenever the Amount on this line changes.</td>
</tr>
<tr>
<td>To Pay</td>
<td>The amount scheduled for payment directly to the vendor. This text box allows you to enter or edit the amount.</td>
</tr>
</tbody>
</table>

The totals line appears under the double line and reflects the entire invoice. The To Pay total reflects the sum of all To Pay amounts on this window. Upon saving it is sent back to its corresponding field at the bottom of the 4-2 Payable Invoices/Credits window.

Retention values are not reflected on this window. Retention that is entered on 4-2 Payable Invoices/Credits is held against the vendor’s balance. You cannot hold a portion of the invoice retention against a secondary payee; however, you can pay 90% on one check and the remaining 10% on a later check.

Discounts are not reflected on this screen. They are applied against the vendor’s balance. You cannot apply a portion of the invoice’s discount against the balance of a secondary payee.

After saving the information in the Secondary Payees window and subsequently the 4-2 Payable Invoices/Credits window, the next logical step could be to print and post the checks using the 4-3 Vendor Payments window. You will
notice that the single invoice appears in the grid as multiple lines with the second payee lines directly under the vendor’s portion. When you sort the grid, these lines stay together.

Here is an example. Suppose you subcontracted the electrical work on the construction of a home. Upon completion of the job, the subcontractor sends an $8,500 invoice, the amount of the contract. The invoice lists three suppliers and the associated costs: a materials supplier—$2,000; a lighting supplier—$1,500; and an equipment supplier for a backhoe to perform ground work—$300. To ensure that each of the subcontractor’s suppliers is paid, you can print a two-party check for each supplier.

When you print checks from the **4-3 Vendor Payments** window. Sage 100 Contractor prints four checks based on the amounts in the **Secondary Payees** window. A check to the subcontractor and materials supplier for $2,000; a check to the subcontractor and lighting supplier for $1,500; a check to the subcontractor and equipment supplier for $300; and a check to the subcontractor for $4,700, which is the vendor’s portion that is not attributed to a second payee.

In additional, consider the following points:

- No information on the **Secondary Payees** window may be edited when the invoice has a status of **4-Paid** or **5-Void**.
- You can add multiple additional secondary payees to an invoice.
- You can change amounts to be paid to secondary payees as long as no payment has been made.
- You can change the name of the secondary payee as long as no payments have been made.
- You can remove secondary payees as long as no payments have been made.

**Retention**

**About accounts payable retention**

Many job subcontracts include retention. When you create a payable invoice, Sage 100 Contractor withholds retention at the rate specified in the subcontract record. If you do not indicate a retention rate in the subcontract record, you can withhold a flat amount on each individual invoice.

Posting a payable invoice declares the entire amount of the invoice as an expense. However, a percentage of the gross amount is withheld as retention, so the client is actually billed for the net amount (gross invoice amount – retention = net invoice amount). Therefore, retention is already declared as an expense, but is not paid out yet. Consequently, Sage 100 Contractor does not include retention in the invoice aging.

When you are ready to pay the subcontractor for retention, it is not necessary to create a new invoice. You can release retention on each invoice individually, or you can release the retention for the entire subcontract at one time.

**Paying retention on payable invoices**

When you select the **Pay Retentions** check box, Sage 100 Contractor includes retention in the invoice balances displayed in the **Balance** column.

**To pay retention on a payable invoice**

1. Open **4-3-1 Select Invoices to Pay**.
2. In the **Invoice Selection** window, select the criteria for the invoices you want to pay.
3. Under **Pay Options**, select the **Pay Retentions** check box.
4. Click **OK**.
5. In the **Set to Pay** text box, enter the amount you want to pay.
6. Or, select the invoice. Then on the **Options** menu, click **Pay**.
7 Repeat step 6 for each invoice you want to pay.
8 On the File menu, click Save.
9 Print the vendor checks.

To invoice holdbacks on a payable invoice:

Releasing retention on payable invoices

To release retention on a payable invoice:
1 Open 4-2 Payable Invoices/Credits.
2 Using the data control, select the invoice.
3 In the Retention text box, reduce or delete the retention.
4 On the File menu, click Save.

About accounts payable retention

Many job subcontracts include retention. When you create a payable invoice, Sage 100 Contractor withholds retention at the rate specified in the subcontract record. If you do not indicate a retention rate in the subcontract record, you can withhold a flat amount on each individual invoice.

Posting a payable invoice declares the entire amount of the invoice as an expense. However, a percentage of the gross amount is withheld as retention, so the client is actually billed for the net amount (gross invoice amount – retention = net invoice amount). Therefore, retention is already declared as an expense but is not paid out yet. Consequently, Sage 100 Contractor does not include retention in the invoice aging.

When you are ready to pay the subcontractor for retention, it is not necessary to create a new invoice. You can release retention on each invoice individually, or you can release the retention for the entire subcontract at one time.

Batches

Batch numbers group together invoices that you enter in the Payable Invoices window during a single session. To verify the accuracy of the invoices entered, you can display a list of the invoices and compare the entered amounts against the actual invoice amounts.

Sage 100 Contractor maintains a separate series of batch numbers for each user name.

When you open a payable invoice window, Sage 100 Contractor establishes the next batch number in your series by determining the largest batch number last used and incrementing it by 1. Sage 100 Contractor assigns the batch number to each new transaction you enter until the window is closed.

When entering a new record, you can change the batch number. For example, you might want to include an invoice in a prior batch. If you assign a previous batch number to a new invoice, that batch number works for one invoice, and then it changes back to the new batch number.

After you save an invoice, you cannot change its batch number.

Changing batch numbers

If you assign a previous batch number to a new invoice, that batch number works for one invoice, and then it changes back to the new batch number.

To change the batch number
1 Open 4-2 Payable Invoices/Credits.
2 In the Batch text box, enter the batch number you want to assign to the invoice.

**Viewing batch lists for invoices being entered**

**To view the batch list for invoices being entered**

1 Open 4-2 Payable Invoices/Credits.
2 On the Options menu, click Batch List.

**Viewing prior batch lists**

Consider the following points before viewing a prior batch list:

- Each user name has its own series of batch numbers. Sage 100 Contractor shows you the batch list for the user name with which you have logged on to Sage 100 Contractor.
- To view the batch list of another user, select an invoice from the batch you want to view. Then on the Options menu, click Batch List.

**To view a prior batch list**

1 Open 4-2 Payable Invoices/Credits.
2 In the Batch text box, enter the number of the batch you want to view.
3 On the Options menu, click Batch List.

**About batch totals**

Batch numbers group together invoices that you enter in the Payable Invoices window during a single session. To verify the accuracy of the invoices entered, you can display a list of the invoices and compare the entered amounts against the actual invoice amounts.

Sage 100 Contractor maintains a separate series of batch numbers for each user name.

When you open a payable invoice window, Sage 100 Contractor establishes the next batch number in your series by determining the largest batch number last used and incrementing it by 1. Sage 100 Contractor assigns the batch number to each new transaction you enter until the window is closed.

When entering a new record, you can change the batch number. For example, you might want to include an invoice in a prior batch. If you assign a previous batch number to a new invoice, that batch number works for one invoice, and then it changes back to the new batch number.

After you save an invoice, you cannot change its batch number.

**Vendor 1099**

**About Federal 1099 forms**

According to the IRS and Federal tax law, payments totaling $600 or more made to independent contractors over the course of the calendar year must be reported to the IRS. Sage 100 Contractor maintains balances for the 1099 reports regardless of the 1099 status assigned to a vendor record. When you include the vendor number on a vendor check or general ledger check, Sage 100 Contractor increases the 1099 balance for that vendor. If you later void the check, Sage 100 Contractor decreases the 1099 balance by the check amount.

On the 1099 form, the name appearing at the top of the Payee text box must correspond to the identification number in the Federal Id# text box. For sole proprietors, the federal government uses the owner’s social security number as the Federal Identification Number. Therefore, the owner’s name must appear above the business name on the 1099 form.
For vendors assigned status **3-Sole Proprietor**, Sage 100 Contractor automatically prints the name from the **Owner Name** text box in the vendor record above the company name on the 1099 form.

**About 1099 types**

You can locate the list of 1099 types on the **4-4 Vendors (Accounts Payable)** window under **Financial Information**, in a drop-down list with the title **1099**.

**NOTE:** The 1099 is tracked by vendor and not by 1099 type.

<table>
<thead>
<tr>
<th>1099 Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0- Undetermined</td>
<td>No choice has been made.</td>
</tr>
<tr>
<td>1- Miscellaneous</td>
<td>The vendor provides a service, but the vendor is not incorporated. Sage 100 Contractor prints the vendor’s 1099 balance in box 7 of the 1099 form.</td>
</tr>
<tr>
<td>2-Rent</td>
<td>The vendor provides a service, but the vendor is not incorporated. Use this type only when the vendor provides a service to your business by renting office space, yard space, equipment, etc. Sage 100 Contractor prints the vendor’s 1099 balance in box 1 of the 1099 form.</td>
</tr>
<tr>
<td>3-Sole Proprietor</td>
<td>The vendor provides a service but the vendor is not incorporated. Sage 100 Contractor prints the vendor’s 1099 balance in box 7 of the 1099 form.</td>
</tr>
<tr>
<td>4-Interest</td>
<td>Sage 100 Contractor can print interest for this vendor.</td>
</tr>
<tr>
<td>5-No 1099</td>
<td>The vendor does not provide a service, or the vendor is incorporated. Sage 100 Contractor does not print a 1099 for a vendor with this type.</td>
</tr>
</tbody>
</table>

**NOTE:** When the company has no workforce other than the owner, the federal government does not provide a federal identification number to the company. Instead, use the owner’s social security number. For status **3-Sole Proprietor**, enter the owner’s social security number in the **Federal Id#** text box. In addition, enter the owner’s name in the **Owner** text box. When you print the 1099, Sage 100 Contractor prints the social security number and the owner’s name on the 1099.

**Recurring Payables**

**About recurring payables**

In the **4-6 Recurring Payables** window, you can set up recurring payable transactions. Only transactions that have a consistent amount from invoice to invoice and post on a regular basis make good candidates for being set up as recurring payables.

Sage 100 Contractor does not automatically post recurring payable transactions; you retain complete control of when to post transactions. You can even set a reminder to prompt users in a specific security group when it is time to post the recurring transactions.

Look at the posting date of a transaction to determine when to post the transaction. After posting a transaction, Sage 100 Contractor advances the posting date based on the transaction cycle. The transaction date does not control or affect the period to which you are posting the transaction. If you need to post a recurring transaction to a different period, change the posting period.

To prevent the possible duplication of invoice numbers, Sage 100 Contractor assigns a unique invoice number to each recurring payable transaction. The invoice number is actually the combination of a record number and an invoice sequence number.
For example, when you enter the first recurring payables record, Sage 100 Contractor assigns it invoice number RP00010001 (RP—recurring payable, 0001—record number, 0001—invoice sequence number). Each time you post the transaction, Sage 100 Contractor advances the invoice sequence number within the invoice number. The next invoice number in the sequence becomes RR00010002.

**Credit Card Management**

Accounting for your business credit cards is now tightly integrated into your business accounting. Features include setting up accounts, entering receipts, reconciling statements, and paying your credit card bills.

- **4-7-1 Add/Edit Issuer Accounts**—Add credit card issuer accounts in your general ledger in the Current Liabilities range of accounts. Return to this window to edit issuer account information. When you set up issuer accounts you are prompted to add credit cards as subaccounts for the issuer accounts.

- **4-7-2 Add/Edit Credit Cards**—Add credit cards as subaccounts of the card issuer account. You can add one card or multiple cards to one issuer account. Return to this window to edit credit card information.

- **4-7-3 Enter Credit Card Receipts**—Enter the data from hardcopy credit card receipts. You have a choice of entering a vendor or not. If you enter a vendor, the program creates a paid accounts-payable invoice and a general ledger transaction. If there is no vendor on the receipt, the program only creates a general ledger transaction.

- **4-7-4 Enter Recurring Charges**—If you have charges with a constant recurring amount, enter them in this window. This amount is charged to your credit card on a regular basis.

- **4-7-5 Reconcile Credit Card Statements**—Verify credit card charges and payments. When you review your statement, the program organizes the information for each credit card by issuer account and by credit card. Payments are listed at the top of the grid. If there is a question about the charge or payment, you can click a link to go to the transaction. The program also provides a way to add transactions “on-the-fly” right from this window.

- **4-7-6 Pay Credit Cards**—Sends credit card payment information through your general ledger accounting. Creates a ledger transaction in 1-3 Journal Transactions. You can then print a check in 1-1 Checks/Bank Charges if you use “0000” for the transaction number.
Chapter 6: Payroll

Working with Payroll

You can automatically calculate all payroll simply by entering the job, cost code, and time worked. Payroll helps generate accurate labor and job costs by calculating all accruals as well as basic pay items for each line on every timecard. You can even include liability insurance (based on per $1000) and small tool costs, which are automatically posted to job costs in your payroll calculations.

Advanced features enable you to manage prevailing-wage, union benefits, and qualified benefit plans. You can set up a benefit system and assign it to a paygroup. For example, you can set variable-rate payroll to override basic employee calculations as well as calculate rates and benefits only for the assigned localities or specific unions.

Using Payroll, you can take advantage of benefit-cost offsets in addition to separately classified shop and site time. Customizable entry windows speed up your daily operations.

5-5 Daily Payroll, which enables daily batch entry of employee time, is ideal for larger companies. You can import employee time from 6-11-6 Daily Field Reports or the Service Receivables add-on module to verify payroll hours. 5-5 Daily Payroll also integrates with 8-Equipment Management so that you can allocate equipment repair time and costs to projects.

Here are more features of Sage 100 Contractor Payroll:

- Supports Workers’ Compensation systems, including split rates, hourly calculations, and employee and employer portions.
- Calculates standard 401(k), 408(k), “cafeteria,” and qualified benefit plans.
- Includes direct deposit capabilities.
- Automatically prints Certified Payroll and minority reports for any timeframe and job.
- Calculates union payroll reports.
- Supports multi-state and multi-local tax district reporting, including reciprocity.
- Supports electronic reporting and filing.
- Supports piece work payment.
- Applies per diem to any job for accurate job costing of employee reimbursements.
- Automatically converts to weekly, biweekly, or semi-monthly timecards.

Employees

About 5-2-1 Employees

Using the 5-2-1 Employees window, you create an employee record for each employee who works during the calendar year. The record stores personal and work-related information, and acts as the source for each employee’s hourly pay...
rates, salary rates, or paygroups. In addition, you can accrue sick and vacation time, provide direct deposit for employees, and automatically recover payroll advances.

On the Compensation tab, you can enter information about Paygroups, Standard Regular Rate, Commission%, Salary, Accrued Sick, Sick Rate, and more. Under Mark on W-2, you can select the check boxes Retirement Plan and Third-Party Sick Pay to include the appropriate values when preparing the W-2 electronic file.

On the Direct Deposit tab, you enter employees’ direct deposit information and email address for the direct deposit pay stub.

On the Calculations tab, you can select which payroll calculations to use and customize the calculation rates for each employee. Each employee record stores its own calculation rates; you can create one payroll calculation but set up different calculation rates for each employee. When you trial-compute or final-compute payroll, Sage 100 Contractor uses calculation rates from the employee records to compute the deductions and benefits for each employee.

On the Additional Contacts tab, you can add multiple additional contacts for each employee.

**IMPORTANT:** Contacts entered in employee records are not synchronized with Outlook due to security reasons.

You can also create generic employee records for scheduling resources. A single, generic employee can represent an entire crew, such as a framing crew. Use the generic employee to assign employee resources to tasks in a schedule, thereby preventing the over-allocation of labor. For service work, you can use the generic employee as a placeholder for scheduling work orders in the 11-3 Dispatch Board window.

**IMPORTANT:** Do not enter more than one employee record for any one employee. For example, if you make a mistake on an employee record, do not correct the mistake by making a second record for that employee.

**Employee Payroll Calculations**

**About calculations in payroll records**

The Calculations tab in the 5-2-2 Payroll Records window lets you view the deduction and benefit amounts for a timecard after the trial or final-compute. After setting up a new employee record or adding a new payroll calculation to an employee record, it is a good idea to review the computed amounts after a trial-compute. The review ensures that the payroll calculation and the calculation rates in the employee record have been set up correctly.

For a single timecard, you can also manually enter an amount for a payroll calculation and override what Sage 100 Contractor would otherwise compute. During a trial or final-compute, Sage 100 Contractor looks at the Override column. When an Override cell contains Yes, Sage 100 Contractor uses the amount you have entered for that calculation. After you have performed a final-compute for timecards, you cannot change the computed amounts on those timecards.

Suppose that you advance Rob $500, and set up a calculation to recover the advance at a rate of $50 per paycheck. One week, Rob works far more than usual and suggests that you deduct $200 from this paycheck. If you were to change the calculation rate for the payroll advance in Rob’s employee record, you would then have to change the rate back after the final-compute. Because the $200 deduction is only for one paycheck, adjust the computed amount on the timecard. On the Calculations tab, locate the Payroll Advance calculation, enter $200 in the Amount cell, and type Yes in the Override cell.

You can also use the Calculations tab to adjust the deduction or benefit balances for a specific employee. When you enter a hand-computed check, you can subtract from the balance of one payroll calculation and add it to another.

**About non-union shops and prevailing-wage jobs**

When an open-shop contractor receives a contract for a Davis-Bacon job, the contractor is required to provide his employees the wages and benefits package as stipulated by the governing agency, usually union scale for the area.
For example, a union local might provide a health care benefit that the open-shop contractor does not. For work performed on the prevailing-wage job, the contractor is required to pay his employees the money that would otherwise be paid for a health care benefit if it were a union shop.

The governing agency determines the prevailing wage and benefits package requirements for each job. To manage the requirements for each prevailing-wage job, use paygroups to set up a separate wage group for each category of worker. When entering a timecard, you specify the paygroup on each timecard line, and Sage 100 Contractor uses the wages and benefits package from the paygroup in place of the wages and benefits package in the employee record.

When your company offers a benefit that is also in the prevailing benefits package, your company receives a credit, determined by the job’s governing agency. In some cases, you might be required to pay the employee the difference between the regular benefit and the prevailing benefit. Set up the payroll calculation for the benefit as a cash add-on, and include the offsetting credit for the new calculation in the employee’s record. When you compute payroll, Sage 100 Contractor uses the offset credit to determine the difference between the benefit provided and the prevailing benefit. The employee is paid the difference as cash.

For example, you pay a health benefit of $180 per month on behalf of Joe, and $120 per month on behalf of Bill using Calculation A: Company Health (paid by the employer). The requirements for a prevailing-wage job include a $2 per hour health benefit. To calculate the required health benefit correctly, you set up a new calculation, called Calculation B: Davis/Bacon Health (cash add-on) and add it to the employee records. The new calculation has a calculation type 2-Add to Gross, and a rate of $2 per hour.

The governing agency, after reviewing the health benefit you supply, determines you get a $1 per hour credit for Joe’s health care benefit and a $0.67 per hour credit for Bill’s health care benefit.

After setting up the paygroups and benefits packages, which includes Calculation B, enter the health care credit in the Calculations tab of the employee records. In Joe’s employee record, enter the $1 credit in the Offset cell for Calculation B. Then in Bill’s employee record, enter the $0.67 credit in the Offset cell for Calculation B.

Joe and Bill work 40 hours on the prevailing-wage job. When entering their timecards, you indicate the appropriate paygroups. When you compute payroll, Sage 100 Contractor determines the amount to add to each check, which is the difference between the health benefit you provide and the prevailing health care benefit [[benefit rate – offsetting credit] * hours worked].

Joe receives an additional $40 [($2 – $1) * 40] on his check; and Bill receives an additional $53.20 [($2 – $0.67) * 40] on his check. For the certified payroll report, Sage 100 Contractor computes the health benefit at $2 per hour for both Joe and Bill.

For companies that perform considerable amounts of prevailing-wage work, you can create a table of paygroups to use with each job. When you enter the job number on a timecard, Sage 100 Contractor determines which paygroup to use based on the employee’s position.

Payroll Records

About 5-2-2 Payroll Records

In the 5-2-2 Payroll Records window, you can enter timecards for employees as well as hand-computed records, advances, bonuses, and third-party payments. Payroll records for advances, bonuses, and salaried employees do not require timecard information. For non-salaried employees, you enter timecards with a breakdown of the hours spent working each job or repairing equipment.

When you enter a payroll record, Sage 100 Contractor inserts default information from the job and employee records. You can accept or change any of the default information. After timecard entry, you can compute the timecards.
You might find this additional functionality beneficial too. The related scope of work recorded in 6-11-6 Daily Field Report line notes from the employees grid can be imported into 5-2-2 Payroll Records using the Options > Data Import > Import Daily Field Reports. This provides a way for that information to become part of your payroll and job costing records.

Also, you can choose whether to use an employee's work locale or residence locale as the default in timecards when the timecard line does not specify a job or when the specified job does not include a locale. When you click Options > Default Option for Locale Column, a separate window opens where you specify your choice. Your selection determines the default for the Locale Column in all time-entry windows, including the 5-5-1 Daily Payroll Entry window and the Sage Construction Anywhere plug-in, as well in as the 5-2-2 Payroll Records window.

A trial-compute allows you to review the amounts computed for each payroll calculation and make any necessary adjustments. On the Calculations tab, you can review the accuracy of computed amounts or override the calculation results by supplying different amounts. After you final-compute timecards, the computed amounts cannot be changed; Sage 100 Contractor posts the job and equipment costs, and updates the wage and payroll calculation balances in the employee records.

**About payroll record errors**

Payroll record errors result from inaccurate timecard entry, employee record setup, or payroll calculation setup. Before attempting to correct the error, determine its cause. In most cases correct the setup problem first, and then correct the payroll record error.

**IMPORTANT:** If the wrong payroll posting accounts were set up in the 5-3-3 Employee Positions window, void the erroneous payroll records. Voiding the payroll records first ensures that reversing transactions are posted to the same accounts. Then enter the correct posting accounts in the 5-3-3 Employee Positions window. Finally, enter the correct payroll records.

**There are two status settings:**

- **1-Open:** Sage 100 Contractor has not created cost records, printed paychecks, or posted payroll to the general ledger. You can edit most information in the record. If the record is a duplicate, you can delete it. If you have assigned the wrong payroll type, void the record.

- **2-Computed:** If you have not printed a check, void the original record. Then enter a new record with the correct data. You can trial-compute the record to make sure all the data is correct before the final-compute.

If you printed a check but did not issue it to the employee, void the original record. Then enter a new record with the correct data. You can trial-compute the record to make sure all the data is correct before the final-compute. To maintain an accurate audit trail, cancel the check number of the erroneous check.

If you issued the check to the employee, void the original record. Then enter a payroll advance for the net amount of the check. To maintain an accurate audit trail, enter the original check number in the Check Number box. Then enter a new record with the correct data. You can trial-compute the record to make sure all the data is correct before the final-compute.

Sage 100 Contractor recovers the payroll advance from the subsequent paychecks. If you overpaid the employee due to error, and the subsequent check results in a net $0 amount, print the check to plain paper and provide a copy to the employee. If you underpaid the employee due to error, print the new paycheck and give it to the employee. Always provide the employee with a copy of the correct payroll information.

**Entering Payroll**

**About entering payroll records**

For each non-salaried employee, you enter a separate record with a breakdown of his or her time on the Timecard tab. On each timecard line you can enter the hours worked on a specific job, or the hours worked performing repairs and maintenance on a piece of equipment. Each timecard line also requires a pay type, which indicates the type of wages to
compute the wages for the line. When you final-compute the payroll, Sage 100 Contractor creates the job and equipment costs based on the timecard lines.

There are two ways to enter payroll records for salaried employees. Most salary records only require the salary amount and do not need a breakdown of the employee’s hours. If you need to create job or equipment costs for a salaried employee’s time, you then need to classify his or her time on the **Timecard** tab.

Payroll records for hand-computed checks, advances, and third-party payments do not use timecard information. A hand-computed check lets you adjust the payroll calculation balances stored in an employee’s record. You can enter a bonus as a separate record from a timecard, or you can include in on the timecard.

**About payroll advances**

When you give a payroll advance to an employee, Sage 100 Contractor debits the **Payroll Advance** ledger account and records the amount in the **Advances Due** text box in the employee’s record. Payroll advances are considered a type of short-term loan and are not subject to payroll deductions.

You can deduct the advance from the employee’s next paycheck, or a flat amount each pay period until the advance has been recovered. As you recover the advance, Sage 100 Contractor updates the **Advances Due** text box to reflect the current amount due. When the amount in the **Advances Due** text box reaches $0, Sage 100 Contractor stops making a deduction from the employee’s pay.

**About employee loans**

Some companies provide long term loans or interest-bearing loans to employees. Instead of writing a payroll check for the advance, write a general ledger check to the employee. Post the amount to the loans receivable account. If you don’t have a subaccount for loans receivable, you can set one up.

If you give several employees long term loans, consider using subsidiary accounts to track each loan separately. Because loans are posted to different ledger accounts than payroll advances, set up a separate payroll calculation to recover the loan.

**Job costing salaried employees**

If a salaried employee spends time working on a job or repairing equipment, you can create the appropriate job or equipment cost records. On the **Timecard** tab, enter the hours the employee has spent working jobs or repairing equipment during the pay period. Also, include the hours spent in an overhead or administrative capacity.

When you compute payroll, Sage 100 Contractor calculates the gross hourly wage (employee salary / total hours = gross hourly wage). If a salaried employee works more than 40 hours in a week, the calculated gross hourly wage is lower. Therefore, to compute a gross hourly wage based on a 40-hour week, enter a timecard line for negative hours and attribute them to a dummy job (created strictly for this purpose). The dummy job allows you to enter all hours worked without affecting the costs attributed to the jobs or equipment.

Suppose Robert, a salaried administrator, worked eight hours as a carpenter on a job. He also worked 32 hours as an administrator. The first timecard line contains the job, cost code, payroll line type, hours, and Workers’ Compensation code. The second timecard line contains the payroll line type, non-job or equipment related hours worked, and the Workers’ Compensation code. When you final-compute the payroll record, Sage 100 Contractor attributes the cost of eight hours labor to the job and 32 hours labor to administration.

**To job cost a salaried employee:**

1. **Open 5-2-2 Payroll Records.**
2. **In the Employee box,** enter the employee number.
3. **In the Period Start box,** enter the date when the payroll period begins.
4. **In the Period End box,** enter the date when the payroll period ends.
5 In the Check Date box, enter the date when the check is to be issued.

6 In the Check# box, type 0000.

When you print the check, Sage 100 Contractor assigns the check number to the record.

7 If you have already issued the check, enter the check number in the Check# text box.

8 In the Payroll Type list, click 1-Regular.

9 In the Quarter box, enter the payroll quarter.

10 In the State text box, enter the tax state.

11 In the Salary box, enter the salary.

12 In the Timecard tab, do the following:
   a In the Date cell, enter the date on which the employee worked.
   b If the employee worked on a job, enter the job number in the Job cell.
   c If the employee repaired equipment, enter the equipment number in the Equipment cell.
   d If the job is in a local payroll tax district, enter the local payroll district number in the Locality cell.
   e If the job requires certified payroll, type Yes in the Certified cell.
   f If the job uses phases, enter the phase number in the Phase cell.
   g If the employee worked on a job or repaired equipment, enter the cost code number in the Cost Code cell.
   h In the Pay Type cell, enter the payroll line type.
   i In the Compensation Code cell, enter the Workers' Compensation code number.
   j If you are using departments, enter the department number in the Department cell.

13 Repeat step 12 for each payroll item.

14 On the File menu, click Save.

**TIPS:**
- To compute payroll records correctly, enter the timecard line containing the negative hours first. This ensures deductions, benefits, or other calculations that use calculation maximums compute properly.
- When a salaried employee is subject to a local payroll tax, enter the local payroll tax district on the Timecard tab.

**Payroll Bonuses**

**About bonus checks**

**IMPORTANT:** Sage 100 Contractor does not support the higher bonus rate of 35% for supplemental wages which exceed one million dollars in a year.

You can enter bonus checks in two ways.

- As a separate paycheck. Sage 100 Contractor computes Federal Income Tax based on the federal bonus tax rate.
- Include it in a regular paycheck. Sage 100 Contractor computes Federal Income Tax and State Income Tax using the standard tax tables.
Hand-computed Checks

About hand-computed checks

**IMPORTANT:** When adjusting any calculation balances, it is important to consider the impact to the employee’s taxable wages. Additional adjustments to the wages may be necessary.

Use hand-computed payroll checks to make small adjustments to the calculation balances stored in an employee record. When you assign pay type **3-Hand Computed** to a payroll record, Sage 100 Contractor limits entry to the **Calculations** tab.

To adjust the balance of an employer cost, enter a negative sum to deduct from the balance, or enter a positive sum to add to the balance. The adjustment does not affect the employee’s net wages.

To adjust employee costs, transfer the sum from one calculation balance to another. Depending on which balance you are adjusting, you can offset the net check amount to **Federal Income Tax**, **State Income Tax**, or **Payroll Advance**.

- Use **Federal Income Tax** to adjust federal taxes such as Social Security or Medicare.
- Use **State Income Tax** to adjust state taxes such as state disability insurance.
- Use **Payroll Advance** to change the amount of the net paycheck.

Suppose that you have over-deducted $10 for Social Security from Dick’s gross wages. On the **Calculations** tab, you enter --$10 in the **Amount** cell for the **Employee Social Security** calculation. Then in the **Amount** cell of **FIT**, enter $10. Sage 100 Contractor deducts the $10 from the **Employee Social Security** balance and adds it to the **FIT** balance. Rather than moving the balance to **FIT**, you could enter the amount in **Payroll Advance**. Sage 100 Contractor would then add $10 to the employee’s next paycheck.

About third-party sick pay

In some states, a third party pays for employees receiving sick pay or disability insurance. In most instances, the employer is responsible for reporting the deductions and wages. If your company is responsible for reporting the sick pay wages, you can enter payroll records using pay type **6-Third Party**.

When you post a payroll record with pay type **6-Third Party**, Sage 100 Contractor:

- Adds the employee costs to the calculation balances stored in the employee’s record.
- Adds the employer costs to the calculation balances stored in the employee’s record.
- Posts the employer costs to the general ledger.

For more information about third-party sick pay, see IRS publication 15A, *The Employer’s Supplemental Tax Guide*.

Employee Record Calculations

About calculations in employee records

When setting up a new employee record, Sage 100 Contractor inserts the package of default payroll calculations, including the calculation rates and maximums, on the **Calculations** tab. Each employee record has its own set of payroll calculation rates, maximums, and totals. You can edit the calculation rates and maximums in one employee record without affecting others. When you compute payroll, Sage 100 Contractor reads the calculation rates and maximums from the **Calculations** tab.

Before editing the individual calculation rates and maximums, familiarize yourself with how payroll calculations are set up. Most calculations that refer to tax tables do not allow editing. Sage 100 Contractor determines the tax table number, but does not display the data in the **Calculations** tab.
You can manage the marital status settings, allowances, and withholding amounts for federal and state tax calculations. For example, Steve works in Kansas and Nebraska. In Kansas, Steve claims married-joint status, but in Nebraska, he claims married-separate status. In the **Marital** column, you can enter the appropriate marital status for the Kansas and Nebraska income tax calculations.

You can also control whether a payroll calculation is active or inactive. When you type No in the **Active** cell for a calculation, Sage 100 Contractor does not include that payroll calculation in the compute for timecards. For example, John was given a $500 payroll advance, and the **Payroll Advances** calculation in John's employee record was set up to recover $100 per paycheck. But John has said that the next few weeks are difficult and that he would like to suspend the repayment for a little while. In John’s employee record, type No in the **Active** cell of the **Payroll Advance** calculation. When you are ready to resume recovering the advance, type **Yes** in the **Active** cell of the **Payroll Advance** calculation.

Contractors who work on prevailing-wage jobs are required to match the difference between prevailing wages and benefits, and actual wages and benefits paid to each employee. For each employee who works the prevailing-wage job, you can enter the credit in the **Offset** column. When you compute payroll, Sage 100 Contractor applies the credit. To manage payroll for prevailing-wage jobs, set up paygroups.

**TIPS:**

- Some states use additional tax tables to collect county taxes with the state taxes. To calculate the correct taxes, enter the tax rate or table number in the **Table#** cell of the calculation.

- You can withhold an additional flat amount for federal taxes or state taxes. To withhold a flat amount for a calculation, enter the amount in the **Add W/H** cell of the calculation.

**Compute Payroll**

**About computing payroll records**

You can perform a trial-compute or a final-compute of the payroll records. During a compute, Sage 100 Contractor calculates the wages, deductions, benefits, and employer costs for each timecard.

After a trial-compute, you can review the individual payroll records, check the accuracy of the payroll calculations, and make any last-minute adjustments. Before the final-compute, you can override a payroll calculation in a specific record and provide the amount you want Sage 100 Contractor to use.

When a final-compute is completed, Sage 100 Contractor changes the status of the records to **2-Computed** and creates the job costs. In the employee records, Sage 100 Contractor updates the quarterly and year-to-date totals for gross wages, Social Security, and Medicare. Sage 100 Contractor also updates the quarterly totals of the payroll calculations.

After you have done the final-compute of the payroll, you can print payroll checks and post the records. If the posting period has changed between the time of the final compute and posting to the general ledger, Sage 100 Contractor updates the posting period of the job cost records.

Job costs are created as part of the final compute of the payroll. At that time, however, neither the check number nor the accounting period of the check transaction is available. The job cost records are updated later with the check number when the check is printed. Then the accounting period and the ledger transaction link are updated when the check is posted to the general ledger.

**Direct Deposit**

**About direct deposit**

Direct deposit allows your employees to have their paychecks deposited directly into their bank account. Banks require electronic delivery of payroll information by companies wanting to provide employees with direct deposit. Sage 100
Contractor supports the creation of a file in automatic clearing house (ACH) format. You can then send this file to your bank. Your bank will extract records from the file and create files that are routed through ACH providers to the various employee banks.

**NOTES:**
- Contact your bank to determine any delivery requirements, including encryption, additional file format requirements, or other requirements. After establishing and agreeing on a method of delivery with your bank, you can create the file and deliver it in the agreed-upon method.
- Whenever any changes are made to your direct deposit file format by changing any of the formatting options, you should contact your bank and request a retest to be sure your bank is ready for the changes.
- After creating the Direct Deposit File, Sage 100 Contractor prompts you to print a Direct Deposit File Report that shows your Direct Deposit File information. If you do not print that report at that time and need to reprint the report, use Options > Reprint Direct Deposit Report.

Two documents can be created during a direct deposit run: the Direct Deposit File and the Direct Deposit File Report.

- **Direct Deposit File**—The Direct Deposit file is created in Automated Clearing House (ACH) format and is saved as a .txt file used by the bank. By default it is saved in the \MB7\companyname\Direct Deposit folder (where x: is your network drive). The next time you save your direct deposit file, Sage 100 Contractor defaults to the directory where the file was last saved. The exact location of your direct file appears on the Direct Deposit File Report.
- **Direct Deposit File Report**—The generated report is saved in the \MB7\companyname\Reports folder as an .rtf or .pdf.

Printed checks have a unique check number and an electronic deposit number that correspond to the payroll record number. Sage 100 Contractor users with checks pre-printed with check numbers should process check runs in sequence.

Printing direct deposit payroll checks creates and prints a non-negotiable check and supplies the employee with a record of the payroll. You have three options for printing direct deposit checks in 5-2-4 Payroll Checks.

Direct deposit is limited to employee payroll only. Sage 100 Contractor does not support electronic payment or electronic transfer of funds for such things as:
- Federal, state, or local taxes
- Child care support payments
- Wage garnishment

**About setting up direct deposit**

Before you begin to set up and process direct deposit, consider the following:

- Obtain the account and routing numbers from each employee for the bank accounts into which they want their paycheck deposited.
- Determine if your bank requires a pre-notification.
- Contact your bank to determine any delivery requirements, including encryption, additional file format requirements, or other requirements specific to an individual bank.

Setting up direct deposit involves entering information in two windows, 7-2 Company Information and 5-2-1 Employees.

Under Payroll Direct Deposit Setup in the 7-2 Company Information window, you set up the parameters that control the movement of information between your company and your bank. This is where you enter your company bank account number, routing number, and account type, which is either checking or savings. There are also three check boxes located under Account Type that specify the format of the file type sent to the bank.
CAUTION: Whenever any changes are made to your direct deposit file format by changing any of the formatting options, you should contact your bank and request a retest to be sure your bank is ready for the changes.

You can set up direct deposit of paychecks using the Direct Deposit tab in 5-2-1 Employees. The employee must provide you with the following information for each account to which he or she wants funds deposited: account type, routing number, account number, rate type, and rate. You can deposit funds in up to four different bank accounts for an employee.

IMPORTANT:

- Sage 100 Contractor does not support an employee receiving a combination of direct deposit and a physical paycheck.
- Account status is set by the payroll administrator. It is not provided by the employee.

Posting Payroll to the General Ledger

About posting payroll

You can enter timecards, compute payroll, and even print payroll checks without posting the payroll records. When you are ready, you can post individual payroll records or all payroll records for a specified pay period.

When you post payroll, Sage 100 Contractor:

- Debits gross payroll:
  - Job costs post to the direct expense account. If you have selected the Post Payroll to WIP check box in the job record, payroll posts to a WIP account. If the WIP account uses subsidiary accounts, payroll posts to a subsidiary account that uses the job number as the account number.
  - Equipment repair or maintenance costs post to the equipment/shop account.
  - All remaining costs post to the overhead or administrative account, which is determined by the employee position.
- Credits payroll expenses to the ledger accounts as indicated in the payroll calculation.
- Credits net payroll to the checking account entered in the Payroll Posting window.
- Credits the ledger accounts as indicated in the payroll calculation.

If you do not specify which records or pay periods to post, Sage 100 Contractor posts all payroll records assigned 2-Computed or 4-Reverse. After posting is complete, Sage 100 Contractor changes records with status 2-Computed to status 3-Posted, and records with status 4-Reverse to status 5-Void.

Payroll Calculations

About payroll calculations

Payroll calculations act as the rules for computing deductions, benefits, and employer costs. You can manually set up payroll calculations, or you can create the set of standard calculations supplied by Sage 100 Contractor.

CAUTION: Setting up payroll calculations can be complex. If you need assistance, consult your business partner.

After you have set up the calculations, you can add them to the employee records. Each employee record maintains its own list of calculation rates, calculation maximums, and quarterly totals for the payroll calculations. On the Calculations tab in the 5-2-1 Employees window, you can edit the calculation rates and maximums for one employee record without affecting the others.
When you compute payroll, Sage 100 Contractor reads the calculation rates and maximums from the employee record, and uses those rates with the payroll calculations. Depending on the type of calculation you want to set up, Sage 100 Contractor: (1) makes certain calculation selections for you that you cannot change; and (2) makes certain suggestions about what you may change:

- **Federal and state taxes (Social Security, Medicare and FUTA):** Sage 100 Contractor contains the tax tables necessary for computing federal and state income taxes. For each state that your employees work in, set up a payroll calculation to compute the state income tax. While some states do not levy an income tax, the calculation is still necessary to maintain accurate wage information.

  To compute taxes correctly, some states require additional setup in the employee records. For details on setting up tax calculations for specific states and municipalities, see Appendix D—Tax Setup Information

  **NOTE:** Do not set up more than one calculation for Tax Type 3 (Employer Social Security) or Tax Type 4 (Employer Medicare). Doing so will cause audit errors.

- **Local payroll tax districts:** Many counties and municipalities levy income taxes. You can specify the correct local payroll-tax districts and then assign the locales to the appropriate job and employees.

- **Calculated amounts that add to or deduct from pay for specific reasons:** In some cases, it is necessary to create different payroll calculations for the same purpose. For example you may need different methods to calculate wage garnishments, retirement plans or union deductions.

**Building Payroll Calculations**

- Creating standard payroll calculations: To get started, we recommend that you take advantage of the standard calculations that Sage 100 Contractor can automatically create for you. If you choose to create the set of standard calculations, you will need to review and possibly adjust and/or manually add additional calculations later.

- Setting up payroll calculations: You can set up payroll calculations manually by defining each type of calculation that you will need. There are many parameters for each calculation that must be carefully reviewed before setup.

**About pre-built standard payroll calculations**

Sage 100 Contractor comes with a set of standard payroll calculations. We recommend that you use these standard payroll calculations as a starting point.

You can only use the pre-built standard calculations for a new company that does not already have the calculations set up. It is important to review and modify the standard calculations after you set them up to ensure they meet your regional requirements.

Sage 100 Contractor creates the following calculations:

- Social Security—Employee
- Medicare—Employee
- Federal Income Tax—Employee
- Social Security—Employer
- Medicare—Employer
- Federal Unemployment—Employer (FUTA)
- Per Diem
- Advances
- Workers’ Compensation
- Liability Insurance
- State Income Tax—Employee
- State Disability Insurance—Employee
- State Unemployment Insurance—Employee

Creating standard payroll calculations

**IMPORTANT:**
- If you choose to create the standard calculations, you must do this before setting up any calculations manually.
- Even though some states do not have state income tax, the state income tax calculation needs to be set up in the 5-3-1 Payroll Calculations window so that the Workers’ Compensation report prints correctly. Additionally, the state income tax calculation needs to be set up so that W-2 forms calculate correctly.

To create standard payroll calculations

**NOTE:** You can only use the pre-built standard calculations for a new company that does not already have the calculations set up. It is important to review and modify the standard calculations after you set them up to ensure they meet your regional requirements.

1. Open 5-3-1 Payroll Calculations.
2. On the menu bar, click **Options**, then click **Create Standard Calculations**.
3. Carefully review each standard payroll calculation.
4. Some of the account numbers may need to be modified. If you used the Sage 100 Contractor standard 4-digit or 5-digit chart of accounts and have not made modifications, the account numbers will be correct. If you have used or created another chart of accounts or modified one of the standard ones, you will need to carefully review each of the account numbers.
5. For each state tax calculation, you must enter the state abbreviation in the **State** text box.
6. For the State Disability Insurance and the State Unemployment Insurance calculations, you must enter the **Default Rate**, **Default Maximum**, and **Max Type**.
7. Set up any additional calculations.

Setting up payroll calculations

The taxes that are subject to calculation vary by state or region. Verify the selections with your accountant, or if it is a benefit, the benefit plan administrator.

**CAUTION:** Verify that all your calculations are correct before computing your payroll by running a trial-compute. If you are unsure about the results, contact Customer Support or your business partner for assistance.

To set up payroll calculations

1. Open 5-3-1 Payroll Calculations.
2. In the data control box, enter the number you want to assign the new calculation.
3. In the **Description** box, enter a brief statement about the calculation.
4. In the **Tax Type** list, click the tax type.
5. In the **Calculation Type** list, click the calculation type.
6 In the Calculation Method list, click the manner in which the calculation is computed.

**IMPORTANT:** When you use calculation method 17-Tables for federal or state income taxes, Sage 100 Contractor sets the rate. The rate does not appear in the payroll calculation or the employee record.

7 When available, do the following:
   a In the Default Rate box, enter the standard calculation rate.
   b In the Default Max box, enter the calculation maximum.
   c In the Max Type list, click the type of maximum for the calculation.

8 In the Job Expense, Shop Expense, Overhead Expense, and Admin Expense boxes, enter the ledger account number that you want to debit.

9 In the Credit Account box, enter the ledger account number that you want to credit.

10 In the Credit Subaccount box, enter the ledger subaccount number that you want to credit.
   a (Optional) If you want to use the employee number as the subsidiary account number, click Use employee# as subaccount.

**IMPORTANT:** The Credit Account and Credit Subaccount are typically liability accounts. You must specify a Credit Account, but a Credit Subaccount is only necessary dependent upon your general ledger setup.

11 Under Subject to, verify the deductions to which the calculation is subject.

12 Under Tax Area:
   a If the calculation is for a specific state, enter the state abbreviation in the Tax State box.
   b If the calculation is for a specific local payroll tax district, click the district number in the Tax Locale list.

13 Under Reporting:
   a To include the calculation on a union report, select the union from the Union list.
   b To include the payroll calculation on certified payroll reports, select the type of benefit in the Benefit list.

14 To report the calculation total in box 11, 12, 13, or 14 of the W-2, enter the box number in the W-2 Box field.

15 To include a special code on the W-2, enter the code in the W-2 Code box.

16 Select the following payroll calculation check boxes if applicable:
   a Use in Paygroup Benefits
   b Display on Check
   c Disposable Earnings
   d Default to New Employees

17 On the File menu, click Save.

**About calculations in employee records**

When setting up a new employee record, Sage 100 Contractor inserts the package of default payroll calculations, including the calculation rates and maximums, on the Calculations tab. Each employee record has its own set of payroll calculation rates, maximums, and totals. You can edit the calculation rates and maximums in one employee record without affecting others. When you compute payroll, Sage 100 Contractor reads the calculation rates and maximums from the Calculations tab.
Before editing the individual calculation rates and maximums, familiarize yourself with how payroll calculations are set up. Most calculations that refer to tax tables do not allow editing. Sage 100 Contractor determines the tax table number, but does not display the data in the Calculations tab.

You can manage the marital status settings, allowances, and withholding amounts for federal and state tax calculations. For example, Steve works in Kansas and Nebraska. In Kansas, Steve claims married-joint status, but in Nebraska, he claims married-separate status. In the Marital column, you can enter the appropriate marital status for the Kansas and Nebraska income tax calculations.

You can also control whether a payroll calculation is active or inactive. When you type No in the Active cell for a calculation, Sage 100 Contractor does not include that payroll calculation in the compute for timecards. For example, John was given a $500 payroll advance, and the Payroll Advances calculation in John’s employee record was set up to recover $100 per paycheck. But John has said that the next few weeks are difficult and that he would like to suspend the repayment for a little while. In John’s employee record, type No in the Active cell of the Payroll Advance calculation. When you are ready to resume recovering the advance, type Yes in the Active cell of the Payroll Advance calculation.

Contractors who work on prevailing-wage jobs are required to match the difference between prevailing wages and benefits, and actual wages and benefits paid to each employee. For each employee who works the prevailing-wage job, you can enter the credit in the Offset column. When you compute payroll, Sage 100 Contractor applies the credit. To manage payroll for prevailing-wage jobs, set up paygroups.

NOTE:

- Some states use additional tax tables to collect county taxes with the state taxes. To calculate the correct taxes, enter the tax rate or table number in the Table# cell of the calculation.
- You can withhold an additional flat amount for federal taxes or state taxes. To withhold a flat amount for a calculation, enter the amount in the Add W/H cell of the calculation.

Adding payroll calculations to employee records

When setting up a new employee record on 5-2-1 Employees, Sage 100 Contractor inserts the package of default payroll calculations, calculation rates, and maximums on the Calculations tab. You can insert additional payroll calculations at any time.

To add payroll calculations

1. Open 5-2-1 Employees.
2. Click the Calculations tab.
3. In the Calculation column, in an empty cell, click once, and then click the down arrow button to display the Payroll Calculations Lookup window.
4. Select and insert the calculation(s).

TIP: Alternatively, you can right-click in an empty cell of the Calculation column and select from the menu of Pick Lists. Press the F5 key to open the Payroll Calculations Lookup, or F8 to open the Payroll Calculations Lookup window as a Picklist.

About tax tables for setting up federal and state tax calculations

Even though some states do not have state income tax:

- The state income tax calculation needs to be set up in the 5-3-1 Payroll Calculations window so that the reports based on state wages are accurate and print correctly.
State income tax calculations for employees must be set up in the **5-2-1 Employees** window so that the payroll calculations compute correctly.

Sage 100 Contractor contains the tax tables necessary for computing federal and state income taxes. For each state you work in, create a payroll calculation for state income tax. The calculation is necessary to maintain the correct gross wage totals for each employee, and to ensure accurate state quarterly reports, state tax reports, and W-2 forms.

If you work in a state that does not levy an income tax, you still need to create a payroll calculation. For those states, a tax is not calculated but Sage 100 Contractor stores the state wage for state reports. In addition, some calculations use the state wage to compute additional deductions such as state unemployment or disability. For those types of calculations, it is important to select the **State Income Tax** check box. Otherwise, the payroll calculation may not compute the deduction correctly.

### About local payroll taxes

Many counties and municipalities levy income taxes. In the **Local Payroll Taxes** window, set up the table of local payroll tax districts and their rates. You can then assign the locales to the appropriate job and employee records. If an employee lives in a locale, add the locale to the employee’s record. If a job site is located in a locale, add the locale to the job record.

There are a variety of ways to set up the districts:

- Some districts base the taxes on whether the employee lives inside or outside the locality. The resident rate applies to employees that work and live in the same locality, while the non-resident rate applies to employees who work in the locality but live elsewhere. During the payroll compute, Sage 100 Contractor compares the locale in the job record to the locality in the employee record. If the districts match, Sage 100 Contractor computes taxes at the resident rate. If the district numbers differ, Sage 100 Contractor computes taxes at the non-resident rate.
- In some regions, employees are subject to several taxes, such as city and county income taxes. As Sage 100 Contractor only lets you assign one locality to a job record, employee record, or timecard line, you can combine districts in the **Local Payroll Tax** window to form a new district. You can then assign the combined district as needed.
- When a local payroll tax applies to employees regardless where they work, you can set up the district to work like state income tax.
- When employees work multiple states but there are no local payroll tax districts, use the districts to control how Sage 100 Contractor computes state income tax for each timecard line.

Each locality requires a corresponding payroll calculation. In most circumstances, each payroll calculation uses calculation method **17-Tables**, and refers to the table of localities for the rates.

### About calculation types

The calculation type determines how a payroll calculation affects a timecard. For example, when you assign a payroll calculation **1-Deduct from Employee**, Sage 100 Contractor deducts the result of the calculation from the employee’s wages.

For most payroll calculations, the program determines the calculation type and the taxes that a calculation is subject to based on the tax type.

If you select tax type **0-None**, however, you instead of the program can select the calculation type.

### Calculation type 1-Deduct from Employee

**Payroll Taxes:** For each payroll tax, set up a payroll calculation. If your company performs work in different states, set up a payroll calculation for every state in which you work, regardless of whether the state levies an income tax. In addition, set up a payroll calculation for each local payroll tax district, such as city and county.
At the calendar year-end, verify the tax rates and maximums for each calculation. Sage 100 Contractor provides Federal and State tax updates each year.

Payroll Advance: Create a calculation for payroll advances. Sage 100 Contractor automatically recovers the advance for you.

Tool Purchases: Some companies allow employees to purchase personal tools from vendors using the company account. You can set up a payroll calculation to deduct the employee’s purchases from his or her paycheck.

When you post the vendor’s original invoice for the tool purchase, post it to the Small Tools account in the Overhead Expense range of accounts. To then deduct the tool purchases from an employee’s paycheck, set up the payroll calculation to post a credit to the Small Tools account. Because the amount deducted from an employee’s paycheck varies based on the cost of the tools purchased, select calculation method 18-Variable (manual calculation).

While you can deduct the cost of tools from the employee’s paycheck, it is a better practice for employees to reimburse tool purchases through personal checks, made payable to your company.

Health Insurance: Create a payroll calculation to deduct the employee’s portion of the cost for medical insurance. Usually this is a fixed amount per month.

If you need to deduct the health insurance each pay period, convert the monthly amount to a per-period amount. From the monthly amount, compute the annual amount and divide by the number of pay periods in a year. If your company pays its employees weekly, for example, divide the annual amount by 52. Then enter the per-period amount in each employee’s record on the Calculations tab.

When employees cannot earn paychecks regularly, due to weather or other circumstances, set up the Health Insurance calculation with a maximum type of 6-Dollars/Month. Then on the Calculations tab in the employee records, enter an accelerated rate and a monthly maximum for the payroll calculation.

Garnishments: (Child support, Previous Year Income Taxes, Court Judgments, etc.) Create a payroll calculation for each type of garnishment. If similar garnishments require different methods of calculation, create a separate calculation for each garnishment.

Suppose you need to garnish the wages of two employees for child support, and a third employee’s wages for back taxes. The first employee’s garnishment is for a set dollar amount each pay period and the second employee’s garnishment is for a percentage of the net pay. Set up two separate calculations for child support garnishments, though both can post to the same payable account. Then set up a third calculation for the garnishment of back taxes, which posts to a different payable account.

If you want to post each garnishment to a different ledger account, create the separate ledger accounts in the Current Liabilities range of accounts. Select the Employee Number as Subaccount check box to post the garnishment to a subsidiary ledger account using the employee’s record number as the subsidiary account number.

Some methods of computing garnishments might be too complex for Sage 100 Contractor to automatically calculate, such as a percentage of the net pay with a minimum or maximum amount. In this case, set up a payroll calculation with a variable calculation method.

Pension Plans: Some businesses set up pension plans such as a 401(k), to which employees contribute. In general, 401(k) deductions are not subject to Federal and state income taxes. Check with your state agencies to determine what is taxable.

Many pension plans allow employees to contribute a flat amount or a percent of the employee’s paycheck. You may need to create two payroll calculations and assign the appropriate calculation to each employee based on how he or she wants to contribute.
To create a pension plan deduction, set up the payroll calculation with tax type 19-Elective Deferral and calculation type 1-Deduct from Employee. Because each employee can choose the flat amount or percent of his or her paycheck to contribute, enter the employee’s amount or rate in the Calculations tab of each employee record.

To post the credit, set up a separate ledger account in the Current Liabilities range of accounts. Select the Employee Number as Subaccount check box to post each employee’s contribution to a subsidiary ledger account using the employee’s record number as the subsidiary account number. The subsidiary accounts help you manage the individual employee contributions, and know what amount to pay on behalf of each employee.

**Calculation type 2-Add to Gross**

**Cash benefits for prevailing wage:** Non-union contractors working Davis-Bacon or prevailing-wage jobs must pay employees a cash equivalent to the union wage and benefits. After setting up the paygroups, set up a payroll calculation for each benefit, such as vacation, pension, and health and welfare.

Because the benefit is being paid as cash, set up the calculation using calculation type 2-Add to Gross, and post the credit to the ledger account number of the payroll checking account. Sage 100 Contractor adds the result of the calculation to the employee’s gross wage.

**TIP:** You can include cash benefits in the Certified Payroll report. In the Benefit list, click the type of benefit the calculation represents.

**Calculation type 3-Employer Cost**

**NOTE:** Calculations type 3-Employer Cost can be used can be used to accrue virtually any type of employer cost.

**Payroll Taxes:** For each payroll tax, set up a payroll calculation. If your company performs work in different states, set up a payroll calculation for every state in which you work, regardless whether the state levies an income tax. In addition, set up a payroll calculation for each local payroll tax district (city, county, etc.).

At the calendar year-end, verify the tax rates and maximums for each calculation. Federal and State tax updates are available each year.

**Workers’ Compensation Insurance:** When you set up a payroll calculation for Workers’ Compensation, Sage 100 Contractor uses the rates set up in the Workers’ Compensation window. Select 17-Tables as the calculation method.

**Liability Insurance:** You can set up the liability insurance calculation to use the rates from the Workers’ Compensation window. Select 17-Tables as the calculation method, and credit the account to which you post the insurance payments.

Generally, liability insurance covers field employees and sometimes the owner, but not office employees. For each exempt employee, change the payroll calculation’s rate to 0 on the Calculations tab of the employee record.

Some companies compute the liability insurance as a percent of gross pay. In the Tax Type list, click 0-None. In the Calculation Method list, click 1-Percent Gross Pay. The rate is usually the same as the payroll rate on the insurance policy.

**Health Insurance:** Set up a payroll calculation to deduct the employer’s portion of the cost for medical insurance. The amount is usually a fixed rate per month.

To deduct the health insurance each pay period, convert the monthly amount to a per-period amount. First, convert the monthly amount to an annual amount, then divide by the number of pay periods in a year. If your company pays its employees weekly, for example, divide the annual amount by 52.

**Pension Plans:** Some businesses set up pension plans, such as a 401(k), to which employers contribute. In the Tax Type list, click 0-None. In the Benefit list, click 2-Pension to include the matching amount on Certified Payroll reports.
To create a pension deduction, set up the payroll calculation as follows: tax type 0-None and calculation type 3-Employer Cost. Because each employee can choose to contribute either a flat amount or percent of his or her paycheck, you might have to create two calculations.

To post the credit, you can post to the same account used to post the employees’ deduction for the pension plan, or you can set up a separate ledger account in the Current Liabilities range of accounts. Whether you post the employer portion of the pension plans to subsidiary accounts depends on your particular needs.

Union shops or open shops that perform Davis-Bacon or prevailing-wage work should not use subsidiary accounts to track the individual matching amounts. To make the payment, each subsidiary account would have to be referenced on the check. Instead, you can use the certified payroll reports to track the amounts paid. If you are using paygroups, you need to enter the pension rates in the Paygroup Benefits window.

Select the Employee Number as Subaccount check box to post each employee’s contribution to a subsidiary ledger account using the employee’s record number as the subsidiary account number. The subsidiary accounts help you manage the individual employee contributions, and know what amount to pay on behalf of each employee.

**Tool Use:** You can recover the cost of small tools by setting up a calculation for a flat rate per hour that applies to all working field employees. To determine the hourly rate, look at the amount your company spent purchasing small tools for a time, such as the previous year. Then divide that amount by the number of hours worked by field employees during the same time. For employees that do not work in the field, change the rate to 0 in the Calculations tab in the employee records.

### Calculation type 4-Add/Deduct

**Vehicle use:** Some companies provide a vehicle to an employee as a benefit.

Set up the payroll calculation with calculation type 4-Add/Deduct (taxable). The calculation adds the dollar value to the gross wages, computes the taxes, and then deducts the dollar value from the gross wages. The calculation results in an increase to the taxable wage.

**Union Vacation:** Contractors are responsible for computing the taxes for vacation pay and filing the necessary reports. When dealing with two or more unions, you might need to create a separate payroll calculation to compute the union vacation for each union local.

Set up the payroll calculation with calculation type 4-Add/Deduct (taxable). The calculation adds the dollar value to the gross wages, computes the taxes, and then deducts the dollar value from the gross wages. The calculation results in an increase to the taxable wage.

To include the calculation in the default set of paygroup benefits, select the Use in Paygroup Benefits check box.

### Calculated type 5-Accrued Hours

You can use calculation type 5-Accrued Hours to create a calculation that builds up hours. For example, you could use this calculation to keep track of hours used to determine an employee’s vacation time. A payroll calculation that uses calculation type 5-Accrued Hours does not post to the general ledger or create job costs.

### About payroll calculation defaults

**IMPORTANT:** The Default Rate, Default Max and Max Type boxes in 5-3-1 Payroll Calculations are defaults. When you create standard payroll calculations, these amounts are automatically created for many of the calculations. This information from 5-3-1 Payroll Calculations is not used to compute payroll; however, Max Type is used when the records are computed.
**Default Rate**

When entering the default rate, ask yourself this question: Will a default rate help me when entering new employees?

Some calculations apply to all employees and have fixed rates, such as Social Security and Medicare taxes. Other calculations apply to all employees but may have varying rates, such as health insurance premiums and other benefits. Some other additional calculations apply to only a subset of employees and may have fixed rates too.

When entering default rates, it is very important to remember that this field is only a default. The actual rate used when payroll records are computed comes from either the individual employee record or the paygroup.

If there is a common rate, you may want to enter it so that it will then default to the employee record when entering a new employee. You may feel, however, that it is “safer” to require yourself to directly enter the rate for each employee to ensure having the correct rate every time rather than having an incorrect default accepted.

Moreover, some default calculations apply to only a subset of employees and may have varying rates, such as child support and other wage garnishments. There is no common rate for this group because this calculation doesn't apply to most employees, and therefore the common rate is actually zero.

**Default Max**

When considering the default maximum, use the same criteria as you use for the default rate. Ask yourself this question: Will a maximum rate help me when entering new employees?

**Max Type**

**Wage-based maximum types** mean that the calculation stops computing when the employee’s wages reach the maximum level.

This kind of maximum is usually used in connection with tax calculations because they are usually published in this style by the government agency. For example, the IRS states something like this: Social Security tax is 6.2% on all wages up to $87,000.

- **Per Quarter** and **Per Year** types are based on wages that are subject to Medicare.
- **Per Check** and **Per Month** types are based on unadjusted gross wages.

**Dollar-based maximum types** mean that the calculation stops computing when the amount of the calculation reaches the maximum level.

This kind of maximum is useful when a dollar amount needs to be calculated without regard to the employee’s earnings. For example, you may want to calculate an employer-matching 401(k) at 50% of what the employee contributes, but the matching is not to exceed $1,000 per year.

- **Per Year** types are based on all computed payrolls to date.
- **Per Quarter** types are based on all computed payrolls assigned to the same quarter number that is on the current payroll record.
- **Per Month** types are based on all computed payrolls that have a check date in the same month as the current payroll record.

**IMPORTANT:** It is important to enter the correct check date on the payroll records prior to computing so that Sage 100 Contractor is aware of the month to which the current payroll is assigned.

- **Per Check** types are based solely on the current payroll record.
About pre-built standard payroll calculations

Sage 100 Contractor comes with a set of standard payroll calculations. We recommend that you use these standard payroll calculations as a starting point.

You can only use the pre-built standard calculations for a new company that does not already have the calculations set up. It is important to review and modify the standard calculations after you set them up to ensure they meet your regional requirements.

Sage 100 Contractor will create the following calculations:

- Social Security—Employee
- Medicare—Employee
- Federal Income Tax—Employee
- Social Security—Employer
- Medicare—Employer
- Federal Unemployment—Employer (FUTA)
- Per Diem
- Advances
- Workers’ Compensation
- Liability Insurance
- State Income Tax—Employee
- State Disability Insurance—Employee
- State Unemployment Insurance—Employee

About tax tables for setting up federal and state tax calculations

**IMPORTANT:** Even though some states do not have state income tax:

1. The state income tax calculation needs to be set up in the 5-3-1 Payroll Calculations window so that the reports based on state wages are accurate and print correctly.

2. State income tax calculations for employees must be set up in the 5-2-1 Employees window so that the payroll calculations compute correctly.

Sage 100 Contractor contains the tax tables necessary for computing federal and state income taxes. For each state you work in, create a payroll calculation for state income tax. The calculation is necessary to maintain the correct gross wage totals for each employee, and to ensure accurate state quarterly reports, state tax reports, and W-2 forms.

If you work in a state that does not levy an income tax, you still need to create a payroll calculation. For those states, a tax is not calculated but Sage 100 Contractor stores the state wage for state reports. In addition, some calculations use the state wage to compute additional deductions such as state unemployment or disability. For those types of calculations, it is important to select the State Income Tax check box. Otherwise, the payroll calculation may not compute the deduction correctly.
Calculation Methods, Tax Types, and Calculation Types

The calculation method tells Sage 100 Contractor how to use the calculation. If a calculation uses a per hour calculation method, for example, Sage 100 Contractor multiplies the number of hours worked by the rate assigned to the calculation.

Percent Gross Pay (unadjusted): Computes a percent of the gross wages.

Percent Total Taxable Wages: Computes a percent of the wages subject to Medicare (Taxable wages = gross pay + taxable add-ons – non-taxable deductions). You can use this calculation method for employer calculations that are not subject to taxes, and employee deductions that are subject to all taxes and do not use calculation types 2-Add to Gross or 4-Add/Deduct (taxable).

Do not use calculation method 2-Percent Total Taxable Wages for a deduction that is not subject to all taxes, such as a 401(k).

Percent Gross + Paygroup Benefits: Computes a percent of the wages subject to Medicare (Taxable wages = gross pay + taxable add-ons – non-taxable deductions). You can only use this calculation for paygroup benefit packages because Sage 100 Contractor only looks at the taxable add-ons and non-taxable deductions in the paygroup.

Calculation method 3-Percentage Gross + Paygroup Benefits requires the calculation to have a calculation number larger than the calculation that adds the benefit to the gross wage. Sage 100 Contractor executes each payroll calculation in the order established by the calculation numbers.

Percent Regular Pay (regular hours only): Computes a percent of the regular pay based on regular hours only, and does not include any pay from hours marked as overtime or premium. For example, if an employee works an eight-hour day plus two hours of overtime, Sage 100 Contractor computes the percent based on eight hours of regular pay.

Percent Regular Pay (all hours): Computes a percent of the regular pay based on all hours worked, including overtime and premium hours. For example, if an employee works an eight-hour day plus two hours of overtime, Sage 100 Contractor computes the percent based on ten hours of regular pay.

Percent Disposable Income (net): Computes a percent of the net pay after taxes.

If two or more wage attachments apply to the same employee and you use 6-Percent Disposable Income (net) as the means of calculation, you may need to combine the calculations to withhold the correct amount.

Percent Other Calculation: Computes an amount based on the result from another calculation.

Calculation method 7-Percent Other Calculation requires you to select the prior calculation on which you are basing this calculation. In the Based on list, click the calculation you want to use. The based-on calculation on must have a calculation number smaller than the current, payroll calculation number. Sage 100 Contractor executes each payroll calculation in the order established by the calculation numbers.

Per Hour (all hours): Multiplies the rate by the number of hours worked.

Per Hour (regular hours only): Multiplies the rate by the number of regular hours worked. This excludes overtime and premium hours.

Per Day: Computes an amount based on the number of days worked.

Per Pay Period: Computes a flat amount each pay period.

Regular/Overtime/Premium (0*, 1*, 1*): Computes overtime and premium wages for add-ons or benefits using overtime and premium wage rates indicated in the employee record. Sage 100 Contractor calculates overtime wages at the rate, and calculates premium wages at the rate.
**Regular/Overtime/Premium (0*, 1.5*, 2*)**: Computes overtime and premium wages for add-ons or benefits using overtime and premium wage rates indicated in the employee record. Sage 100 Contractor calculates overtime wages at 1.5 times the rate, and calculates premium wages at 2 times the rate.

**Regular/Overtime/Premium (1*, 1.5*, 1.5*)**: Computes regular, overtime, and premium wages using regular, overtime, and premium wage rates indicated in the employee record. Sage 100 Contractor calculates overtime wages at 1.5 times the rate, and calculates premium wages at 1.5 times the rate.

**Regular/Overtime/Premium (1*, 1.5*, 2*)**: Computes regular, overtime, and premium wages using regular, overtime, and premium wage rates indicated in the employee record. Sage 100 Contractor calculates overtime wages at 1.5 times the rate, and calculates premium wages at 2 times the rate.

**Regular/Overtime/Premium (1*, 2*, 2*)**: Computes regular, overtime, and premium wages using regular, overtime, and premium wage rates indicated in the employee record. Sage 100 Contractor calculates overtime wages at 2 times the rate, and calculates premium wages at 2 times the rate.

**Tables**: Computes taxes using rates from a tax table. Sage 100 Contractor contains the necessary federal and state tax tables, but does not display the rates and maximums.

**Variable (manual calculation)**: Allows you to enter a rate in the payroll record before the final-compute.

**About calculation methods**

The calculation method tells Sage 100 Contractor how to use the calculation. If a calculation uses a per hour calculation method, for example, Sage 100 Contractor multiplies the number of hours worked by the rate assigned to the calculation.

- **Percent Gross Pay (unadjusted)**: Computes a percent of the gross wages.
- **Percent Total Taxable Wages**: Computes a percent of the wages subject to Medicare (Taxable wages = gross pay + taxable add-ons – non-taxable deductions). You can use this calculation method for employer calculations that are not subject to taxes, and employee deductions that are subject to all taxes and do not use calculation types 2-Add to Gross or 4-Add/Deduct (taxable). Do not use calculation method 2-Percent Total Taxable Wages for a deduction that is not subject to all taxes, such as a 401(k).
- **Percent Gross + Paygroup Benefits**: Computes a percent of the wages subject to Medicare (Taxable wages = gross pay + taxable add-ons – non-taxable deductions). You can only use this calculation for paygroup benefit packages because Sage 100 Contractor only looks at the taxable add-ons and non-taxable deductions in the paygroup. Calculation method 3-Percentage Gross + Paygroup Benefits requires the calculation to have a calculation number larger than the calculation that adds the benefit to the gross wage. Sage 100 Contractor executes each payroll calculation in the order established by the calculation numbers.
- **Percent Regular Pay (regular hours only)**: Computes a percent of the regular pay based on regular hours only, and does not include any pay from hours marked as overtime or premium. For example, if an employee works an eight-hour day plus two hours of overtime, Sage 100 Contractor computes the percent based on eight hours of regular pay.
- **Percent Regular Pay (all hours)**: Computes a percent of the regular pay based on all hours worked, including overtime and premium hours. For example, if an employee works an eight-hour day plus two hours of overtime, Sage 100 Contractor computes the percent based on ten hours of regular pay.
- **Percent Disposable Income (net)**: Computes a percent of the net pay after taxes. If two or more wage attachments apply to the same employee and you use 6-Percent Disposable Income (net) as the means of calculation, you may need to combine the calculations to withhold the correct amount.
- **Percent Other Calculation**: Computes an amount based on the result from another calculation. Calculation method 7-Percent Other Calculation requires you to select the prior calculation on which you are basing this calculation. In the Based on list, click the calculation you want to use. The based on calculation on must have a
calculation number smaller than the current, payroll calculation number. Sage 100 Contractor executes each payroll
calculation in the order established by the calculation numbers.

- **Per Hour (all hours):** Multiplies the rate by the number of hours worked.
- **Per Hour (regular hours only):** Multiplies the rate by the number of regular hours worked. This excludes overtime
  and premium hours.
- **Per Day:** Computes an amount based on the number of days worked.
- **Per Pay Period:** Computes a flat amount each pay period.
- **Regular/Overtime/Premium (0*, 1*, 1*):** Computes overtime and premium wages for add-ons or benefits using
  overtime and premium wage rates indicated in the employee record. Sage 100 Contractor calculates overtime
  wages at the rate, and calculates premium wages at the rate.
- **Regular/Overtime/Premium (0*, 1.5*, 2*):** Computes overtime and premium wages for add-ons or benefits using
  overtime and premium wage rates indicated in the employee record. Sage 100 Contractor calculates overtime
  wages at 1.5 times the rate, and calculates premium wages at 2 times the rate.
- **Regular/Overtime/Premium (1*, 1.5*, 1.5*):** Computes regular, overtime, and premium wages using regular, 
  overtime, and premium wage rates indicated in the employee record. Sage 100 Contractor calculates overtime
  wages at 1.5 times the rate, and calculates premium wages at 1.5 times the rate.
- **Regular/Overtime/Premium (1*, 1.5*, 2*):** Computes regular, overtime, and premium wages using regular, 
  overtime, and premium wage rates indicated in the employee record. Sage 100 Contractor calculates overtime
  wages at 1.5 times the rate, and calculates premium wages at 2 times the rate.
- **Regular/Overtime/Premium (1*, 2*, 2*):** Computes regular, overtime, and premium wages using regular, 
  overtime, and premium wage rates indicated in the employee record. Sage 100 Contractor calculates overtime
  wages at 2 times the rate, and calculates premium wages at 2 times the rate.
- **Tables:** Computes taxes using rates from a tax table. Sage 100 Contractor contains the necessary federal and state 
  tax tables, but does not display the rates and maximums.
- **Variable (manual calculation):** Allows you to enter a rate in the payroll record before the final-compute.

**Calculation type 1-Deduct from Employee**

**Payroll Taxes:** For each payroll tax, set up a payroll calculation. If your company performs work in different states, 
set up a payroll calculation for every state in which you work, regardless of whether the state levies an income tax. In addition, set 
up a payroll calculation for each local payroll tax district, such as city and county.

At the calendar year-end, verify the tax rates and maximums for each calculation. Sage 100 Contractor provides Federal 
and State tax updates each year.

**Payroll Advance:** Create a calculation for payroll advances. Sage 100 Contractor automatically recovers the advance for 
you.

**Tool Purchases:** Some companies allow employees to purchase personal tools from vendors using the company account. 
You can set up a payroll calculation to deduct the employee’s purchases from his or her paycheck.

When you post the vendor’s original invoice for the tool purchase, post it to the **Small Tools** account in the **Overhead 
Expense** range of accounts. To then deduct the tool purchases from an employee’s paycheck, set up the payroll 
calculation to post a credit to the **Small Tools** account. Because the amount deducted from an employee’s paycheck 
varies based on the cost of the tools purchased, select calculation method **18-Variable (manual calculation).**

While you can deduct the cost of tools from the employee’s paycheck, it is a better practice for employees to reimburse tool 
purchases through personal checks, made payable to your company.
**Health Insurance:** Create a payroll calculation to deduct the employee’s portion of the cost for medical insurance. Usually this is a fixed amount per month.

If you need to deduct the health insurance each pay period, convert the monthly amount to a per-period amount. From the monthly amount, compute the annual amount and divide by the number of pay periods in a year. If your company pays its employees weekly, for example, divide the annual amount by 52. Then enter the per-period amount in each employee’s record on the Calculations tab.

When employees cannot earn paychecks regularly, due to weather or other circumstances, set up the Health Insurance calculation with a maximum type of 6-Dollars/Month. Then on the Calculations tab in the employee records, enter an accelerated rate and a monthly maximum for the payroll calculation.

**Garnishments:** (Child support, Previous Year Income Taxes, Court Judgments, etc.) Create a payroll calculation for each type of garnishment. If similar garnishments require different methods of calculation, create a separate calculation for each garnishment.

Suppose you need to garnish the wages of two employees for child support, and a third employee’s wages for back taxes. The first employee’s garnishment is for a set dollar amount each pay period and the second employee’s garnishment is for a percentage of the net pay. Set up two separate calculations for child support garnishments, though both can post to the same payable account. Then set up a third calculation for the garnishment of back taxes, which posts to a different payable account.

If you want to post each garnishment to a different ledger account, create the separate ledger accounts in the Current Liabilities range of accounts. Select the Employee Number as Subaccount check box to post the garnishment to a subsidiary ledger account using the employee’s record number as the subsidiary account number.

Some methods of computing garnishments might be too complex for Sage 100 Contractor to automatically calculate, such as a percentage of the net pay with a minimum or maximum amount. In this case, set up a payroll calculation with a variable calculation method.

**Pension Plans:** Some businesses set up pension plans such as a 401(k), to which employees contribute. In general, 401(k) deductions are not subject to Federal and state income taxes. Check with your state agencies to determine what is taxable.

Many pension plans allow employees to contribute a flat amount or a percent of the employee’s paycheck. You may need to create two payroll calculations and assign the appropriate calculation to each employee based on how he or she wants to contribute.

To create a pension plan deduction, set up the payroll calculation with tax type 19-Elective Deferral and calculation type 1-Deduct from Employee. Because each employee can choose the flat amount or percent of his or her paycheck to contribute, enter the employee’s amount or rate in the Calculations tab of each employee record.

To post the credit, set up a separate ledger account in the Current Liabilities range of accounts. Select the Employee Number as Subaccount check box to post each employee’s contribution to a subsidiary ledger account using the employee’s record number as the subsidiary account number. The subsidiary accounts help you manage the individual employee contributions, and know what amount to pay on behalf of each employee.

**Calculation type 2-Add to Gross**

**Cash benefits for prevailing wage:** Non-union contractors working Davis-Bacon or prevailing-wage jobs must pay employees a cash equivalent to the union wage and benefits. After setting up the paygroups, set up a payroll calculation for each benefit, such as vacation, pension, and health and welfare.

Because the benefit is being paid as cash, set up the calculation using calculation type 2-Add to Gross, and post the credit to the ledger account number of the payroll checking account. Sage 100 Contractor adds the result of the calculation to the employee’s gross wage.
**Calculation type 3-Employer Cost**

**TIP:** You can include cash benefits in the *Certified Payroll* report. In the *Benefit* list, click the type of benefit the calculation represents.

**Payroll Taxes:** For each payroll tax, set up a payroll calculation. If your company performs work in different states, set up a payroll calculation for every state in which you work, regardless of whether the state levies an income tax. In addition, set up a payroll calculation for each local payroll tax district, such as city and county.

At the calendar year-end, verify the tax rates and maximums for each calculation. Sage 100 Contractor provides Federal and State tax updates each year.

**Workers’ Compensation Insurance:** When you set up a payroll calculation for Workers’ Compensation, Sage 100 Contractor uses the rates set up in the *Workers’ Compensation* window. Select **17-Tables** as the calculation method.

**Liability Insurance:** You can set up the liability insurance calculation to use the rates from the Workers’ Compensation window. Select **17-Tables** as the calculation method, and credit the account to which you post the insurance payments.

Generally, liability insurance covers field employees and sometimes the owner, but not office employees. For each exempt employee, change the payroll calculation’s rate to 0 on the *Calculations* tab of the employee record.

Some companies compute the liability insurance as a percent of gross pay. In the *Tax Type* list, click **0-None**. In the *Calculation Method* list, click **1-Percent Gross Pay**. The rate is usually the same as the payroll rate on the insurance policy.

**Health Insurance:** Set up a payroll calculation to deduct the employer’s portion of the cost for medical insurance. The amount is usually a fixed rate per month.

To deduct the health insurance each pay period, convert the monthly amount to a per-period amount. First, convert the monthly amount to an annual amount, then divide by the number of pay periods in a year. If your company pays its employees weekly, for example, divide the annual amount by 52.

**Pension Plans:** Some businesses set up pension plans, such as a 401(k), to which employers contribute. In the *Tax Type* list, click **0-None**. In the *Benefit* list, click **2-Pension** to include the matching amount on Certified Payroll reports.

To create a pension deduction, set up the payroll calculation as follows: tax type **0-None** and calculation type **3-Employer Cost**. Because each employee can choose to contribute either a flat amount or percent of his or her paycheck, you might have to create two calculations.

To post the credit, you can post to the same account used to post the employees’ deduction for the pension plan, or you can set up a separate ledger account in the *Current Liabilities* range of accounts. Whether you post the employer portion of the pension plans to subsidiary accounts depends on your particular needs.

Union shops or open shops that perform Davis-Bacon or prevailing-wage work should not use subsidiary accounts to track the individual matching amounts. To make the payment, each subsidiary account would have to be referenced on the check. Instead, you can use the certified payroll reports to track the amounts paid. If you are using paygroups, you need to enter the pension rates in the *Paygroup Benefits* window.

Select the **Employee Number as Subaccount** check box to post each employee’s contribution to a subsidiary ledger account using the employee’s record number as the subsidiary account number. The subsidiary accounts help you manage the individual employee contributions, and know what amount to pay on behalf of each employee.

**Tool Use:** You can recover the cost of small tools by setting up a calculation for a flat rate per hour that applies to all working field employees. To determine the hourly rate, look at the amount your company spent purchasing small tools for a
time, such as the previous year. Then divide that amount by the number of hours worked by field employees during the same time. For employees that do not work in the field, change the rate to 0 in the Calculations tab in the employee records.

**Calculation type 4-Add/Deduct**

**Vehicle use:** Some companies provide a vehicle to an employee as a benefit.

Set up the payroll calculation with calculation type 4-Add/Deduct (taxable). The calculation adds the dollar value to the gross wages, computes the taxes, and then deducts the dollar value from the gross wages. The calculation results in an increase to the taxable wage.

**Union Vacation:** Contractors are responsible for computing the taxes for vacation pay and filing the necessary reports. When dealing with two or more unions, you might need to create a separate payroll calculation to compute the union vacation for each union local.

Set up the payroll calculation with calculation type 4-Add/Deduct (taxable). The calculation adds the dollar value to the gross wages, computes the taxes, and then deducts the dollar value from the gross wages. The calculation results in an increase to the taxable wage.

To include the calculation in the default set of paygroup benefits, select the **Use in Paygroup Benefits** check box.

**Calculated type 5-Accrued Hours**

You can use calculation type 5-Accrued Hours to create a calculation that builds up hours. For example, you could use this calculation to keep track of hours used to determine an employee’s vacation time. A payroll calculation that uses calculation type 5-Accrued Hours does not post to the general ledger or create job costs.

**Updating employee calculations using 5-3-1 Payroll Calculations Options menu**

The 5-3-1 Payroll Calculations Options menu provides two menu commands with subcommands for updating employees’ payroll calculations under Update Employees. The option for Update Maximum Only does not add the calculation to employees that do not have it already.

**Update Default Rate and Maximum**

**ALL Employees**—Updates employees’ payroll calculation with the Default Rate and Max from the currently displayed calculation (if it does not already exist for the employee).

‘Current’ Employees—Updates “current” employees’ payroll calculation with the Default Rate and Max from the currently displayed calculation (if it does not already exist for the employee).

**Employees with this Calculation**—Updates employees’ payroll calculation with the Default Rate and Max from the currently displayed calculation that already have it.

**Update Maximum only**

**ALL Employees**—Updates employees’ payroll calculation with the Max only from the currently displayed calculation (if it does not already exist for the employee).

‘Current’ Employees—Updates “current” employees’ payroll calculation with the Max only from the currently displayed calculation (if it does not already exist for the employee).

**To update employee calculations for Default Rate and Maximum:**

1. Open 5-3-1 Payroll Calculations.
2. Using the data control, select a payroll calculation.
3 On the menu bar, click **Options > Update Employees > Update Default Rate and Maximum**, and select one of the following:
   a. ALL Employees
   b. ‘Current’ Employees
   c. Employees with this Calculation
4 On the **File** menu, click **Save**.

**To update employee calculations for Maximum only:**

1 Open **5-3-1 Payroll Calculations**.
2 Using the data control, select a payroll calculation.
3 On the menu bar, click **Options > Update Employees > Update Maximum Only**, and select one of the following:
   a. ALL Employees
   b. ‘Current’ Employees
4 On the **File** menu, click **Save**.

**Workers’ Compensation**

**About Workers Compensation**

In the **5-3-2 Workers’ Compensation** window, you can set up the table for workers’ compensation codes, rates, and experience modifiers. Sage 100 Contractor uses the table in conjunction with the workers’ compensation payroll calculation to compute the premium for each code category. How you set up the workers’ compensation codes depends on the requirements for each state.

- Some states use two-tiered codes, where two rates apply to a single category of work.
- Some states require the employer to pay for general liability insurance. Often the liability rates are based on the risk groups, but are not affected by the experience modification.
- Some states use a dollar per hour rate instead of a percent; some use both.
- Some states do not require subcontractors to carry workers’ compensation insurance. Often the general contractors carry the liability insurance burden for the subcontractor.
- The states of Ohio and New York may include a workers’ compensation value in the **Maximum Wage** column.

Use the compensation codes from the insurer’s policy or report whenever possible. Companies with multiple policies may find that the policies share compensation codes. If this occurs, you may need to create a separate numbering system for Sage 100 Contractor to use. Then include each state’s compensation code at the end of the description.

After you have set up the table, you can assign the workers’ compensation codes to the cost codes and employee records. When you enter a timecard, Sage 100 Contractor first looks to the cost code. If Sage 100 Contractor does not find a compensation code, Sage 100 Contractor then looks to the employee record.

It is a good idea to write the expiration dates of your workers’ compensation policies on your company calendar. Also, write a reminder on the calendar one month prior to the policy expiration so you can get quotes for the next policy term. When you renew the policies, adjust the rates and experience modifications in the **5-3-2 Workers’ Compensation Codes** window.

A few states have special requirements for calculating workers’ compensation. For more details, see Appendix D: Tax Setup Information and help topics about these state’s specific workers’ compensation requirements.
Workers’ compensation for subcontractors

Some states do not require subcontractors to carry workers’ compensation insurance. In these states, the subcontractors may use the general contractor’s insurance policy for the duration of the job, and the general contractor deducts the cost of coverage from payments to the subcontractor. Check with your state for compliance requirements, as the laws vary in each state.

You can set up the vendor record of a subcontractor with the employer’s compensation rate. When entering the payable invoice, you can charge the subcontractor for coverage based on the invoiced amount. The charge appears as a credit on the subcontractor’s invoice.

The credit does not appear on the Workers’ Compensation report, which only uses data from payroll records. To track and report these costs, it is a good idea to create a separate Workers’ Compensation ledger account.

Employee Positions

About employee positions

Employee positions determine how you post payroll costs to the general ledger. Create employee positions that represent the type of work performed by employees such as office workers, job supervisors, and laborers. The list does not need to be complex. However, you must create at least one employee position.

After creating the employee positions, assign them to employee records. When you post a payroll record, Sage 100 Contractor looks at the position in an employee’s record, and the ledger accounts in the employee positions table:

- When a timecard line contains a job number, payroll posts to the ledger account in the Job Wages cell.
- When a timecard line contains an equipment number (for maintenance or repair), payroll posts to the ledger account in the Equipment Wages cell.
- When a payroll record does not contain timecard lines, or a timecard line does not contain a job number or equipment number, Sage 100 Contractor posts to the ledger account in the Other Wages cell.

You can also add a department to each position. When you post a payroll record, Sage 100 Contractor first looks to the job record for a department number. If Sage 100 Contractor does not find a department number in the job record, it next looks to the cost code. If the cost code does not contain a department number, Sage 100 Contractor then looks to the employee position.

Paygroups

About paygroups

Use paygroups to manage wages and the benefit packages for union shops, or open shops working Davis-Bacon projects. You can include the paygroups in the employee record or in the job record to provide the correct paygroup when entering timecards. The paygroup then becomes the source for wages and benefits on the timecard lines.

- For union shops, set up a paygroup for each combination of pay scale and benefits package that you need to report. Then assign the appropriate paygroup to each employee record. During timecard entry, Sage 100 Contractor assigns the paygroup from the employee record to each timecard line.

When working with multiple unions, it is a good idea to provide the union number at the beginning of the paygroup description. Place the important information at the beginning of the description. For example, 80% Apprentice instead of Apprentice—80%.
In open shops, the requirements between the prevailing-wage projects can vary, and employees can work under a variety of pay categories. For each prevailing-wage project, set up the appropriate paygroups for each combination of pay scale and benefits package that you need to report. Then in the job record, you can list only the paygroups for that job. When you enter a job number on a timecard line, Sage 100 Contractor looks for a list of paygroups. If the job record contains a list of paygroups, it then uses the employee’s position to determine the appropriate paygroup and inserts it on the timecard line.

When creating the paygroups, organize the paygroups by job or geographic area. When numbering the paygroups, skip a few numbers between groups in case you need to add other paygroups later. You may also want to include a job or area description in the paygroup name. This allows quick identification of the correct paygroup when entering timecards.

Each union or prevailing-wage project has specific requirements as to how the benefits are calculated. To manage the different benefit packages, you can assign an independent set of payroll calculations to each paygroup. It is important to review each benefit you provide and determine if it meets the requirements set forth by the governing agency. If not, you will need to create a new payroll calculation.

**Local Payroll Tax**

**About local payroll taxes**

Many counties and municipalities levy income taxes. In the **Local Payroll Taxes** window, set up the table of local payroll tax districts and their rates. You can then assign the locales to the appropriate job and employee records. If an employee lives in a locale, add the locale to the employee’s record. If a job site is located in a locale, add the locale to the job record.

There are a variety of ways to set up the districts:

Some districts base the taxes on whether the employee lives inside or outside the locality. The resident rate applies to employees that work and live in the same locality, while the non-resident rate applies to employees who work in the locality but live elsewhere.

During the payroll compute, Sage 100 Contractor compares the locale in the job record to the locality in the employee record. If the districts match, Sage 100 Contractor computes taxes at the resident rate. If the district numbers differ, Sage 100 Contractor computes taxes at the non-resident rate.

In some regions, employees are subject to several taxes, such as city and county income taxes. As Sage 100 Contractor only lets you assign one locality to a job record, employee record, or timecard line, you can combine districts in the **Local Payroll Tax** window to form a new district. You can then assign the combined district as needed.

When a local payroll tax applies to employees regardless where they work, you can set up the district to work like state income tax.

When employees work multiple states but there are no local payroll tax districts, use the districts to control how Sage 100 Contractor computes state income tax for each timecard line.

Each locality requires a corresponding payroll calculation. In most circumstances, each payroll calculation uses calculation method **17-Tables**, and refers to the table of localities for the rates.
Federal and State Filing

About Sage 100 Contractor integration with Aatrix

What is Aatrix®?

Aatrix is a leading provider of tax-form filing and compliance services. It is in business to help you complete state and federal payroll reports directly from your software. Now that Aatrix has been integrated into Sage 100 Contractor, you have the ability to fill out report forms, print, and then send them to federal and state entities.

In addition, if you enroll with Aatrix and set up an account, you can file reports electronically through Aatrix while working within Sage 100 Contractor.

Whether you print and send your tax reports or you files the reports electronically, with Aatrix integration there is no longer any need to create these tax reports manually.

What do I get if I register Aatrix through Sage 100 Contractor?

If you choose to register, you can fill out and print Aatrix report forms, and then send them to federal or state entities.

If you choose not to register, you can still use Aatrix in “Evaluate” mode; however, the forms you print will have a “DEMO” watermark. You cannot file them with federal and state entities.

How do I register?

As soon as you open the Sage 100 Contractor windows, 5-4-1 Federal Tax Forms by Aatrix® or 5-4-2 State Tax Forms by Aatrix®, you are prompted to register Aatrix through your Sage 100 Contractor so that it is associated with your Sage Service Plan.

As a benefit for our customers, registering Aatrix through Sage 100 Contractor allows you to use Aatrix forms. We recommend that you register immediately to take advantage of this valuable service.

Can I file electronically when I register?

Registering through Sage 100 Contractor allows you to use all the Aatrix report forms for your tax reports and then print them. Registering the Aatrix software through Sage 100 Contractor does not enroll you with an Aatrix account for filing electronically. To use electronic filing, you have to register for an Aatrix account.

How do I enroll with Aatrix so that I can file electronically?

For more information about enrolling with Aatrix and set up an account for efilng, visit https://efile.aatrix.com/

What is the Aatrix fee structure for electronic filing?

For more information about Aatrix fees, visit https://partner.aatrix.com/sagemasterbuilder.

Can I file W-2s electronically?

For more information about filing W-2s electronically, visit http://efile.aatrix.com/SMB029/info.aspx.

How do I use Aatrix with Sage 100 Contractor?

Basically, open either 5-4-1 Federal Tax Forms and eFiling by Aatrix or 5-4-2 State Tax Forms and eFiling by Aatrix. Select a state (state forms only), a report, set criteria, and then click Run Report or View History.
When you click **Run Report**, you can review the report and enter any missing information. Then you go to the next step to save and print the form. If you have an account with Aatrix, then you can file electronically by forwarding the completed reports to the Aatrix eFile® center for electronic filing.

When you click **View History**, you can review and work with reports through the **Open Report** window.

**How can I get acquainted with Aatrix integration before I use it for my company?**

You can open the Sample Company and then open either **5-4-1 Federal Tax Forms and eFiling by Aatrix** or **5-4-2 State Tax Forms and eFiling by Aatrix**. Select a state (state forms only), a report, set criteria, and then click **Run Report** or **View History**. This will also give you a chance to open the Aatrix Help, which provides details information about how the Aatrix processes works.

**What technical support options do I have if I run into a problem with Aatrix?**

If you have a problem with Aatrix or Sage 100 Contractor, call 800-849-8049 (Sage Customer Support for Sage 100 Contractor).

**About 5-4-1 Federal Tax Forms and eFiling by Aatrix®**

The 5-4-1 Federal Tax Forms and eFiling by Aatrix window is an integration portal into Aatrix. When you move beyond this window, for example, by clicking View History or Run Report, you are working in the Aatrix software that is integrated into Sage 100 Contractor.

**How does my business information in Sage 100 Contractor get into Aatrix forms?**

When you select a report such as 2008 940 Report and the Year 2008 and then click Run Report, Sage 100 Contractor searches its database for information relevant to that form and inserts it into the Aatrix form.

**How do I know the forms are up to date?**

Aatrix makes a strong point of keeping all its forms up to date. If Aatrix determines that you do not have the latest forms, you see a message window that provides four choices:

- **Automatic Update**: Update forms automatically over the Internet.
- **Download Update**: Update forms by manually downloading an update from any computer with an Internet connection.
- **Continue Expired**: Continue processing without the required update. Forms will be marked as expired and cannot be filed.
- **Cancel**: Cancel without processing forms.

**About 5-4-2 State Tax forms and eFiling by Aatrix®**

The 5-4-2 State Tax Forms and eFiling by Aatrix window is an integration portal into Aatrix software. When you move beyond this window, for example, by clicking View History or Run Report, you actually begin working in Aatrix software that has been integrated into Sage 100 Contractor.

On the menu bar, you have access to the following Options:

- **Update Forms**—Displays a message window that prompts you to update Aatrix forms if updates are available.
- **View History**—Displays the Open Report window which provides information about saved reports.
- **Payroll Calculation Assignments**—Displays the Payroll Calculation Assignments window. There are situations where your payroll calculation may need more information. You use the Payroll Calculation Assignments grid to assign the payroll to the tax.
• **Register Aatrix Software**—Displays the Aatrix Software Registration window. Registering allows you to fill out and print current reports for the duration of your service and maintenance contract. A line at the bottom of the window displays your registration status.

**NOTE:** When you are working in Aatrix software, you have access to Aatrix Help. Sage 100 Contractor Help does not duplicate Aatrix Help.

### About state quarterly reports

The **5-4-3 Magnetic Media—Quarterlies** window creates reports through the existing Sage 100 Contractor functionality.

**IMPORTANT:** Sage 100 Contractor creates an electronic file that you can submit electronically. The state of California accepts physical media and electronic files; however, mailing the electronic file on physical media (round tapes, cartridge, diskette, CD) is no longer an acceptable filing method for “federal tax forms.” For details, visit [http://www.edd.ca.gov/Payroll_Taxes/Electronic_Filing_Registration_and_Payment_Information.htm](http://www.edd.ca.gov/Payroll_Taxes/Electronic_Filing_Registration_and_Payment_Information.htm)

To help complete your quarterly report, print the state quarterly report.

**You can also print:**

- The **State of California Quarterly Employee Tax Report (DE6)**. With the preprinted DE6 forms in your printer, you can print the DE6 information directly on the form. You can also create an electronic file.
- The **Alaska Quarterly Contribution Report**. For the Alaska Quarterly Contribution Report, Sage 100 Contractor prints the form as well as the information on blank paper.
Chapter 7: Project Management

Working with Project Management

Sage 100 Contractor’s project management tools provide a way for you to manage proposals, budgets, purchase orders, subcontracts, change orders, and job costing.

Budgets

Your budgets are always under your control when you verify and compare job costs as you enter them. You can enter budget information manually or export data from Sage 100 Contractor estimates. Budget information can be used in Work in Progress, Bonding, and Job Status Reports as well as in other reports that compare costs by cost code, cost type, and summary totals. Also, as your project proceeds, Sage 100 Contractor maintains the initial budget and contract amounts at the same time that it updates the current (working) budget and contract amounts with change order information. In addition, you can create budgets from your estimate, import budget information from other programs, or manually export budget information to Work in Progress, Bonding, Job Status, and other reports.

Purchase Orders

Your can simplify your purchasing to enhance productivity. Sage 100 Contractor can generate all purchase orders from your estimates, and then automatically phase your purchasing by scheduled tasks. Alternatively you can use master purchase orders and generate purchase orders for only the parts you need at a particular time. You can also create manual purchase orders with the Part Lookup feature.

After you issue a purchase order, the costs are included in committed cost reports. To pay your bills, simply enter the purchase order number from supplier invoices and Sage 100 Contractor fills in the payables due, plus the remaining balances and job cost information automatically. You can set vendor-specific warnings so that you will not pay invoices that are missing a purchase order number or invoices that exceed the purchase order amount. By running purchase order audit reports, you can catch overcharges.

Subcontracts

You can manage all subcontractor interactions from contract creation to the last item on your final punch list. Sage 100 Contractor helps you avoid subcontractor overpayment by monitoring for retention, approved and open change orders, expired Workers’ Compensation, liability insurance, safety certification, and more throughout the job. Over-billing control, retention tracking, withholds for insurance, charge backs, lien tracking, and lien waivers are all fully integrated with Sage 100 Contractor’s accounts payable functionality.

You can make your own custom subcontract forms (up to 100 pages) using the Subcontract option in Form/Report Page Design, so you do not need to use pre-printed forms. You can even include a billing form to standardize your subcontract billings.

To check a subcontract’s status, you simply click Recap, and then click once more to display a list of changes or invoices against the contract. You can also call up a summary view of the entire subcontract to verify billing accuracy whenever you enter an invoice for payment.
Change Orders
With Sage 100 Contractor’s change order management tools, you use a single window to modify your prime contract, any number of subcontracts, and your budget. After approval, change orders automatically increment your budget, contract, and subcontracts. You can handle each part of the change independently and continue subcontract negotiations even after the prime contract change has been approved. Your approved and pending change orders are reflected in job cost reports.

You can use internal change orders to manage chargebacks, move work from one subcontractor to another, and manage inter-cost changes. You can view prime and subcontract audits with audit reports.

Using change orders, you can manage all upgrades and options that belong to the sale price of the project. You can archive change orders as they are printed for a complete, permanent history of interactions with your clients and subcontractors.

Job Costing
With Sage 100 Contractor’s job costing functionality, you can see where your business is earning profits and where you need to improve estimates or other processes to be more profitable. Generate a wide variety of reports comparing costs to budget so that you can obtain precise, up-to-date cost views for every project with as much detail as you choose to include. Sage 100 Contractor job costing helps you estimate job profits with cost-to-complete and committed-cost reports that compare budgets, job costs, and actual labor for every line item. You can even create your own job cost reports with the built-in Report Writer.

Job cost information, including labor burden costs, stays current and accurate because it integrates with all posting features including General Ledger, Accounts Payable, Accounts Receivable, Payroll, Equipment, and the Inventory add-on module. Because explicit cost details are preserved indefinitely, you can research job costs at any time.

Project Work Center

About Project Work Center
The first time you open the Project Work Center, the job box displays the last job entered in the current company. However, you can also view any other available jobs in that company. After that, the last accessed job is the default when you open Project Work Center. If you have not created any jobs in your company, you are prompted to create one from the 3-5 Jobs (Accounts Receivable) window when you open Project Work Center.

Project Work Center displays the following information for a selected job:

- A customizable menu tree displaying accessible menu commands.
- The Project Hot List.
- Contact and current financial information about the selected job.

**IMPORTANT:** All selections and defaults are user-specific and company-specific.

Customizable Menu Tree
The left side of the window displays a menu tree for accessible Sage 100 Contractor menu commands for the selected job. Selecting a menu command displays the form or record pre-loaded with the job’s information for you to view or update.

In some cases, a list of associated items of that type for the selected job appears and you can then select the appropriate item. The following selections display a list:
- 3-2 Receivable Invoices/Credits
- 3-7 Progress Billing
- 4-2 Payable Invoices/Credits
- 6-4-1 Change Orders
- 6-6-1 Purchase Orders
- 6-7-1 Subcontracts

The menu tree defaults with all possible menu commands available. This is customizable through the **Customize Project Work Center Menu** window.

**Project Hot List**

The upper right side of the window displays the **Project Hot List**. The **Project Work Center** lets you view and manage information from the standard tables in the **Project Hot List**. With **Document Control**, you also have access to the enhanced functionality available from the **6-11-9 Project Hot List** window.

**Project Work Center Job Contact and Financial Data**

The bottom of the window displays important information at a glance for each selected job. This information is “display only” and cannot be edited. However, as information is changed in Sage 100 Contractor for a specific job, this information is updated.

**Project Work Center Desktop Shortcut**

Job information is available directly from the **Sage 100 Contractor Desktop** by creating a desktop shortcut icon in the **6-12 Project Work Center** window. This feature enables you to view important data and manage all your jobs from one location. **Project Work Center** is highly customizable for each user’s needs.

**IMPORTANT:** You must create the desktop shortcut once. The **Project Work Center** shortcut will then be accessible from the desktop or in the **6-12 Project Work Center** window.

**Project Work Center job contact and financial information**

The bottom of the **Project Work Center** window displays contact and financial information for the selected job. This information is “display only.” However, as you make changes in Sage 100 Contractor that affect the selected job, this information is refreshed.

The following client information appears:

- Client name
- Contact name
- Email address
- Phone number
- Fax number
- Cell number
The following financial information about the job appears:

- Contract Amount
- Approved Changes
- Total Contract
- Costs to Date
- Original Budget
- Budget for Changes
- Total Budget
- Costs as % Budget

**Project Hot List**

**About Project Hot List**

This functionality is available only if you have the Document Control Module.

The Project Hot List is a record of items that require immediate attention. You can display a hot list by job or by supervisor. You can then drill down to review a specific record.

You can access the Project Hot List from the 6-11-9 Project Hot List or the 6-12 Project Work Center windows.

**IMPORTANT:** Selection by supervisor is not available when accessing the Project Hot List from 6-12 Project Work Center.

You can include the following standard information on the Project Hot List:

- Invoices
- Change orders
- Purchase orders
- Subcontracts
- Proposals
- Progress bills
- Loan draws
- Unitary bills
- Recurring payables
- Recurring receivables

**Optional information you can include on the Project Hot List:**

You can display more items in your Project Hot List, from both the 6-11-9 Project Hot List and 6-12 Project Work Center windows, such as:

- Requests for information
- Requests for proposals
- Transmittals
- Submittals
- Plan records
- Daily field reports
- Punch lists
- Correspondence

**Budgets**

**About budgets**

A budget represents a summary of the hard costs detailed in a takeoff, and provides the basis for all budgeted versus actual cost, hour, or unit comparisons. In addition, you can use the budget as the basis for the proposal you provide to the client.

The costs for a budget are categorized by cost code, and each cost code is further divided into cost types. Furthermore, you can include the hours necessary to complete the work for each cost code. For work performed on a unit basis (include the quantity of units to be performed for each cost code), Sage 100 Contractor automatically computes the cost per unit.

There are several ways to create a budget: you can export the data from a takeoff, import a file, or create a budget manually. After the budget is completed, you can set the original budget. If at any point the budget is changed, you can compare it to the original.

If it becomes necessary to adjust the costs in a budget, you enter the changes by issuing change orders. Change orders allow you to alter the budgeted costs independent from the budget itself.

Sage 100 Contractor also provides a way for you to be warned when you are over budget. The program determines the costs to date for the jobs by cost code and cost type. It then compares the data to the original budget plus change orders. When you save the record, Sage 100 Contractor notifies you if costs exceed the budgeted amount for a job. You can enable the Over Budget Warning option using the 1-3 Journal Transactions or 4-2 payable Invoices/Credits windows.

**Job Costs**

**About job costs**

Job costs provide detailed information about costs, giving you the means to track the costs of a project using cost codes and cost types. This functionality provides you with another way to analyze costs and refine the estimating or budgeting process.

When you post a transaction to the Direct Expense or WIP range of accounts, Sage 100 Contractor prompts you to create a job cost record in the Job Cost Distribution window. Job cost records are maintained in a separate database from the accounting data, and therefore do not impact the general ledger.

**IMPORTANT:**

If you have turned on WIP Verification for job costs, and are posting job costs to a job that is marked for WIP Posting, you will not be allowed to post to a direct expense account. A message will display: **WIP Posting is not = to job costs.** You must correct your posting before you will be allowed to save.

If you have turned on WIP Verification for job costs, and are posting job costs to a WIP (Asset) ledger account for a job that is not marked for WIP Posting, a message will display: **WIP Posting is not = to job costs.** You must correct your posting before you will be allowed to save.

If a text box is shaded, you cannot directly edit the data; you can only change it through an accounting entry.
About job cost reconciliation

Because discrepancies can appear over time, it is important to reconcile the job cost records with the ledger transactions. During the reconciliation, Sage 100 Contractor compares the ledger transactions with the job cost records and reports any discrepancies that exist.

The reconciliation determines if ledger transactions are missing job cost records, or if variances exist between the cost amount of the ledger transaction and the job cost records. After the audit is complete, print the Job Cost Reconciliation report, which lists ledger transactions that are missing cost records or have variances in excess of $1.

To determine the cause of each error, review the ledger transaction in the 1-3 Journal Transactions window or in the window of original entry. If a transaction does not have a corresponding job cost record, look for situations where cost records have been deleted. For example, when you delete a job Sage 100 Contractor deletes all associated records, including the job cost records.

It is also important to search the job cost records thoroughly. Because historical records do not tie to ledger transactions, it is possible to already have a cost record for a ledger transaction. Make sure that a historical record does not already exist before creating a cost record. If you cannot locate a cost record, you can enter a historical cost record.

Resolving audit variances does not eliminate them from the Job Cost Reconcile report, and they will appear on subsequent reports for the fiscal year. It is a good idea to retain a printed copy of the report and any notes you have made to help identify and resolve errors. You can then use the report with future job cost reconciliation reports to identify the job cost errors you have already resolved.

NOTE: Sage 100 Contractor does not report duplicate or extra job cost records because they are not associated with a specific ledger transaction. Additionally, Sage 100 Contractor cannot audit historical job cost records as they were not created by posting ledger transactions.

Job Cost Distribution

About job cost distribution

When you post payable transactions to the Expense range of accounts, Sage 100 Contractor displays the Job Cost Distribution window.

In the Job Cost Distribution window, you can break apart costs to create individual line entries that reference jobs, phases, cost codes, and cost types. You can also select jobs or phases using a Picklist and distribute the cost equally among the selections.

When job costing a transaction from the 1-1 Checks/Bank Charges window or the 4-2 Payable Invoices/Credits window, Sage 100 Contractor uses the vendor record to determine which cost code and cost type to use. If the vendor record does not contain a cost code or cost type, you must supply the information.

The Ledger Total box displays the total debits less credits posted to Direct Expense or WIP accounts. As you enter the costs, Sage 100 Contractor shows the total amount costed in the Job Cost Total box. To save the job cost record, the amount in the Job Cost Total box must equal the amount in the Ledger Total box.

Change Orders

About change orders

The 6-4-1 Change Orders window provides functionality for managing changes to a prime contract or subcontract. Change orders allow you to track changes independent of a project’s budget, providing a clear audit trail for pending, approved, and refused changes.
Depending on the type of change work you need to perform, you can enter change orders that alter the job’s budget, proposal, or subcontracts, or any combination of the three. On the **Prime Change Details** tab, you can enter changes to costs that affect the bid amount. In the **Budget and Sub Change Details** tab, you can enter cost changes that affect your budgeted costs such as subcontract changes, or work for which you do not want to charge the client.

Change orders are now more closely integrated with subcontracts. When you create a change order using the **6-4-1 Change Orders** window for a subcontract, information is displayed on the **6-7-1 Subcontracts** window in columns named **Changes, New Contract, and Remaining**. This tight integration provides more control over your contracts and your invoicing by providing accessible information.

The **6-4-1 Change Orders** window has two tabs, **Prime Change Details** and **Budget and Sub Change Details**.

**Prime Change Details tab**

The **Prime Change Details** tab allows you to track changes to a project and segregate changes to the contract (proposal) from changes to your budget (costs).

Prime Changes are change orders that alter the job proposal. Prime Changes allow you to track changes independent of a project proposal, providing a clear audit trail for pending, approved, and refused changes.

From approved prime changes, you can create receivable invoices and purchase orders. When you select the **Create A/R Invoice** or **Create Purchase Order** command on the **Options** menu, Sage 100 Contractor opens the appropriate window and inserts the relevant information. To complete the invoice or purchase order, you enter the parts and any additional information.

**Budget and Sub Change Details tab**

Change orders have two components: Prime Change Orders and Budget and Sub Change Orders. Change Orders allow you to track changes to a project and segregate changes to the contract (proposal) from changes to your budget (costs). Depending on the type of change work you need to perform, you can enter change orders that alter the job budget, proposal, or subcontracts, or any combination of the three. Overall, change orders provide a convenient way to manage changes to a contract or subcontract.

Subcontracts work in conjunction with change orders and accounts payable, providing you with better control over change work and billing. You can review billings, approved and open change orders, or a summary of the subcontract information. You can also set up retention for a subcontract. When you create an invoice for the subcontract, the program uses the rate indicated in the subcontract record.

Because the **Sub Change Orders** window provides for managing changes to a budget or subcontract, you may enter cost changes that affect your budgeted costs (such as subcontract changes) or cost changes that affect work for which you do not want to charge the client.

When changes are approved, Sage 100 Contractor reflects the changes to costs in the contract and job cost reports, but the original budget remains unchanged. From approved change orders, you can create receivable invoices and purchase orders. When you select the **Create Invoice** or **Create Purchase Order** command on the **Options** menu, Sage 100 Contractor opens the appropriate window and inserts the relevant information. To complete the invoice or purchase order, you enter the parts and any additional information.

You can also record which plans and documents you send as attachments with the change order, as well as to whom you route the change orders.

**Attachments and Routing**

The **6-4-1 Change Orders** window also supports **Attachments** and **Routing**. You can drag and drop files onto the window to create an attachment that can be emailed to customers or printed. The Routing command allows you to keep track of where and to whom you have sent attachments.
Upgrade check box

Another important feature of the 6-4-1 Change Orders window is Upgrade check box. The Upgrade check box controls what information is included in important reports. Here are two examples:

For an Upgrade Price to appear on the Homebuilders reports and to be added to the Sales Price Totals on the reports, Upgrade must be selected, and that specific change order must have an approved Prime Change Order amount.

For the Upgrade Budget to appear on the Homebuilders reports and be added to the Total Budget, Upgrade must be selected, and that specific change order must have an approved Budget amount.

How change orders affect budgets and proposals and subcontracts

You can make changes to the budgeted costs, bid amounts, and subcontracts using the 6-4-1 Change Orders window. When you print contract-related reports, Sage 100 Contractor computes the new contract amounts based on the amount in the Contract box in the 3-5 Jobs window and approved changes. In cost analysis reports, Sage 100 Contractor computes the new costs based on the costs from the budget and approved change orders.

Sage 100 Contractor does not alter the original budget created in the 6-2 Budgets window nor does it alter the original proposal created in the 6-9 Proposals window. It does, however, update subcontract totals while retaining the original subcontract amount when change orders are created using the Budget and Sub Change Details tab. These totals can be viewed in 6-7-1 Subcontracts. You can also use the subcontracts window to invoice the entire subcontract or specific change order lines of the subcontract.

After work begins on a contract, enter any changes to the budget or proposal as a change order. As you create the change order, determine whether the costs affect bid amounts, budgeted costs, or both.

For example, suppose you forgot to estimate the cost of some work required in a project. To include the costs in the budget and charge the client, enter the changes to the bid amount on the Prime Change Details tab in 6-4-1 Change Orders. Then on the Budget and Sub Change Details tab, enter the changes to costs.

Otherwise, if you merely want to add the costs to the budget without charging the client, enter only the changes to the costs in the Budget and Sub Change Details tab.

Alternatively, you can set the original budget and manually enter the changes to costs in the affected cost codes. Likewise, you can set the original proposal and enter the changes in the affected cost codes. In addition, you can use a separate cost code for each change order.

About entering change orders

The 6-4-1 Change Orders window contains a header area and two tabs, and at the bottom, boxes that report various values that you may be following.

The header area contains boxes for entering information such as: Job, Phase, Description, Date, Status, and so forth.

IMPORTANT: The Status box selection sets the status for both tabs, however; you can override the Status box selection by entering a status in the Approved column on the Budget and Sub Change Details tab except for those with a status of Void and Rejected.

Tabs

The window has two tabs, Prime Change Details, and Budget and Sub Change Details. To make changes to a job’s contract amount, you enter the change on the Prime Change Details tab. To change a budget or subcontract, you enter the changes in the Budget and Sub Change Details tab.
The changes to the contract amount (3-5 Jobs (Accounts Receivable), and the budget amount (6-2 Budgets) do not appear in the window of origin. They only appear in reports or in sub-menus of the windows of origin. This functionality maintains the separation of the original amounts and the changes.

For example, to see the changes in a contract, you may view the Prime Contract Audit report. To see the changes in the budget, you may view various project management reports, such as the Job Cost Summary report. To see the changes in a subcontract, you may view the subcontract Audit report.

On the 3-5 Jobs (Accounts Receivable) window, on the menu bar, you may also view changes in the contract amount by clicking Options > Contract Summary.

On the other hand, changes to the subcontract do appear in the 6-7-1 Subcontracts window. After creating a change order against a subcontract, the program updates the changes as well as the original totals. On the 6-7-1 Subcontracts window, on the menu bar, you may also view changes in the budget amount by clicking Options > Summary.

Change order work may require an adjustment to the job contract and the budget. For example, a general contractor has begun work on a kitchen remodel project and the client wants to change the sink called for in the plans. The plumbing subcontractor tells the general contractor to add $75 for the sink upgrade.

In creating the change order, the contractor enters the $75 change to the subcontract in the Budget and Sub Change Details tab. Because the client requested the change, the contractor charges $25 for the upgrade in addition to the $75 in added costs. On the Prime Change Details tab, the contractor enters a request for an additional $100. After saving the sub change, the change information appears with the subcontract record in 6-7-1 Subcontracts.

Sometimes you might only want to change the contract amount. Suppose, from the above example, the sink the client wants costs the same amount as the sink from the plans. Because the client requested the change, the contractor charges $25 for the change work. On the Prime Change Details tab, the contractor enters a request for an additional $25.

Under certain conditions, you might have to adjust only the budget. Suppose the specification for the faucet requires a specific model that costs $100. However, due to some miscommunication, the subcontractor installed a model costing $150 and refuses to take the loss. In the Budget and Sub Change Details tab, the contractor enters a budget change for $50.

TIP: To include a detailed description of the change order work, type a note for the change order “record” rather than typing a note in a grid row or including an attached document. To open the Notes window, click the Notes icon on the toolbar.

About automatic numbering for change orders

When you create a new change order for a job, Sage 100 Contractor provides the next change order number in the sequence. You do not have to accept the suggested change order number, and can enter your own number instead.

Use the following guidelines:

- When a change order number uses only a number, Sage 100 Contractor increments the change order number by one. For example, you create change order 1 for job 220. The subsequent change order numbers would be 2, 3, 4, and so on.
- If a change order number uses a dash ( – ), Sage 100 Contractor increments the number to the right of the dash by one. The dash lets you include the job or subcontract number in the change order number sequence this helps identify to which job or subcontract the change order belongs.

Suppose you are creating the first change order for job 220. By including the job number, the first change order number would be 220-1. The subsequent change orders for the job would be 220-2, 220-3, and so on.
You can also use the same numbering convention for subcontract change orders. Suppose you are creating a change order for subcontract 850 on job 220. When entering the first change to the subcontract on the Budget and Sub Change Details tab, you enter 850-1 in the Change# box. Later, when you enter another change order for that subcontract, the next change order number would be 850-2.

- When a change order number combines letters and numbers, Sage 100 Contractor cannot increment the change order number. For example, if you created change order AAA5 for job 220, Sage 100 Contractor cannot suggest the next change order number.

**NOTE:** The change order numbers in each phase of a job are independent from the change order numbers in the other phases of the job. Suppose job 220 has two phases, and you create change order 220-1 in phase 1. In phase 2, you can also create change order 220-1. This lets you track the number of change orders in each phase.

### About adding change orders to subcontracts

It is likely that you will have to add one or more change orders to subcontracts during the course of a project.

**NOTE:** 6-7-1 Subcontracts control subcontract records and their interaction and integration with 6-4-1 Change Orders and 4-2 Payable Invoices/Credits. Changes made to records in 6-4-1 Change Orders and in 4-2 Payable Invoices/Credits are displayed in 6-7-1 Subcontracts.

The process of entering a change order for a contract is straightforward. You begin by referencing the job in the header section of the widow. Then after entering the required information, such as Description, Change#, Date, and Status in the header, you enter information in the tabs, Prime Change Details and Budget and Sub Change Details.

On the Prime Change Details tab, you only need to enter required information for Description, Cost Code, and Cost Type. Then you click the Budget and Sub Change Details tab to enter the changes.

There is a new column, Subcontract Line, in the Budget and Sub Change Details grid. Five of the columns of the grid now act as a unit. These columns are:

- **Vendor**—Enter a vendor, or accept the default vendor.
- **Subcontract**—Enter a subcontract number, or accept the default subcontract number.
- **Subcontract Line**—Select the line to affect in the subcontract, leave the cell blank to create a new line in the subcontract.
- **Change#**—Enter a Change#, or accept the default Change#.
- **Status**—Enter a Status.

**IMPORTANT:**
These five columns act as a unit. In addition to required fields, a value must be entered under each of these columns except Subcontract Line to be able to save the change order record.

If the Subcontract Line cell is blank, you have to enter a Cost Code and Cost Type.

If you enter data in the Subcontract Line cell, Cost Code and Cost Type autofill.

### Change a line or create a new line in a 6-7-1 Subcontract record

When entering a subcontract change, you can add or subtract the existing value of a subcontract record line or you can add a new line to the subcontract record. When working in the grid with your cursor in the a cell under the Subcontract Line column, you can press F5 to open the Subcontract Lines lookup window. Then select the line you want to affect by double-clicking it. Alternatively, leaving the Subcontract Line cell blank when creating a new line in the grid, creates a new line in the subcontract record.
After saving the record, you can see the changes to the subcontract record by opening the subcontract in **6-7-1 Subcontracts.** In the grid, notice that the **Changes** column will have an entry in the line you selected when creating the change. The change is also displayed in the details summary boxes at the bottom of the window.

**Cost Codes and Divisions**

**About cost codes and divisions**

Cost codes are an important part of the job costing system. They allow you to separate costs into different categories and compare budgeted costs to actual cost for a job. Each cost code is assigned to a division, which provides a way to group cost codes for subtotaling on reports. Sage 100 Contractor organizes job costs in order of detail by job and phases, cost codes, and cost types.

![NOTE:](image) Cost codes are company-specific, not job-specific.

A common mistake when creating a cost code list for general contractors is building a long list that contains too much detail. It is unnecessary to include trades that the contractor does not perform or subcontract. Unless a general contractor performs the work, one cost code is usually sufficient. For example, a general contractor rarely needs separate cost codes for rough electrical, electrical trim, electrical fixtures, and alarm. Including such trades only creates an unwieldy cost code list, which leads to errors in data entry.

The cost code list for most single-trade subcontractors can be very short; a dozen codes are usually sufficient. Some contractors, though, may need more cost codes. Mechanical subcontractors, for example, may need approximately twenty codes to break down both plumbing and HVAC work.

Divisions are used to group cost codes. Because Sage 100 Contractor uses divisions to subtotal costs for cost-based reports, many contractors create divisions based on the Construction Specifications Institute (CSI) divisions. However, you do not have to rely on the CSI structure for divisions and can create your own.

![NOTE:](image) Although there is no report that prints cost codes by division, you can print the cost codes from the **6-5 Cost Codes** window. The report lists the costs codes and divisions assigned to them.

**About Workers’ Compensation codes**

Assigning Workers’ Compensation codes to cost codes provides the correct compensation code based on the type of work performed during timecard entry. You may need to create additional cost codes for the combination of cost codes and Workers’ Compensation codes to work correctly.

In a split rate system for Workers’ Compensation, a category of work uses two different rates. Some states, such as California, use a two-tiered system of rates based on employee pay. The wages an employee earns determines the rate at which the insurance company computes Workers’ Compensation.

For split rates, Sage 100 Contractor uses a wage maximum to determine which code to use. For wages that are less than or equal to the wage maximum, Sage 100 Contractor assigns the first compensation code to the timecard. When employee wages exceed the wage maximum, Sage 100 Contractor assigns the second compensation code.

**Setting Up A Cost Code Numbering System**

**About cost code numbering systems**

When creating cost codes, use a simple numbering system to avoid the introduction of errors and to divide the cost codes into major categories. When starting with a 4-digit number system, for example, make each thousand a division, such as **1000-General Requirements, 2000-Site Work, 3000-Concrete, and 4000-Masonry.**
CAUTION: Carefully plan your cost code structure before implementing it. After you have entered transactions into the system with a set of cost codes, it is a complex process to change them.

The Construction Specifications Institute (CSI) has designed a set of cost codes intended for cost and specification purposes. General contractors often adopt the system for estimating and cost accounting, and subcontractors often use an extended numbering system defined by the CSI code list.

NOTE: Cost codes are company-specific, not job-specific.

About cost code numbering for general contractors

A common mistake when creating cost codes is building a long list that contains too much detail. It is not necessary to include trades that the contractor does not perform or subcontract. Unless a general contractor performs the work, one cost code is usually sufficient. For example, a general contractor rarely needs separate cost codes for Rough Electrical, Electrical Trim, Electrical Fixtures, and Alarm. Including such trades only creates an unwieldy cost code list. While you can use a single cost code in place of many cost codes, how do you track costs? With each payable invoice, the contractor creates job costs that detail the type of work performed. Continuing with the example above, an electrical subcontractor on most jobs submits three to six invoices to the general contractor. By printing a Job Cost Journal for the specific job, the journal details each electrical cost entry made to the job as well as the total electrical costs.

There are circumstances in which having several cost codes are useful. If you have allowances in a contract, you will want to track those costs separately. For example, you might use Electrical and Electrical Fixtures as separate cost codes, allowing you to separate the electrical costs. Over the course of the project, you can provide the owner with a report detailing the total amount spent on allowance items. You can always enter a change order to adjust the prime contract based on the over/under amount of the allowance.

When building the list of cost codes, it is best to begin with a small list with room for expansion. Over time you can add more cost codes in the appropriate sections.

For ease of use, many general contractors use the Construction Specifications Institute (CSI) divisions. Be aware that the CSI numbering system classifies materials and workmanship in a construction project and not cost breakdowns. In most cases, the first two levels of the CSI system work for cost codes. If you decide to use the CSI divisions, use the main 16 divisions. To provide room for growth in the cost code list, add two or three zeros after each division number.

While creating the cost codes, keep in mind that you will assign a cost type to each job cost. It is unnecessary, therefore, to create cost codes that break apart costs into materials, labor, equipment, subcontracts, and so forth.

About cost code numbering for subcontractors

The cost code list for most single-trade subcontractors can be very short; a dozen codes are usually sufficient. Some contractors, though, may need more cost codes. Mechanical subcontractors, for example, may need twenty codes or more to breakdown both plumbing and HVAC work.

Some subcontractors use numbers that reflect the related CSI divisions. For example, a drywall subcontractor may use 9250 for Stocking, 9255 for Hanging, 9260 for Taping, 9265 for Spraying, 9270 for Knockdown, and 9275 for Cleanup. General contractors or owners rarely require such detail in a cost code list.

Purchase Orders

About purchase orders

A purchase order lists the materials needed from a specific vendor for a specific job. You can create purchase orders manually for each vendor, or export data from the takeoff to create purchase orders automatically for each vendor. In addition, you can create purchase orders for the subcontractors on a given project.
With large projects, you can create master purchase orders. A master contains all the parts needed from a vendor, but allows you to create smaller purchase orders to help schedule the flow of materials to the job site. For example, you can stagger the purchase and delivery of framing materials to better coincide with the different phases of construction.

After creating purchase orders, you can generate job cost reports to determine committed costs. As you receive shipments of materials, employees can enter the quantities of materials received using the **12-4 Purchase Order Receipts** window, which creates a payable invoice with status **2-Review**. When you receive the payable invoice from the vendor, you can review the invoice record and make any necessary adjustments.

Use the **Remove Closed Purchase Orders** option to remove purchase orders with a **Closed** status and no job number.

**About master purchase orders**

To control the ordering and arrival of materials at a job site, use a master purchase order. Think of the master purchase order as a contract with the vendor, which lists all the materials you intend to purchase over the course of the project. You might even supply each of your vendors with copies of the master orders.

From the master, you create smaller purchase orders for the materials necessary to complete the next series of tasks. The master tracks the total quantity of items ordered and cancelled for a particular vendor and job. After creating the master purchase order, you can create all the smaller purchase orders to ensure you have accounted for all materials on the master purchase order. Then you only need to assign the appropriate delivery dates and print the purchase orders as you need them.

**Subcontracts**

**About subcontracts**

Many general contractors enter into subcontracts with other contractors to perform specific types of work. In the **6-7-1 Subcontracts** window, you can create subcontracts, review change work and invoices that affect subcontracts, and gain tighter control of subcontract billings. You can export items from a takeoff to create subcontracts automatically, or you can enter the subcontracts manually.

When using phases to manage larger projects, look at the amount of work a subcontractor is providing and determine whether you want to create a single subcontract for the entire job or a subcontract for each phase within the job. If the amount of work is relatively small or does not vary from phase to phase, it might be easier to create a single subcontract. For large amounts of work, or if the complexity of work varies between phases, consider creating a subcontract for each phase.

From a takeoff, you can export items assigned status **4-Subcontract** by job, or by job and phase.

- When you export the subcontracts by job, Sage 100 Contractor creates a subcontract that lists each phase in which the subcontractor performs work.
- When you export the subcontracts by job and phase, Sage 100 Contractor creates a separate subcontract for each phase in which the subcontractor performs work.

Subcontracts work in conjunction with change orders and accounts payable invoices, providing you with better control over change work and billing. You can review billings, approved and open change orders, or a summary of the subcontract information, including a line-by-line summary of the invoiced amounts. You can also set up retention for a subcontract. When you create an invoice for the subcontract, Sage 100 Contractor uses the rate indicated in the subcontract record.
Job-Complete Tracking

About cost to complete

CAUTION: The Cost to Complete report relies on accurate and up-to-date job costs. Be sure to post all job costs and enter any recent change orders before updating the report.

In the 6-8-1 Cost to Complete window, you can generate a report estimating the costs necessary to complete a project currently under construction. When you select the job and phase and update the data, Sage 100 Contractor retrieves the current budget, job costs, and the gross wages for uncomputed payroll records. Over the course of the project, you can update the current budget and job costs in the Cost to Complete window to create a new report.

Enter the estimated percent of work completed or costs to complete the project, and calculate the report. If you provide the percent of work completed, Sage 100 Contractor computes an estimate of the remaining costs to complete the project and the amount by which you are over or under budget. If you provide the estimated costs to complete the project, Sage 100 Contractor computes the percent of work completed and the amount over or under budget.

While the computed payroll records include the labor burden, the gross wages for uncomputed payroll records do not. To increase the accuracy of the report, you can provide a labor burden rate, which Sage 100 Contractor uses to calculate and add in the estimated labor burden for uncomputed payroll records.

About hours to complete

In the Hours to Complete window, you can generate a report estimating the number of hours necessary to complete a project currently under construction. When you select the job and phase and update the data, Sage 100 Contractor retrieves the current budget, job costs, and the gross wages for uncomputed payroll records. Over the course of the project, you can update the current budget and job costs in the Hours to Complete window to create a new report.

CAUTION: The Hours to Complete report relies on accurate and up-to-date job costs. Be sure to post all job costs and enter any recent change orders before updating the report.

Enter the percent of hours completed or estimated hours to complete the project, and calculate the report. If you provide the percent of hours completed, Sage 100 Contractor computes an estimate of the remaining hours to complete the project and the amount by which you are over or under budget. If you provide the estimated hours to complete the project, Sage 100 Contractor computes an estimate of the percent of hours completed and the amount by which you are over or under budget.

About units to complete

In the 6-8-3 Units to Complete window, you can generate a report to review the number of units to complete on a project currently under construction. When you select the job and phase and update the data, Sage 100 Contractor retrieves the current budget. Over the course of the project, you can update the current budget in the Units to Complete window to create a new report.

You can enter the estimated units completed and calculate the report. Sage 100 Contractor computes the budgeted cost per unit, the actual cost per unit, and the units by which you are over or under budget.

Proposals

About proposals

The proposal is a document presented to a client, providing a breakdown of the contracted amount by cost code or bid item. Sage 100 Contractor provides several ways to create a proposal: you can export the data from a takeoff, import a budget,
import a file, or create a proposal manually. After the proposal is completed, you can set the original proposal. After negotiating the price with your client, you can edit the current proposal and compare it with the original.

If it becomes necessary to adjust the selling price in a proposal, enter the changes by issuing change orders. Change orders allow you to alter the selling price independent from the proposal itself.

**About creating proposals**

There are many ways to create proposals—from entering the cost codes or bid items manually, to selecting a list of cost codes or bid items in a Picklist, to importing a budget or file. Furthermore, you can export a takeoff to create a proposal by bid item or cost code.

While it is faster and easier to import a proposal, you can also build a proposal manually by entering the individual cost codes and amounts for each cost type, including the overhead and profit.

**Exporting and Importing Proposal Files**

**About exporting and importing files**

Files save you time performing repetitious work by providing the structure for documents such as budgets or proposals. You can create files that provide only a brief outline or contain nearly complete information or anywhere in between.

Suppose that you are building homes in a residential subdivision. Because there is only one model of home, the basic budget for each home does not change. Rather than re-entering the same budget information for each home you intend to build, you can create a file from the first budget. Then for each new home, import the budget file and enter any minor modifications to suit the needs of that particular project.

If the subdivision contains four different models of homes, you can create four budget files. When you begin work on a new home, import its budget file for the particular model and modify it as needed.

Perhaps you do a great deal of home construction, and one budget cannot accurately reflect so many different projects. You can create a budget file that only contains a list of cost codes. When you import the budget file, you can enter the appropriate figures as dictated by the job.

When creating a file, either you can use an existing record as the basis for the file, or you can build the file from scratch.

**Unitary Proposals**

**About unitary proposals**

The proposal is a document presented to a client, providing a breakdown of the contracted amount by bid item. There are two ways to create a unitary proposal: you can import a file, or you can create a proposal manually. After the proposal is completed, you can set it as the original. After negotiating the price with your client, you can edit the current proposal while retaining the original.

If it becomes necessary to adjust the selling price in a proposal, you enter the changes by issuing change orders. Change orders allow you to alter the selling price independent from the proposal itself.

**Document Control**

**About document control**

This functionality is available only if you have the Document Control Module.
Sage 100 Contractor’s **Document Control** module provides complete control of all your project management documents. These include Requests for Information (RFIs), Requests for Proposal (RFPs), transmittals, submittals, daily field reports, and correspondence.

**Document Control** tools help you manage correspondence, keep track of project plans, maintain a project hot list, and stay on top of punch list items. A customizable template makes daily field reports accurate and accessible.

When using the functionality of **Document Control**, all your documents integrate with estimating, change orders, purchase orders, subcontracts, and payroll. This makes the process of project management complete, fast, accurate, and reliable.

**About Request for Proposal**

This functionality is available only if you have the **Document Control Module**.

A Request for Proposal (RFP) is a document you send to vendors or subcontractors containing a list of parts needed or work to be performed. The vendor or subcontractor uses the RFP to create a proposal for you. Look for menu **6-11-1 Request for Proposal**.

*TIP:* You can set up RFPs to be numbered sequentially with an association to a job and phase.

**About file and link Attachments on records**

**What are attachments?**

Attachments provide functionality to attach files and/or Web links to selected records in Sage 100 Contractor. There are two methods for attaching files and links. You can add them individually using the **Attachments window** (Edit > **Attachments**), or you can simply drag-and-drop files and/or Web links onto a Sage 100 Contractor window that accepts attachments.

A few examples of Sage 100 Contractor windows that accept attachments are payable invoices, requests for proposal, progress bills, change orders, purchase orders, jobs.

**How can I use attachments?**

Here are a few examples:

- After receiving a hard copy document that you would like to attach to a payable invoice record in **4-2 Payable Invoices/Credits**, you scan the document into your computer to create a file, then attach the file to the payable invoice record.
- You have several digital photos of work being done on by a subcontractor on a remodel job. You can transfer these files to your computer, and then attach them to a record in **6-7-1 Subcontracts**.
- After sending an RFP to an architect who has a Web site, you want to attach the architect’s web site URL link to the RFP record. From the open the site in your browser, you drag and drop the link from the browser’s **Address** box onto the **6-11-1 Requests for Proposal** record.

**How does attachment functionality work?**

You create an attachment as either a “local” attachment or a “link” attachment. Link attachments can either be a file or a URL (Web site link).

Creating a “local” attachment, associates the a local file (on your local computer) or a copy of a network file (copied from a network computer) to an Sage 100 Contractor record in your local computer's company data. In this process, the program creates a local folder and subfolder structure in your local company where the record is located.
Creating a “link” attachment, attaches a link to the remote file (on a network computer) or URL link to Web page on a remote computer. The program does not create a local folder and subfolder structure in your local company for linked attachments.

**IMPORTANT:** For link attachments, do not rename an attachment’s file server after attaching a file. Sage 100 Contractor cannot locate a linked file if the file server is renamed or replaced by a server with another name.

**Can I drag and drop files to create attachments?**

If a record accepts attachments, you can drag and drop files onto the window to create an attachment. This includes graphic files, Web links, email messages, desktop shortcuts, or any other file type.

**NOTE:** If you use Microsoft Outlook, you can drag and drop email messages from your Inbox list directly onto a Sage 100 Contractor record.

**Where are attachments located?**

First, let’s look at what happens when you attach a local file to a record. When you add the attachment and save the record, the program creates an Attachments folder and folder structure under \MB7\[company]\Attachments. To prevent naming conflicts between files, each file in placed into a subfolder with a unique name.

For example, let’s suppose you are working in Sample Company job **Jiminez Burrito #8**, and you attach a local graphic file to record **8** in **6-4-1 Change Order, Floor Tile Upgrade**. After saving the record, in Windows Explorer, you will find this path: \MB7\Sample Company\Attachments\Jobs\Change Orders\(unique subfolder name)\(file name).gif.

**TIP:** Sample Company data can be changed on any computer. The Sample Company data in these examples may not match the Sample Company data on your computer exactly.

**What is the attachment parent-child structure?**

You probably noted that the Change Order folder is a subfolder of Jobs. That’s because the program creates Attachments according to the existing parent-child relationships that already exist in the program for Jobs and Change Orders.

For example, the parent record for the change order is the job, **215-Jiminez Burrito #8**. If you were to open, **6-6-1 Purchase Orders** to record **38**, clear the Lock Edit, and add the same graphic file to this record and then look at the folder structure, you will find MB7\Sample Company\Attachments\Jobs\Purchase Orders\(unique subfolder name)\graphic.gif. The attachments to the purchase order record and the change order record are both “children” of job **215—Jiminez Burrito #8**, which is located in **3-5 Jobs (Accounts Receivable)**.

**What do I see when opening parent record when children have attachments?**

You can attach files to both “parent” records and “child” records. For example, you can attach files and links to job **215-Jimenez Burrito #8** directly from that job’s record in **3-5 Jobs (Accounts Receivable)** or to that job through other records such as Change Orders, Purchase Orders, Subcontracts, and so forth. As described above, you can add attachments to records that are children of the job.

Because of the parent-child structure of the program, when you open the Attachments window from the parent window **3-5 Jobs (Accounts Receivable) 215-Jimenez Burrito #8**, you can select different ways to view the Attachment related to this job using the box with the title, **Show items attached to:**

- **this job directly.** If the parent record has attachments, the attachments would be displayed in this list.
- **Purchase Orders for this job.** If a “child” purchase order record of this job has attachments, then the attachments would be displayed in this list.
- **Change Orders for this job.** If a “child” change order record of this job has attachments, then the attachments would be displayed in this list.
How does attaching network files work?

When you select a network file to attach to a record, the program recognizes that it isn't a local file and offers two choices, **Copy the file to my company data** (my local computer), or **Link to the existing file** (on a network computer).

If you select to **Copy the file to my company data**, the program makes a copy of it and places it in a folder\subfolder structure under \MB7\(company)\Attachments\ in its parent-child relationship.

If you select to **Link to the existing file**, the file remains on the network computer. A copy of it is not created, and it does not appear in a folder under \MB7\(company)\Attachments\. In fact, if you never link to a local file or copy a attachment file to your computer, you will never see an Attachments folder under the company folder.

**What happens if I select “Protect this file from being changed”**

After you link to a network file by selecting **Copy the file to your company data**, you have the option to **Protect this file from being changed**. After saving the record, if you were to open the linked file and try to edit it, the program that opens it displays a message stating that the file cannot be changed, is read-only, or something similar. The message displayed depends on the program that opens it.

**NOTE:** If you select the option, **Link to the existing file**, the **Protect this file from being changed** option is unavailable. If you need to prevent an attachment from being changed, select the **Copy file to my company data** option.

**How do I attach Web links?**

When adding a link to a Web page as an attachment, you are encouraged to copy and paste the contents of your browser’s **Address** box (a URL—unique resource locator) into the box on the Add Attachment window. You can type the URL in the box, but it’s much easier to copy and paste it to avoid possible errors from typing mistakes.

**TIP:** Attachments that are Web links are always remote and never appear in an Attachments folder under \MB7\ (company name).

**How do I know that a record has attachments? Are there visual indicators?**

An **Attachment** button has been added to the toolbar. It displays a paper clip against a grey background if the record has no attachments. It displays a paper clip against a white rectangle if the record has attachments. You can click the **Attachments** button to open the **Attachments** window whether the record has attachments or not.

**IMPORTANT:** To provide room for the **Attachments** button, the **Count** button has been removed from the toolbar. On windows that provide the count files functionality, the **Count** command is available from the menu bar.

**Can I email attachments?**

**IMPORTANT:** Emailing attachment functionality only works if Microsoft Outlook is your default Email client.

Yes, just open an **Attachments** window, and select one or more attachments. Click **Email**, and the program opens an email message with the attachments included in the **Attach...** box.

**Can I print Attachments?**

Yes, just open an **Attachments** window, and select an attachment. Click **Print**, and the program opens the file in the program that is controlled by your Windows settings.

**NOTE:** Printing from the **Attachments** window behaves the same as right-clicking the file in Window Explorer and selecting **Print** from the menu.
About Requests for Information

This functionality is available only if you have the Document Control Module.

A request for information (RFI) is a document you send to general contractors, architects, or engineers asking for information. When you receive the information, you can include it in the RFI record. There is a business advantage to adding information about clients or vendors. When you enter such information on a request for information, the document is legally traceable.

The entry in the Client box and Vendor box on the 6-11-2 Requests for Information window are mutually exclusive. On a new request for information record when you enter a client, the vendor entry is cleared and the client address and contact name are automatically placed into the Attention box and Address boxes. Also on a new record, when you enter a vendor, the client information is cleared and replaced with the vendor information.

TIPS:
- To check spelling, click in the text entry areas and then press the F7 key. On the Field Properties Text window, select the Check Spelling check box and click OK.
- You can set up RFIs to be numbered sequentially with an association to a job and phase.

About transmittals

A transmittal is a cover sheet that lists all the documents being sent. The individual to whom you sent the documents signs the transmittal as proof that all the items were received.

There is a business advantage to adding information about clients or vendors. When you enter such information on a transmittal, the document is legally traceable.

The entry in the Client box and Vendor box on the 6-11-3 Transmittal window are mutually exclusive. On a new transmittal record when you enter a client, the vendor entry is cleared and the client address and contact name are automatically placed into the Attention box and Address boxes. Also on a new record, when you enter a vendor, the client information is cleared and replaced with the vendor information.

About submittals

This functionality is available only if you have the Document Control Module.

You can provide submittal documents with all material samples supplied to the general contractor, client, vendor, or architect. The submittal lists each sample you are providing for review. Look for menu command 6-11-4 Submittals.

There is a business advantage to adding information about clients or vendors. When you enter such information on a submittal, the document is legally traceable.

The entry in the Client box and Vendor box on the 6-11-4 Submittals window are mutually exclusive. On a new submittal record, when you enter a client, the vendor entry is cleared and the client address and contact name are automatically placed into the Attention box and Address boxes. Also on a new record, when you enter a vendor, the client information is cleared and replaced with the vendor information.

About plan records

This functionality is available only if you have the Document Control Module.

In the 6-11-5 Plan Records window, you can enter and track the revisions made to plans. In addition, you can track who has received the plans.
**About daily field reports**

This functionality is available only if you have the [Document Control Module](#).

You can track the conditions and events that occur at the job site on a daily basis. You can keep track of the employees and subcontractors working on the job, what equipment was used, and how many units of work were completed. In addition, you can track incidents, meetings, and field orders.

**About punch lists**

This functionality is available only if you have the [Document Control Module](#).

You can create a punch list in the 6-11-7 Punch Lists window. This feature helps you with project reviews at the job site with an architect, engineer, or client inspecting the work, and helps you create a list of items to complete.

**Correspondence**

**About correspondence**

This functionality is available only if you have the [Document Control Module](#).

Documenting correspondence is a very important part of business record keeping. Using the various 6-11-8 Correspondence menu commands, you can write letters and keep records of your correspondence with clients, subcontractors, architects, engineers, and so forth.

For example, if you are having a dispute with vendor about a missed payment or a dispute with a client about a change order, you can use the 6-11-8 Correspondence window features and options to track and record the correspondence with the other party.

There are several useful tools available with the 6-11-8 Correspondence window. You can create Quick Lists for frequently used descriptions and for creating a list of attachments. There is an Edit menu command for creating correspondence notes. On the Options menu, the Routing command tracks to whom the correspondence was sent, the date sent, the expected return date (if any), the date returned, and any notes.

**TIP:** To check spelling, click in the text entry area and then press the F7 key. On the Field Properties Text window, select the Check Spelling check box and click OK.

Like many Sage 100 Contractor windows, the 6-11-8 Correspondence window provides access to the Report Printer window where you can create output such print, print to screen, fax, and email. You can also export the correspondence to Microsoft Excel. In addition, you can schedule the correspondence to be delivered via fax or email.

**7-8 Contact Manager**

**About 7-8 Contact Manager**

Contact Manager allows you to add and update 3-5 Jobs (Accounts Receivable), 3-6 Receivables Clients, and 4-4 Vendors (Accounts Payable) contact records in your Outlook contacts.

The contacts are added in a Sage 100 Contractor folder in Outlook. Updates made in Outlook to those Sage 100 Contractor contacts can be synchronized and saved back to the contact records in Sage 100 Contractor.

**NOTE:** Any contacts added to the Sage 100 Contractor folder that were originated in Outlook cannot be added back into Sage 100 Contractor. Contacts must originate in Sage 100 Contractor.

From this window, you can:
- Manage contacts from multiple companies
- Sync with Outlook
- Sort contacts by contact type, contact record, short name, contact name
- Drill down into single contact record
Chapter 8: Reviewing and Reporting

Working with Review and Reporting

Sage 100 Contractor provides over 1200 reports providing you with many ways to understand your business and to communicate with your clients. Standard reports include selection criteria that allow you to save your personal defaults for repeated use. For quick access to reports that you use often, you can drag them to the Sage 100 Contractor Desktop to create an icon.

You can drill down into special Dashboard reports and from there to the record source. This feature makes getting to the source of financial data just one mouse-click away.

You can also drill down into the 1200 program-wide reports by running a report in print preview, which is available via Print preview and Drilldown (when available) the Print preview and Drilldown (when available) button. With your cursor appearing as a magnifying glass with a red lens, double-clicking rows or fields drills down to report details and records.

Many sections of Sage 100 Contractor have menu links to reports. For example, in 3-Accounts Receivable you find 3-1 Receivable Reports and 3-1-1 Receivable List reports. On the Report Criteria tab in the 3-1-1 Report Printing window, you see a list of 17 reports. With a report selected, you can then click the Samples tab to view a sample of that report.

You can use 13-3 Report Writer to create your own reports. As a starting point, you can modify many of the standard reports to fit your own needs.

From any window with report scheduling functionality, you can schedule the automatic delivery of reports to customers, subcontractors, and suppliers via fax and email.

Using the tools in 13-5 Form/Report Page Design, you can customize the reports to your company’s design requirements. You can change the look of any document to fit your needs so that you will not have to purchase expensive, pre-printed forms.

For a list of all the Sage 100 Contractor reports, see Appendix B, Sage 100 Contractor Reports, see Appendix B: Sage 100 Contractor Reports.

Selecting and Creating Reports

Sage 100 Contractor provides over 1200 reports providing you with many ways to understand your business and to communicate with your clients. Standard reports include selection criteria that allow you to save your personal defaults for repeated use. For quick access to reports that you use often, you can drag them to the Sage 100 Contractor Desktop to create an icon.

You can drill down into special Dashboard reports and from there to the record source. This feature makes getting to the source of financial data just one mouse-click away.

You can also drill down into the 1200 program-wide reports by running a report in print preview, which is available via Print preview and Drilldown (when available) the Print preview and Drilldown (when available) button. With your cursor appearing as a magnifying glass with a red lens, double-clicking rows or fields drills down to report details and records.

To drill down into report information

- 127 -
Examples of Drilling Down into Report Information

In the following examples, Sage 100 Contractor is running the Sample Company, menu 3-1-3 Receivable Aging, and the 31-Current Job Aging report. The report was run without selection criteria.

Drilling down into rows

A single click on the information reveals whether you are drilling to information contained in a row (notice the arrows at each end of the row) or an individual field. In this case, the first line contains a drillable row in addition to two drillable fields, Job# and Current Retention.

<table>
<thead>
<tr>
<th>Job#</th>
<th>Description</th>
<th>Current + Retention</th>
</tr>
</thead>
<tbody>
<tr>
<td>186</td>
<td>Williams Post Office</td>
<td>149,696.25</td>
</tr>
<tr>
<td>201</td>
<td>Trappen Motel</td>
<td>156,053.48</td>
</tr>
<tr>
<td>207</td>
<td>Wood Elementary School</td>
<td></td>
</tr>
</tbody>
</table>

Double-clicking the row drills down to the job record 186—Williams Post Office in the 3-5 Jobs (Accounts Receivable) window.

Drilling down into fields

Drillable information contained in a single field is depicted differently. In a drillable field, you see arrows at each end of the field. Double-clicking the field opens a grid window that shows the details of the value, as shown in the 31—Job Current Aging—Current + Retention window.

Notice that the grid window displays the value in addition to the values that have been added together to create the drillable field value. At the bottom left corner of the grid window is a Drill Down button. By selecting a grid cell in the A/R Invoices Balance column (9,569.34) and clicking Drill Down, you can drill to the invoice.

From that invoice, you can continue to drill down to information through other reports. In addition, the status bar below the grid displays the selection criteria of the cell when the query selection criteria contains a “Where” clause.

This information can help you understand why certain information is in a grid and (equally as important) why certain information is not in the grid. For example, if you are expecting to see an important invoice on a grid but it’s not showing up, the information in the status bar can show information revealing that the invoice has incorrect status. This allows you to locate the invoice and correct its status.

About report selection criteria

You can use the selection criteria to limit the scope of documents; however, many reports do not require you to use selection criteria. If a criterion is left blank, Sage 100 Contractor does not use the criterion when creating the document.

Specific criteria is required to print checks. You must provide the first check form number, check date, and ledger account number of the checking account.

If a document does not include information that you were expecting, examine the selection criteria. If all the criteria are correct, the scope of the criteria might be too narrow. Try removing some of the criteria.

GAAP-standard reports

Sage 100 Contractor provides several reports to reflect generally accepted accounting principles, or GAAP. These reports include the following:
Viewing reports

You can view a list of reports in three ways:

To view a list of available reports

NOTE: You can view the list of available reports for a particular function or print window from the Report Printing window. Some reports are editable; if so, a Modify Report button appears.

1. Open a Sage 100 Contractor window, for example 3-2 Receivable Invoices/Credits.
2. Select the record you want to view in the data control.
3. In the toolbar, click the Print Records button.
5. Double-click the report you want to view or print.

To view a list of all reports by menu command

NOTE: You can only edit a calculated field on an existing report containing an existing calculated field.

3. If not already selected, select 21-Report List~by Menu.
4. On the tool bar, click Print preview and Drilldown (when available) to view the report.
5. Alternatively, select other printing and export options.

To view the list of all reports by menu option

NOTE: You can only edit a calculated field on an existing report containing an existing calculated field.

If not already selected, select **26-Report List-by Menu Option**.

4. On the tool bar, click **Print preview and Drilldown (when available)** to view the report.

5. Alternatively, select other printing and export options.

### Viewing sample reports

Sage 100 Contractor provides representative samples of most reports that the system produces. These samples are not generated from the sample data but are images for you to view. By viewing sample reports, you can get an idea of the report’s content without having to actually generate the report.

#### To view a sample report

1. Open a Sage 100 Contractor window, for example **4-2 Payable Invoices/Credits**.
2. On the toolbar, click the **Print Records** button.
3. In the **Report Printing** window, click the **Samples** tab.
4. In the reports list, click a report.
5. The sample appears in the right pane.

**NOTE:** Not all reports have a sample. If there is no sample, a message appears: **There is no example available for this report.**

### Working with Quick Reports

Sage 100 Contractor’s Quick Reports feature lets you create simple reports for review. When you view a Quick Report, Sage 100 Contractor displays the report information in a grid.

For example, here are some of the windows in which you can create Quick Reports:

- **1-9 Departments**
- **6-5 Cost Codes**
- **7-3-1 Security Groups**
- **7-3-2 User List**
- **9-8 Board Footage**
- **10-2 Task List**
- **12-3 Inventory Locations**

You can change the font styles in individual cells or for the entire grid. In addition, you can hide columns of information. When you print the report, any information hidden in the **Quick Report** window will not appear on the printed report.

Although you can change the formatting of a Quick Report, the changes are not saved. They are only used for printing a Quick Report. For example, open **6-5 Cost Codes**, and using the **B**, **I**, and **U** buttons located under the menu bar, apply bold, italic, or underline formatting to the contents of cells.

You can hide the columns by right-clicking the column heading and selecting the **Hide Selected Column** command from the drop-down menu. Then click the **Print Records** button. When the **Grid Printing** window opens, click the **Print preview and Drilldown (when available)** button to view a preview of your changes.

In some cases, a grid may display too many columns for the report to fit on a standard-sized piece of paper even in landscape orientation. In such cases, we recommend that you export the quick report to Microsoft Excel, which has the capability to capture all the data on any grid in Sage 100 Contractor.
Setting up a shortcut from a report printing window

To create a shortcut to a specific report:
2. Click the Report Criteria tab.
3. Select a report.
4. In the lower left of the window, click Create a Shortcut to Selected Report.

GAAP-standard reports

Sage 100 Contractor provides several reports to reflect generally accepted accounting principles, or GAAP. These reports include the following:

- 2-2-0-21 Balance Sheet
- 2-2-0-31 Balance Sheet~This Year/Last Year Comparison
- 2-3-0-21 Income Statement
- 2-3-0-31 Income Statement~Period and YTD
- 2-3-0-32 Income Statement~This Year/Last Year Comparison
- 2-3-0-33 Income Statement~Actual/Budget Comparison
- 2-3-0-41 Dept. Income Statement
- 2-3-0-51 Dept. Income Statement~Period/Year
- 2-3-0-53 Dept. Income Statement~Actual/Budget Comparison
- 2-3-0-71 Income Summary~With Subaccount Detail Period and YTD
- 2-8-0-21 Financial Report
- 2-9-0-21 Statement of Cash Flows

NOTE: The existing reports with the same names in previous versions of Sage 100 Contractor are replaced with these new GAAP-standard reports.

About report selection criteria

You can use the selection criteria to limit the scope of documents; however, many reports do not require you to use selection criteria. If a criterion is left blank, Sage 100 Contractor does not use the criterion when creating the document.

Specific criteria is required to print checks. You must provide the first check form number, check date, and ledger account number of the checking account.

If a document does not include information that you were expecting, examine the selection criteria. If all the criteria are correct, the scope of the criteria might be too narrow. Try removing some of the criteria.

Working with Quick Reports

Sage 100 Contractor’s Quick Reports feature lets you create simple reports for review. When you view a Quick Report, Sage 100 Contractor displays the report information in a grid.

For example, here are some of the windows in which you can create Quick Reports:
1-9 Departments
6-5 Cost Codes
7-3-1 Security Groups
7-3-2 User List
9-8 Board Footage
10-2 Task List
12-3 Inventory Locations

You can change the font styles in individual cells or for the entire grid. In addition, you can hide columns of information. When you print the report, any information hidden in the Quick Report window will not appear on the printed report.

Although you can change the formatting of a Quick Report, the changes are not saved. They are only used for printing a Quick Report. For example, open 6-5 Cost Codes, and using the B, I, and U buttons located under the menu bar, apply bold, italic, or underline formatting to the contents of cells.

You can hide the columns by right-clicking the column heading and selecting the Hide Selected Column command from the drop-down menu. Then click the Print Records button. When the Grid Printing window opens, click the Print preview and Drilldown (when available) button to view a preview of your changes.

In some cases, a grid may display too many columns for the report to fit on a standard-sized piece of paper even in landscape orientation. In such cases, we recommend that you export the quick report to Microsoft Excel, which has the capability to capture all the data on any grid in Sage 100 Contractor.

Dashboard Reports

About the Dashboard

The Sage 100 Contractor Dashboard has been designed to show the state of your company’s finances in real time by displaying information about your company’s financial state.

NOTE: Until you set up Dashboard security, the Dashboard is only available to the supervisor user.

Showing the Dashboard after Login

You can show the Dashboard every time you log into the company, if you have the access.

1 Click the [Dashboard] button.
2 Select the Options menu, and click on [Show Dashboard After Login].

NOTE: If you need to turn off displaying the Dashboard after you log into the company, use the same steps, then verify that [Show Dashboard After Login] is not checked.

Dashboard Sections

The Dashboard is organized into seven sections when first opened. You can add and remove content by clicking the [Add/Remove Content] link.

- Cash Accounts- Displays up to five cash accounts. You can drill down into each of the accounts to review details. You can use the Edit feature to choose which accounts are displayed.
- Cash Position - Displays Total Cash and Receivables. Your Cash Position is the difference between Total Cash + Receivables and Less Current Liabilities.

- Outstanding Change Orders - Displays Change Orders that have not been approved in Less than 30 Days and those that have not been approved in More than 30 Days.

- Receivables - Displays receivable amounts that are Due in 7 Days, Due in 30 Days, Overdue 1-30 days, and Overdue > 30 (more than 30) days.

- Payables - Displays payable amounts that are Due in 7 Days, Due in 30 Days, Overdue 1-30 days, and Overdue > 30 (more than 30) days.

- Income from Operations - Displays Income from This Month, This Quarter, and This Year broken down into three cost categories: Direct/Equip/Shop, Overhead, and Administrative. The final display totals Income from Operations by This Month, This Quarter, and This Year.

- Under-Billed Jobs - Displays under-billed jobs in two ways, by amount and by percentage of contract. You may also choose not to display any under-billed jobs.

### NOTES:
- The Dashboard displays GAAP-standard financial information.
- All negative amounts are displayed in parentheses.
- Amounts that are shown in red indicate items that may need your special attention.

### Refreshing the Dashboard Information

The Dashboard displays the Last refreshed date and time so that you always know if the information is fresh. You can click the Refresh button to refresh the information. In addition, every time you exit and re-launch the Dashboard, Sage 100 Contractor refreshes the information.

You can print the current view of the Dashboard by pressing the Print button on the right side of the toolbar.

### TIPS:
- If you have access to the Dashboard, you can display it at any time by clicking the [Dashboard] button.
- You may need to set up a separate security group with one member if you are the only one who is going to view the Dashboard. You have to be a Supervisor user to set up security groups.
- You can click the [?] link to the right of each section heading to open a detailed Help topic about this area of the Dashboard.

### About Dashboard security

The Dashboard has been created to display and provide access to a great deal of company financial information. It was designed for the benefit of company owners, company executives, and other selected employees. Such a detailed presentation of financial information is not meant to be accessible to all your employees in your company, although it can be set up that way.

Until you set up security, the Dashboard is only available to the supervisor user. It is best to set up the Dashboard security at the earliest possible opportunity to be able to share your company’s financial information with selected employees.

When a supervisor user launches Sage 100 Contractor, the Dashboard window opens. Upon closing the Dashboard window and until a security option has been selected, Sage 100 Contractor continues to display the Dashboard Security Options window to the supervisor user.
About Setting the Security Options Globally

Selecting Set Dashboard Security in the Options menu opens the Form Level Security window. Selecting one or more check boxes from the security groups list allows the members of that security group to view the Dashboard. Clicking OK sets security for the Dashboard.

NOTE: You may need to set up a new security group just for the Dashboard. For details, see About Security Groups.

About Setting the Security Options by Dashboard Tab

Clicking on the Add/Remove Content link in the Dashboard allows you to set the security by Dashboard tab for the General Ledger, Payables, Receivables, and Projects tabs. You can go to each tab and click on the Security link to choose the security groups allowed access to this tab. Clicking the OK button saves the security choice for all panels that are on the tab currently displayed.

NOTE: Security for adding panels is enforced. If a non-supervisor user tries to add a panel from a tab where they are not a member of the allowed groups, then a security message is displayed and the dashboard panel is not added.

Changing the Security Settings

As your business grows, you may need to change your security settings. You can access the Form Level Security window at any time from the Dashboard by pressing the F7 key or by clicking the Security link in the General Ledger, Payables, Receivables, or Projects tabs for tab level security. Selecting or unselecting check boxes in the Form Level Security window will change access for members of that security group to view the Dashboard.

About General Ledger content in the Dashboard

You can add or remove the following content panels from the General Ledger tab by clicking the Add/Remove Content link on the Dashboard.

- Cash Accounts
- Cash Position
- Income from Operations
- Income and Expenses
- Previous Year Income Comparison
- Previous Year Expense Comparison
- Budget vs. Actual Income
- Budget vs. Actual Expense
- Department Income and Expense
- Department Budget vs. Actual Income
- Department Budget vs. Actual Expense
- Budgeted Expenses

About Cash Accounts on the Dashboard

The Cash Accounts panel displays five selected cash accounts in your list of cash accounts with their balances.

If these five accounts are not the ones you are interested in monitoring, you can click the Edit button to the right of the title heading and select five accounts from your cash accounts list.
TIP: The bottom line in the list of accounts, All Other Cash Accounts, presents the sum of all other existing cash accounts in that company.

About Cash Position on the Dashboard
Displays information on five distinct areas for executive financial review.

The Cash Position section displays numbers representing five distinct areas that merit executive review:

- **Total Cash**—Displays the total for all accounts in the Cash Accounts range.
- **Receivables**—Displays the full balance of the invoices. Because it does not display the net due, it includes retention.
- **Total Cash + Receivables**—Displays the sum of Cash Accounts and Receivables.
- **Less Current Liabilities**—Displays the total for all accounts in the Current Liabilities range.
- **Cash Position**—Displays the difference between Total Cash + Receivables and Less Current Liabilities.

About Income from Operations on the Dashboard
Displays information that summarizes an income statement, excluding the Other Income and After Tax Expense categories.

It displays the information in three ways:

- **This Month**—Displays information that includes all transactions posted to the current period.
- **This Quarter**—Displays information that includes all transactions posted to the current quarter.

  **NOTE:** There is no cutoff within the quarter. If the current period is 4, then activity posted to periods 5 and 6 are included because they are part of the current quarter.

- **This Year**—Displays information that includes all transactions posted to the current fiscal year.

  **NOTE:** There is no cutoff within the year. Any transaction posted to periods 1 through 12 are included.

About Income and Expenses on the Dashboard
Displays the income and expenses by period for the fiscal year.

About Previous Year Income Comparison on the Dashboard
Compare this year's income with last year's income.

About Previous Year Expense Comparison on the Dashboard
Compare this year's expenses with last year's expenses.

About Budget vs. Actual Income on the Dashboard
Compare this year's actual income with their budgeted amounts.

About Budget vs. Actual Expense on the Dashboard
Compare this year's actual expenses with their budgeted amounts.
About Department Income and Expenses on the Dashboard

View incomes and expenses for ledger accounts with departments. You can add this panel more than once for different departments.

NOTE: All departments are selected by default, click the Edit button on the Dashboard to select a specific department. This reports supports multiple instances on the Dashboard.

About Department Budget vs. Actual Income on the Dashboard

Compare this year’s actual income with the departmental budgeted amounts. You can add this panel more than once for different departments.

NOTE: All departments are selected by default, click the Edit button on the Dashboard to select a specific department. This dashboard panel supports multiple instances on the Dashboard.

About Department Budget vs. Actual Expense on the Dashboard

View income and expenses for ledger accounts with departments. You can add this panel more than once for different departments.

NOTE: All departments are selected by default, click the Edit button on the Dashboard to select a specific department. You can add this panel more than once for different departments.

About Budgeted Expenses on the Dashboard

Displays expenses for accounts that have budgets, ranked by percent of budget.

From beginning of the fiscal year through the current accounting period. The budget amount for the current accounting period is prorated, based on today’s date.

NOTE: All future periods are ignored.

About Payables content in the Dashboard

You can add the following content panels from the Payables tab by clicking the Add/Remove Content link on the Dashboard.

- Payables Aging
- Top Vendors
- Expiring Vendor Discounts
- Credit Card Accounts

About Payables on the Dashboard

This section of the Dashboard displays information on invoices with status of:

- 1-Open—Indicates a record posted to the general ledger.
- 2-Review—Indicates the management or bookkeeping staff should review the record.
- 3-Dispute—Indicates a record disputed by the client.

It also displays information about the invoices in four ways:
Invoices Due in 7 Days—Today is the first of the seven days. If today is Sunday, then this number represents the total amount due from and including today, which is Sunday through and including the following Saturday.

Invoices Due in 30 Days—Today is the first of the thirty days. If today is the tenth day of the month, this number represents the total amount due from and including today through and including 29 more days.

Invoices Overdue 1-30 (overdue one to thirty days)—This is the same as an aging report.

Invoices Overdue > 30 (overdue more than thirty days)—This is the same as an aging report. The amount that the Dashboard presents is the sum of AP Invoice Aging report, 31-60, 61-90, and 91—120+ columns.

When reviewing the information contained in this section, it is important to remember that the amounts are “net due;” that is, if retention exists, then it is excluded.

About Payables Aging on the Dashboard

Displays information on invoices with status of:

- 1-Open—Indicates a record posted to the general ledger.
- 2-Review—Indicates the management or bookkeeping staff should review the record.
- 3-Dispute—Indicates a record disputed by the client.

It also displays information about the invoices in four ways:

- Invoices Due in 7 Days—Today is the first of the seven days. If today is Sunday, then this number represents the total amount due from and including today, which is Sunday through and including the following Saturday.
- Invoices Due in 30 Days—Today is the first of the thirty days. If today is the tenth day of the month, this number represents the total amount due from and including today through and including 29 more days.
- Invoices Overdue 1-30 (overdue one to thirty days)—This is the same as an aging report.
- Invoices Overdue > 30 (overdue more than thirty days)—This is the same as an aging report. The amount that the Dashboard presents is the sum of AP Invoice Aging report, 31-60, 61-90, and 91—120+ columns.

\[\text{TIP:}\] Amounts that are shown in red indicate items that may need your special attention.

When reviewing the information contained in this section, it is important to remember that the amounts are “net due.” That is, if retention exists, then it is excluded.

About Credit Card Accounts on the Dashboard

Displays five selected credit card accounts with their balances.

Displays the first five credit card accounts in your list of credit card accounts. If these five accounts are not the ones you are interested in monitoring, you can click the Edit button to the right of the title heading and select five accounts from your credit card accounts list.

\[\text{TIP:}\] The bottom line in the list of accounts, All Other Card Accounts, presents the sum of all other existing cash accounts in that company.

About Top Vendors on the Dashboard

Displays the top 6 vendors based on year-to-date activity. Based on billed amounts for the current fiscal year.

About Expiring Vendor Discounts on the Dashboard

Displays the amounts of vendor discounts that are available this week and next week. Each week ends on Saturday.
About Receivables content in the Dashboard

You can add the following content panels from the Receivables tab, once you click the Add/Remove Content link on the Dashboard.

- Receivables Aging
- Service Receivables Aging
- Job Receivables Aging
- Top Customers by Billing
- Top Service Customers
- Top Customers by $ Owed
- Top Customers by Contract

About Receivables on the Dashboard

This section provides information about receivable invoices with status of:

- **1-Open**—Indicates a record posted to the general ledger.
- **2-Review**—Indicates the management or bookkeeping staff should review the record.
- **3-Dispute**—Indicates a record disputed by the client.

It also displays information about the invoices in four ways:

- Invoices **Due in 7 Days**—Today is the first of the seven days. If today is Sunday, then this number represents the total amount due from and including today, which is Sunday through and including the following Saturday.
- Invoices **Due in 30 Days**—Today is the first of the thirty days. If today is the tenth day of the month, this number represents the total amount due, from today through 29 more days (inclusive).
- Invoices **Overdue 1-30** (overdue one to thirty days)—This is the same as an aging report. The amount that the Dashboard presents is the sum of:
  - AR Invoice Aging report, 1—30 column
  - Service Invoice Aging report, 1—30 column.
- Invoices **Overdue > 30** (overdue more than thirty days)—This is the same as an aging report. The amount that the Dashboard presents is the sum of:
  - AR Invoice Aging report, 31-60, 61-90, and 91—120+ columns, and
  - Service Invoice Aging report, 31-60, 61-90, and 91+ columns.

When reviewing the information contained in this section, it is important to remember that the amounts:

- Are “net due,” that is, retention, if it exists, is excluded.
- Include both Accounts Receivable and Service Receivable invoices.

**TIP:** Amounts that are shown in red indicate items that may need your special attention.

About Receivables Aging on the Dashboard

Displays information about receivable invoices with status of 1-Open, 2-Review, and 3-Dispute.
1-Open—Indicates a record posted to the general ledger.
2-Review—Indicates the management or bookkeeping staff should review the record.
3-Dispute—Indicates a record disputed by the client.

About Service Receivables Aging on the Dashboard
Displays information about service receivable invoices with status of:

1-Open—Indicates a record posted to the general ledger.
2-Review—Indicates the management or bookkeeping staff should review the record.
3-Dispute—Indicates a record disputed by the client.

TIP: Amounts that are shown in red indicate items that may need your special attention.

About Top Customers by Billing on the Dashboard
Displays the total billed for the top 6 customer from job and service billings.

About Top Service Customers on the Dashboard
Displays the top 6 customers from service billings.

About Top Customers by $ Owed on the Dashboard
Displays the top 6 customer balances for both accounts receivables and service receivables.

About Top Customers by Contract on the Dashboard
Displays the top 6 customers based on contract amounts, including approved change orders.

About Projects content in the Dashboard
You can add or remove the following content panels from the Projects tab, once you click the Add/Remove Content link on the Dashboard.

- Under-Billed Jobs
- Outstanding Change Orders
- Job Costs by Cost Type
- Job Contract, Budget, and Cost to Date
- Job Cash Flow to Date
- Job Uncommitted Budget
- Today’s Job Tasks
- Tomorrow’s Job Tasks
- Payable Retention by Job
- Receivable Retention
- Job Hours Over Budget
About Under-Billed Jobs on the Dashboard
Displays the five most under-billed jobs ranked by dollar amount or percentage of contract.

This section of the Dashboard displays the Job Number and Job Name with two ranking criteria:

- The dollar amount that is under-billed.
- The percentage of current contract amount that is under-billed.

To be included in the Under-Billed Jobs display, jobs must have:

- A status of 3-Contract or 4-Current.
- A positive contract amount.
- A budget.

The Under-billed Jobs section displays the five most under-billed jobs ranked by percentage of contract.

Clicking Edit located to the right of the section heading opens the Under-Billed Jobs window.

Clicking Show all in Report opens a report displaying all under-billed jobs. This link is only available if there are more than 5 under-billed jobs.

This window provides options to display jobs:

- Ranked by dollar amount
- Ranked by percentage of contract

TIP: Over/under billing is another name for percentage complete accounting. For more information, see the topic About percentage complete accounting.

About Outstanding Change Orders on the Dashboard
Displays information on change orders that are outstanding Less than 30 days or More than 30 days. Drilling down into either one of these areas displays change orders with statuses of:

- 2-Open—The client has not approved the changes yet. (Only the Prime Change List~Land with Aging report and job status reports reflect the changes.)
- 3-Review—The changes are under review. (Only the Prime Change List~Land with Aging report and job status reports reflect the changes.)
- 4-Disputed—The change order is in dispute.

TIP: Amounts that are shown in red indicate items that may need your special attention.

About Job Costs by Cost Type on the Dashboard
Compare job costs by cost type. You can add this panel more than once for different jobs.

NOTE: User-defined cost types (6-9) are included in the Other category. Default is All jobs, click Edit on this dashboard panel in the Dashboard to select specific jobs. You can also view jobs by job supervisor.

About Job Contract, Budget and Costs to Date on the Dashboard
Displays the job contract, budget, and costs to date for 6 selected jobs. You can add this panel more than once for different job contracts.
NOTE: In the Cost to Date column, the number is shown in red if the cost is greater than the budget.

**About Job Cash Flow to Date on the Dashboard**
This panel displays the net cash flow to date on 6 selected jobs. You can add this panel more than once for different jobs.

**About Job Uncommitted Budget on the Dashboard**
Displays budget, actual and committed costs, and remaining budget for 6 selected jobs. You can add this panel more than once for different job contracts.

This panel allows you to see what the committed costs are on a job. The committed costs are monies that you’ve committed to spend but have not spent yet. The report looks to new or unfilled purchase orders, subcontracts, and payroll records that have not been final-computed. It allows you to determine the percentage of labor burden applied to all open payroll records. It calculates the remaining budget based on the budget plus changes, less costs to date and committed costs.

**About Today’s Job Tasks on the Dashboard**
Displays today’s tasks from a job schedule for a single job.

NOTE: Based on work days.

**About Tomorrow’s Job Tasks on the Dashboard**
Displays tomorrow’s tasks from a job schedule for a single job.

**About Payable Retention by Job on the Dashboard**
Displays retention on jobs from payable invoices. You can add this panel more than once for different jobs.

**About Receivable Retention on the Dashboard**
Displays retention on jobs from receivable invoices. You can add this panel more than once for different jobs.

**About Job Hours Over Budget on the Dashboard**
Displays the top 6 cost codes from a job that are over the budgeted hours. Includes hours from uncomputed payroll records, including daily payroll entries.

**About Alerts content in the Dashboard**
You can add or remove the My Alerts content panel from the Alerts tab by clicking the Add/Remove Content link on the Dashboard.

**About My Alerts on the Dashboard**
This panel is automatically displayed in the top left when you have alert notifications sent to the Dashboard.

NOTE: If you remove the My Alerts content panel from the Dashboard, the next time an alert notification is sent to the Dashboard, the My Alerts panel will automatically be displayed in the top left position.

**All Alerts**
The All Alerts count is the count of all read and unread alert notifications in the Dashboard Alert Viewer.
Unread Alerts
The Unread Alerts count is the count of all unread alert notifications in the Dashboard Alert Viewer.

Form/Report Page Design

About 13-5 Form/Report Page Design

Every report, document, or letter that you generate uses a form design. A form design is a template for the layout of a page or pages. With 13-5 Form/Report Page Design, you can edit any of the form designs supplied with Sage 100 Contractor, or create entirely new forms. You can change the graphic elements and layout of the form, as well as the boilerplate text. This is especially useful when a company has several different businesses, and needs to use different forms for each business.

Before creating a report, it is important to understand how 13-3 Report Writer and Form/Report Page Design work together.

- In 13-5 Form/Report Page Design, you create the page layout for a single page form or a multi-page form that includes text, fields, and calculated fields. Form designs also use a detail box, which indicates where the details of the report will be placed.
- In 13-3 Report Writer, you create the body of the report that appears in the detail box of the form design. In the design of the report details, you can include text, fields, and calculated fields. In addition, you can control when a report prints on a new page or on an entirely new form.

13-5 Form/Report Page Design provides the ability to create multi-page forms. Suppose that you always send a cover letter with each proposal to potential clients. You can incorporate both the cover letter and the proposal forms in a single design. Then when you print proposals, the cover letter always prints with the proposal. A form can have up to 100 pages, each of which you can format differently.

- Creating new forms
- Creating new forms using existing forms
- Editing existing forms
- Previewing forms

Creating new forms

NOTE: Be aware that sometimes it is quicker to create a new form from an existing form if you only have to make a few changes or additions.

To create a new form, open 13-5 Form Report/Page Design. The 13-5 Form Report/Page Design window appears and displays a blank page on which you can begin creating your new form.

Creating new forms using existing forms

It may be easier for you to use an existing form to create a new form. For example, in the 3-2 Report Printing window, on the Report Criteria tab, you see a list of reports. When you click a report in the Report Criteria list, the form upon which the report is based is displayed in the Report Form drop-down list.
<table>
<thead>
<tr>
<th>Report</th>
<th>Report Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>21—Receivable Invoice</td>
<td>System.Invoice_AR</td>
</tr>
<tr>
<td>22—Receivable Invoice—with Notes</td>
<td>System.Invoice_AR</td>
</tr>
<tr>
<td>23—Receivable Invoice—Retention</td>
<td>System.Invoice_AR_Retention</td>
</tr>
<tr>
<td>24—Receivable Invoice—Retention; with Notes</td>
<td>System.Invoice_AR_Retention</td>
</tr>
<tr>
<td>31—Receivable Credit</td>
<td>System.Credit_AR</td>
</tr>
</tbody>
</table>

The system forms follow a specific naming pattern, for example, **System.Invoice_AR**. For the new report to appear in Sage 100 Contractor in the area in which you would want it to appear, it must be saved with a similar naming scheme. For example, **YourName.Invoice_AR**. You do not need to preserve "System" in the name, you must retain the .Invoice_AR in the name. The "System" designation is intended to identify the forms that are included with the program installation. Forms that you create or modify should not include "System" in the name.

**NOTE:** Form designs are listed alphabetically in the report form list. To see your new forms listed before the "System" reports, use a name that will appear before the word system.

When you open a system report and save it with a new name, it is saved by default to the \Report Forms folder; however, you can choose to save it in a different folder. If you save it to a different folder, it will not appear in the program.

**To create a new form using an existing form**

1. Open, for example, the 3-2 Receivable Invoices/Credits window.
2. Click the Print Records button.
3. On the 3-2 Report Printing window, in the Report Form list, click the drop-down arrow and select the form design that you want to edit.
4. From the Edit menu, select Form Design.
6. From the File menu, select Save.
7. On the Save File window, name the new form and then click Save.

When you need to make a large number of changes, it might be easier to create a new form from scratch in the 13-5 Form/Report Page Design window.

**Editing existing forms**

**To edit an existing form design in 13-5 Form/Report Page Design**

2. Select File > Open.
3. Select the form design that you want to edit.
5. Select File > Save.

**To edit an existing form design from a Report Printing window**

1. Open any Report Printing window, for example 3-2 Receivable Invoices/Credits.
2. Click the Print Records button.
3 Select the form design that you want to edit.
4 From the **Edit** menu, select **Form Design**.
5 On the **13-5 Form/Report Page Design** window, edit the form.
6 Select **File > Save**.

**Previewing forms**

To preview a form within **13-5 Form/Report Page Design**:
1 From the **13-5 Form/Report Page Design** window, select **Pages > View Page**.

To preview a form from within a **Report Printing** window:
1 Open the report and select the Report Form for preview.
2 Select **Edit > Form Design**.
3 Select **Pages > View Page**.

**Reducing the document size when previewing forms**

When previewing a form, you can reduce the size of a document displayed in the **Screen Review** window.

In the **Screen Review** window, select **View Options**, then select the percentage size (100%, 85%, 70%, or 50%) at which you want to view the report.

**Setting object properties**

When you right-click an object in **13-3 Report Writer** or **13-5 Form/Report Page Design**, you can set its properties.

The **Object Properties** dialog box is specialized for each type of object

- Text Object Properties
- Image Object Properties
- Lines and Boxes Object Properties
- Field Object Properties
- Multiple Object Properties

**Text Object Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>You can:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Select a font to apply to the entire text box.</td>
</tr>
<tr>
<td>Size</td>
<td>Select a font size.</td>
</tr>
<tr>
<td>Bold</td>
<td>Format all text in the text box as bold.</td>
</tr>
<tr>
<td>Underline</td>
<td>Format all text in the text box as underlined.</td>
</tr>
<tr>
<td>Italic</td>
<td>Format all text in the text box as italic.</td>
</tr>
<tr>
<td>Bold Italic</td>
<td>Format all text in the text box as bold italic.</td>
</tr>
<tr>
<td>Text</td>
<td>Edit the text or field that appears in the text box.</td>
</tr>
<tr>
<td>Property</td>
<td>You can:</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Characters</td>
<td>Set the total number of characters that appear in the text box.</td>
</tr>
<tr>
<td>Page</td>
<td>Specify on which page the object appears in 13-5 Form/Report Page Design.</td>
</tr>
<tr>
<td>Top</td>
<td>Specify the absolute position for the top of the object.</td>
</tr>
<tr>
<td>Left</td>
<td>Specify the absolute position for the left side of the object.</td>
</tr>
<tr>
<td>Forecolor</td>
<td>Select the color you want to use for the text.</td>
</tr>
<tr>
<td>Backcolor</td>
<td>Select the color you want to use behind the text in the text box.</td>
</tr>
<tr>
<td>Alignment</td>
<td>Align text to the left or right margin of the text box.</td>
</tr>
</tbody>
</table>

**Image Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>You can:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page</td>
<td>Specify on which page the object appears in 13-5 Form/Report Page Design.</td>
</tr>
<tr>
<td>Top</td>
<td>Specify the absolute position for the top of the image.</td>
</tr>
<tr>
<td>Left</td>
<td>Specify the absolute position for the left side of the image.</td>
</tr>
<tr>
<td>Width</td>
<td>Specify the width of the image.</td>
</tr>
<tr>
<td>Height</td>
<td>Specify the height of the image.</td>
</tr>
<tr>
<td>Image</td>
<td>Specify the path of the image you want to display in the picture box. To select the image, click the detail button.</td>
</tr>
</tbody>
</table>

**Lines and Boxes Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>You can:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line width</td>
<td>Specify the thickness of a drawing line.</td>
</tr>
<tr>
<td>Line type</td>
<td>Specify the type of drawing line you want (Solid, Dash, Dot, Dot-Dash).</td>
</tr>
<tr>
<td>Forecolor</td>
<td>Select the color you want to use for the drawing line.</td>
</tr>
<tr>
<td>Backcolor</td>
<td>Select the color you want to use to fill the interior area of a box.</td>
</tr>
<tr>
<td>Page</td>
<td>Specify on which page the line/box appears in 13-5 Form/Report Page Design.</td>
</tr>
<tr>
<td>Top</td>
<td>Specify the absolute position for the top of the line/box.</td>
</tr>
<tr>
<td>Left</td>
<td>Specify the absolute position for the left side of the line/box.</td>
</tr>
<tr>
<td>Width</td>
<td>Specify the width of the line/box. This property does not appear for vertical lines.</td>
</tr>
<tr>
<td>Height</td>
<td>Specify the height of the line/box. This property does not appear for horizontal lines.</td>
</tr>
</tbody>
</table>

**Field Object Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>You can:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Select a font to apply to the entire text box.</td>
</tr>
<tr>
<td>Property</td>
<td>You can:</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Size</td>
<td>Select a font size.</td>
</tr>
<tr>
<td>Bold</td>
<td>Format all text in the text box as bold.</td>
</tr>
<tr>
<td>Underline</td>
<td>Format all text in the text box as underlined.</td>
</tr>
<tr>
<td>Page</td>
<td>Specify on which page the object appears in <strong>13-5 Form/Report Page Design</strong></td>
</tr>
<tr>
<td>Top</td>
<td>Specify the absolute position for the top of the text box.</td>
</tr>
<tr>
<td>Left</td>
<td>Specify the absolute position for the left side of the text box.</td>
</tr>
<tr>
<td>Width</td>
<td>Specify the width of the text box.</td>
</tr>
<tr>
<td>Height</td>
<td>Specify the height of the text box.</td>
</tr>
<tr>
<td>Forecolor</td>
<td>Select the color you want to use for the text.</td>
</tr>
<tr>
<td>Backcolor</td>
<td>Select the color you want to use behind the text in the text box.</td>
</tr>
<tr>
<td>Format</td>
<td>For special number and date formatting, select the desired format from the list.</td>
</tr>
<tr>
<td>Alignment</td>
<td>Align text to the left or right margin of the text box.</td>
</tr>
<tr>
<td>Characters</td>
<td>Set the total number of characters that appear in the text box.</td>
</tr>
</tbody>
</table>

**Do not print line if the returned value for this field is zero/blank**

Hide a line if the field is blank or returns a zero.

Suppose you create a detail line in a report to print the account number, account name, and the account balance. However, you do not want to include the account on the report if it does not contain a balance. For the balance field, you display the object properties and select the **Do not print line if the value returned for this field is zero/blank** check box. Now, when you generate the report, accounts with no balance or a zero balance do not appear on the report.

**Print a zero if the value is zero (otherwise will print a blank space)**

Display "0" or "0.00" (depending on the format choice for a zero amount) if the field has no value.

**Do not total this field**

Place fields on a group band that is not totaled on the report.

For example, for a report that includes a calculated percentage value on each detail line, you don’t want the total of all the percentage amounts printed on the subtotal and total lines.

---

**Set Properties for All Selected Objects**

<table>
<thead>
<tr>
<th>Property</th>
<th>You can:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Select a font to apply to all the selected text objects.</td>
</tr>
<tr>
<td>Size</td>
<td>Select a font size.</td>
</tr>
<tr>
<td>Bold</td>
<td>Format all the selected text objects as bold.</td>
</tr>
<tr>
<td>Underline</td>
<td>Format all the selected text objects as underlined.</td>
</tr>
<tr>
<td>Property</td>
<td>You can:</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Italic</td>
<td>Format all the selected text objects as italic.</td>
</tr>
<tr>
<td>Bold Italic</td>
<td>Format all the selected text objects as bold italic.</td>
</tr>
<tr>
<td>Forecolor</td>
<td>Select the color you want to use for all the selected objects.</td>
</tr>
<tr>
<td>Backcolor</td>
<td>Select the color you want to use for all the selected objects.</td>
</tr>
<tr>
<td>Line width</td>
<td>Specify the thickness of a line for all the selected line/box objects.</td>
</tr>
<tr>
<td>Line type</td>
<td>Specify the type of line you want (Solid, Dash, Dot, Dot-Dash) for all the selected line/box objects.</td>
</tr>
<tr>
<td>Alignment</td>
<td>Align text to the left or right margin of the text boxes for all the selected text objects.</td>
</tr>
</tbody>
</table>

**Page Layout**

In the Pages > Page Format dialog box, you can set the following options:

- Page Size
- Margins
  - Select the placement of lines
  - Snap to Position Setting
  - Disable or enable a 1/4 Inch Grid to align design elements

**To set the page size**

2. Under Page Size, enter the size of the page on which you want to base your design.
3. Click Save.

**To set the page margins**

2. Under Margins, enter the values for the page margins.
3. Click Save.

**To select the placement of lines**

2. In the status bar area, select the line width and type of line you want to draw.
3. Click in the grid to draw the line and drag the pointer.

**To position objects with snap lines**

2. Under the Layout Tools section, next to Size of snap-to-position grid, click the arrows to select the position, up to 10/16".
3. Click Save.

**To display a quarter-inch grid**
1 In **13-5 Form/Report Page Design**, on the *Pages* menu, click **Page Format**.

2 Under the **Layout Tools** section, click **Show ¼" grid in background**.

3 Click **Save**.

**About form and report page design layout**

In the *Pages > Page Format* dialog box, you can set the following options:

- Page Size
- Margins
- Snap to Position Setting
- Disable or enable a 1/4 Inch Grid to align design elements

**To set the page size**

1 In **13-5 Form/Report Page Design**, on the *Pages* menu, click **Page Format**.

2 Under **Page Size**, enter the size of the page on which you want to base your design.

3 Click **Save**.

**To set the page margins**

1 In **13-5 Form/Report Page Design**, on the *Pages* menu, click **Page Format**.

2 Under **Margins**, enter the values for the page margins.

3 Click **Save**.

**To position objects with snap lines**

1 In **13-5 Form/Report Page Design**, on the *Pages* menu, click **Page Format**.

2 Under the **Layout Tools** section, next to **Size of snap-to-position grid**, click the arrows to select the position, up to 10/16”.

3 Click **Save**.

**To display a quarter-inch grid**

1 In **13-5 Form/Report Page Design**, on the *Pages* menu, click **Page Format**.

2 Under the **Layout Tools** section, click **Show ¼" grid in background**.

3 Click **Save**.

**About fields**

Fields are special codes that instruct Sage 100 Contractor to replace the field with information from a database. For example, you might want to include the job number on a report for payable invoices. You can insert the `ACPINV.JOBNUM` field in the report design. Then, when you generate the report, Sage 100 Contractor fills in the appropriate information for you.

With fields, you can create form designs and report designs to automatically add or update information in your reports and documents. Fields provide you access to data throughout Sage 100 Contractor. Because you can place fields in both report designs and form designs, you need to determine which fields are necessary and then decide where to insert them. It is a good idea to place most all fields in the report design if possible, as this lets you reuse a small number of form designs for a variety of reports.
Like other objects in a form or report design, you can set object properties for fields. When you generate a report or document, Sage 100 Contractor inserts the information indicated by the field. If the database does not contain information requested by the field, Sage 100 Contractor leaves the field blank in the resulting report or document. However, you can set the property of a field to print a zero rather than leaving the field blank.

**Using Report Writer**

**About Report Writer**

**13-3 Report Writer** provides tools that allow you to create custom reports to access information stored in the Sage 100 Contractor databases. With **13-3 Report Writer**, you can modify existing reports or create entirely new reports for your company’s needs.

Before creating a report, it is important to understand how **13-3 Report Writer** and **13-5 Form/Report Page Design** work together. In **13-5 Form/Report Page Design**, you create the page layout for a single page form or a multi-page form that includes text, fields, and calculated fields. Most form designs also have a detail box, which indicates to Sage 100 Contractor where the details of the report will be placed.

In **13-3 Report Writer**, you create the body of the report that appears in the detail box of the form design. In the design of the report details, you can include text, fields, and calculated fields. In addition, you can control when the report prints on a new page or an entirely new form.

**13-3 Report Writer** allows you to associate a specific form design with a report. When you select the report for printing, Sage 100 Contractor automatically selects the associated form design. In addition, you can determine the location of the report in Sage 100 Contractor. You can assign custom reports to **13-4 Report Printing**, or to another window that contains reports similar to the custom report.

You can create new reports from scratch, or you can use existing reports as the basis for new reports. When you display a Sage 100 Contractor report, Sage 100 Contractor copies the report and displays the copy in the **13-3 Report Writer** window. You can then edit, rename, and save the new report.

**Assigning reports to form designs**

When you decide to print a report, Sage 100 Contractor selects the form design you assigned to the report design. You can assign a report design to a specific form or to a group of forms.

Form design uses file name extensions to group similar types of form designs together. To assign a report design to a form design, you need to determine which form design a specific report uses. When you select a report for preview or printing in the **13-4 Report Printing** window, Sage 100 Contractor displays the file name and file name extension of the form design below the Report list.

For example, you create a new report for income statements titled **My Income Statement** and want the new report to use the same form design as the original report for income statements. Having created the report design, assign it a form design to use when Sage 100 Contractor generates the report. In the Form text box, you type report.rpt and save the new report. Later, when you print the **My Income Statement** report, Sage 100 Contractor automatically selects the Report.rpt form design.

Suppose, instead of limiting the report to the Report.rpt form design, you want to be able to select any form design using the .rpt file name extension when printing the **My Income Statement** report. In this situation, use a wildcard in place of the report name and indicate the file name extension.

In the Form text box, type *.rpt to indicate you want all files using the .rpt file name extension, and save the report. When you select the **My Income Statement** report for printing, you will be able to select from all the form designs using the .rpt file name extension.
Saving and naming reports

When you save a report design, Sage 100 Contractor saves it as a file. The file name determines where you will find the report in Sage 100 Contractor. Where form designs use different file name extensions to organize the forms into meaningful groups, all report designs use the .rpf file name extension.

You can assign a custom report to:

- **13-4 Report Printing.** Assign the file any name and save it to the \MB7\Custom Reports folder. You can save an unlimited number of reports to this location.
- **A specific location where similar reports are found.** For example, if you create a new income statement, you might want to make the report available with the other income statements. Each window location can contain up to 20 custom reports.

The filename consists of eight numbers. The first six numbers specify the window location, and the last two numbers are user-defined and must fall between 01 and 20.

The following examples explain how to convert the window locations into the correct naming format:

- You created a new departmental income statement and want to access the report from **2-8-1 Departmental Income Statement.** Convert each menu and submenu number used to arrive at the Departmental Income Statement into a 2-digit number, so the file name becomes 020801. As this is your first custom report in this location, add 01 to the end. The full name of the file becomes 02080101.rpf.
- Some windows in Sage 100 Contractor are not located under two submenus. To indicate the correct report path, add two zeros in the report name to represent the last submenu. For example, you create a new income statement and want to access it from **2-3 Income Statement.** The numbers representing the location become 0203. Because you need six numbers to represent the menu location, add two zeros. The file name then becomes 02030001.rpf.

Report Printing

About report printing

Clicking the Print Records button on many Sage 100 Contractor windows opens a Report Printing window that is pre-loaded with reports specific to the area in which you are working. For example, if you are working in **3-2 Receivable Invoices/Credits,** Sage 100 Contractor opens 3-2 Report Printing.

Report Printing window toolbar

The Report Printing window toolbar buttons provide more versatile tools for working with reports. From right to left:

- **Print records**—Sends the selected report to the default printer or the printer you select from the printer selection drop-down menu.
- **Print preview and Drilldown (when available)**—Opens the selected report in print preview mode with drill-down functionality.
- **Send report data to Excel**—Opens the report in an Excel worksheet.
- **Send report to Word**—Sends the report to an Export to File window. Click Save to open the report in Word as an RTF file. The default Save in folder is the Reports folder under the company folder.
- **Send report as an Outlook email attachment**—Launches Outlook with the report attached to an email message as a PDF file.
Create a PDF file of this report—Sends the report to an Export to File window. Click Save to open the report in Adobe Reader as a PDF file. The default Save in folder is the Reports folder under the company folder.

NOTES:
- Printing reports on legal-sized paper is a special condition.
- Printing Gantt charts works differently than other report printing. For example, you must select a form design with either portrait or landscape orientation. Paper size and the size of the detail section do not matter because the program takes the selected form design elements and resizes them to fit the size of the selected printer page size.
- Email this report—Opens the Email Distribution window which provides the means to send a message through Sage 100 Contractor email functionality.
- Fax this report—Opens the Fax Distribution window which provides the means to send a fax through Sage 100 Contractor faxing functionality. (Requires an installed fax/modem)
- Schedule this report—Opens the Report Scheduling window which provides the means for you to schedule sending the selected report.
- Set the print orientation to landscape or portrait—Becomes available when printing graphs or charts.
- Insert a note into the report—Opens the Notes window, and if the form design contains the field for inserting a note, the text of the note is inserted in the selected report.
- Enter a new record—Clears the selection criteria and resets the form design to the saved default.

Selection criteria and form designs

In the Report Printing window, you can select which report design is printed. Using the selection criteria, you can narrow the scope of a report to provide only the information you need. In addition, you can make changes to a report before printing it.

Report printing allows you to set up printer defaults. Most windows from which you can print have a dedicated Report Printing window. Suppose that you have two printers: a tractor feed printer that is used to only print checks and a laser printer that is used to print all other documents. In the Report Printing window from which you print general ledger checks, you can set the dot matrix printer as the default.

IMPORTANT: Scheduling reports to email, fax, or print will not work if the company data is opened exclusively. If you have a question, you may review the file SARAEventLog.txt found in |Program Files (or Program Files (x86)) \Sage\Sage 100 Contractor to see if a scheduled report has been sent or not and if the company was “opened for exclusive access by another user.”

To print a legal-sized PDF or RTF report:

1. From the printers drop-down menu, select either Sage 100 Contractor RTF Export or Sage 100 Contractor SagePDF Export.
2. From the Size drop-down menu, select Legal.
3. On the right end of the toolbar, click the Print records button.

NOTE: The report, 2-3-0-34 Income Statement–All Periods, must be printed on legal-sized paper to avoid being truncated. One-click printing using the Create a PDF file of this report button on the toolbar, for example, does not print to legal-sized paper even when selected because one-click buttons use the default printer’s default settings, which are typically set to letter-sized paper.
Printing reports to screen—print preview

You can preview reports before you print them by clicking the Print preview and Drilldown (when available) button. It is located on each report printing window on the toolbar in the upper right. It is indicated by the button displaying a magnifying glass.

Viewing reports in print preview also provides the platform for drilling down into report information. When you are viewing a report in print preview and if there is drillable information on that report page, your cursor becomes a magnifying glass. When the lens displays a red circle, you can double-click the row or field to drill down to the details of the report information.

Report Scheduling

About report scheduling

From any Report Printing window, you can open the Report Scheduling window (File > Scheduling). You use this window to:

- Schedule a report to print at a specific time and at a given frequency
- Specify the output options for the report (print, fax, or email)
- Determine to whom it should be sent.

This powerful tool provides the ability to control and manage the flow of your messaging and information directly to your vendors, clients, and employees. In addition, other features also provide a way to send reports and messages to people other than those on your distribution lists.

Under Output Options, you find controls for:

- Printer / File check box—Specify that the report will be printed or saved as a file. Selecting the check box activates the Edit Printer Settings button. Click the button to edit your printer settings.
- Fax check box—Specifies that the report will be faxed. Selecting the check box activates the Edit Fax Settings button. Click the button to edit your fax settings.
- Email check box—Specifies that the report will be attached to an email message. Selecting the check box activates the Edit Email Settings button. Click the button to edit your email settings.

Under Frequency Options, you can specify:

- Daily option
- Weekly option
- Bi-weekly option
- Monthly option
- Time of Day—Select a time of day or type a time of day in the box.

Under Recurrence Options, you find controls for:

- Print report such amount of times
- Repeat printing until such a date
- Print report until the schedule is deleted.

Under Windows Authentication, you find boxes where to enter:
- Windows User ID
- Windows Password

Message for Email / Fax—Type a Subject Line and Message when emailing and faxing reports.

You can view or edit your scheduled reports in the 7-7 Scheduled Reports Manager and see information about your scheduled reports each time a scheduled report, fax, or email message is sent.

**NOTE:** Enter a valid Windows User ID and Windows Password as setup in your business for your user profile. If you do not enter a password or if you enter one that is not valid, the scheduled report will not run. Moreover, under these conditions, you will not receive any notification that the report failed due to an invalid or missing password. If you change your password, any previously scheduled reports must be rescheduled using your Windows User ID and your new Windows Password.

Emailing and Faxing Reports

Using the faxing functionality through the Sage 100 Contractor program requires:

- Installation of the Windows operating system Fax Service component
- A separate installation and setup of a fax modem in your workstation
- Access to an analog phone line.

In addition, you will also have to set up the cover page information and the number of times that the fax re-tries to send.

For more information about installing and setting up your fax modem, refer to the documentation that came with your fax modem. Sage 100 Contractor does not provide support for installing or setting up a fax modem.

For more information about installing the Window operating system Fax Service component, see Installing the Window Fax Services component.

Upgrade to the latest version of Adobe Reader

Adobe Reader supports faxing from Windows. To fax from Sage 100 Contractor, you should download and install the latest version from [http://get.adobe.com/reader/](http://get.adobe.com/reader/).

Disengage automatic updating for Adobe Reader

If you are using the scheduling capability for sending faxes, we recommend that you disengage the automatic “check for updates” capability of Acrobat Reader as it will prevent scheduled reports from completing.

**NOTE:** Instructions disengaging automatic “check for updates” differ from version to version of Adobe Reader. Refer to the Adobe Reader Help for instructions.

Report Scheduling and Email Functionality

**IMPORTANT:** Using the email capability of Sage 100 Contractor requires Microsoft Outlook or access to a simple mail transfer protocol (SMTP) email server.

The Email Settings window provides a way for you to set up email. You can change the selections to accommodate different emailing preferences.

You can access the Email Settings window through:
- Any **Report Printing** window by clicking the **Email** button on the toolbar to open the **Email Distribution** windows. Then, click the **Email Settings** button to open the **Email Settings** window.

- **7-9 Alerts Manager**

- Click on **Settings** in the Dispatch Board, then click on **Email Setup**.

**Sage 100 Contractor and SMTP**

**IMPORTANT:** The SMTP server may be located on your workstation PC, on a server on your company’s network, or at your Internet service provider (ISP). If the email server is local, you may need the assistance of an IT professional to properly identify or set up this capability. If the email server is located at your ISP, you may need contact your ISP for assistance.

Using the ISP’s simple mail transfer protocol (SMTP) server to send email via Sage 100 Contractor typically requires “user authentication” at the SMTP server. An example of an SMTP email server name is smtp.att.sbcglobal.net.

Different ISPs may use different terms when referring to user authentication. In general, however, user authentication means verifying a user’s identity by means of a “user name” and “password.”

In the context of sending email through Sage 100 Contractor using an ISP’s SMTP server, user authentication only refers to verifying the user’s identity at the ISP’s SMTP server. It does not refer to your:

- Sage 100 Contractor user name and password
- Network domain user name and password
- Windows system user name and password.

**NOTE:** We do not provide support for setting up or installing an email server. You set up user authentication and your fax line access dial out number on **7-2 Company Information**.

**About setting up emailing and faxing through Sage 100 Contractor**

Using the faxing functionality through the Sage 100 Contractor program requires:

- Installation of the Windows operating system Fax Service component
- A separate installation and setup of a fax modem in your workstation
- Access to an analog phone line.

In addition, you will also have to set up the cover page information and the number of times that the fax re-tries to send.

For more information about installing and setting up your fax modem, refer to the documentation that came with your fax modem. Sage 100 Contractor does not provide support for installing or setting up a fax modem.

For more information about installing the Windows operating system Fax Service component, see [Installing the Window Fax Services component](#).

**Upgrade to the latest version of Adobe Reader**

Adobe Reader supports faxing from Windows. To fax from Sage 100 Contractor, you should download and install the latest version from [http://get.adobe.com/reader/](http://get.adobe.com/reader/).

**Disable automatic updating for Adobe Reader**

If you are using the scheduling capability for sending faxes, we recommend that you disable the automatic “check for updates” capability of Acrobat Reader as it will prevent scheduled reports from completing.
NOTE: Instructions for disabling automatic “check for updates” differ from version to version of Adobe Reader. Refer to the Adobe Reader Help for instructions.

Report Scheduling and Email Functionality

IMPORTANT: Using the email capability of Sage 100 Contractor requires Microsoft Outlook or access to a simple mail transfer protocol (SMTP) email server.

The Email Settings window provides a way for you to set up email. You can change the selections to accommodate different emailing preferences.

You can access the Email Settings window through:

- Any Report Printing window by clicking the Email button on the toolbar to open the Email Distribution windows. Then, click the Email Settings button to open the Email Settings window.
- 7-9 Alerts Manager
- Click on Settings in the Dispatch Board, then click on Email Setup.

Sage 100 Contractor and SMTP

IMPORTANT: The SMTP server may be located on your workstation PC, on a server on your company’s network, or at your Internet service provider (ISP). If the email server is local, you may need the assistance of an IT professional to properly identify or set up this capability. If the email server is located at your ISP, you may need contact your ISP for assistance.

Using the ISP’s simple mail transfer protocol (SMTP) server to send email via Sage 100 Contractor typically requires “user authentication” at the STMP server. An example of an SMTP email server name is smtp.att.sbcglobal.net.

Different ISPs may use different terms when referring to user authentication. In general, however, user authentication means verifying a user’s identity by means of a “user name” and “password.”

In the context of sending email through Sage 100 Contractor using an ISP’s SMTP server, user authentication only refers to verifying the user’s identity at the ISP’s SMTP server. It does not refer to your:

- Sage 100 Contractor user name and password
- Network domain user name and password
- Windows system user name and password.

NOTE: We do not provide support for setting up or installing an email server. You set up user authentication and your fax line access dial out number on 7-2 Company Information.

Installing the Windows Fax Services component

To fax from Sage 100 Contractor, you must install the Windows Fax Services component:

Vista:
1. Click Start > Control Panel > Programs > Turn Windows features on or off.
2. On the Windows Features window, locate the Windows fax and scan check box, then select it.
3. Click [OK].

Windows 7:
1. Click Start > Control Panel > Programs > Turn Windows features on or off.
2 On the **Windows Features** window, locate **Print and Document Services**, then click on the **Windows fax and scan** check box.

3 Click **[OK]**.

**Windows 8:**

1 Click **Start > All apps > Control Panel > Programs > Turn Windows features on or off.**

2 On the **Windows Features** window, locate **Print and Document Services**, then click on the **Windows fax and scan** check box.

3 Click **[OK]**.

**Windows Server 2012**

Detailed information from Microsoft

### About fax line access selection

The **Fax Line Access Selection** window provides a way for you to set up an alternate dialout number to access an outside phone line. You can change the selections to accommodate different dialing preferences for a computer in another location.

You can access the **Fax Line Access Selection** window through any **Report Printing** window by clicking the **Fax** button on the toolbar to open the **Fax Distribution** window. Click the **Change** button to open the **Fax Line Access Selection** window.

When **Fax using the company default dial out number** is selected, line access selections default from the setting on 7-2 **Company Information**. When you set up and choose **Fax using this alternate dial out number**, then Sage 100 Contractor uses this setup for line selection.

### About fax distribution lists

Fax distribution lists allow you to select contacts from your client, vendor, or employee records, which appear in folders in the **Fax Distribution** window under **Contacts**. For fax contacts to appear in the folders, each category of contact—client, vendor, or employee—must have a fax number entered in **3-6 Receivable Clients**, **4-4 Vendors**, or **5-2-1 Employees**.

If you have scheduled messages to be sent at a certain time, the messages will be faxed to the contacts for each scheduled occurrence.

You can access the **Fax Distribution** window through any report printing window by clicking the **Fax this report** button on the toolbar.

**NOTE:** If there is no fax contact information entered in **3-6 Receivable Clients**, **4-4 Vendors**, or **5-2-1 Employees**, a message will display indicating that there are no records containing the appropriate information.

### Exporting Data to Microsoft Excel

You may need to get data out of a Sage 100 Contractor report, **Quick Report**, **Quick Grid**, or **Find** query and into a Microsoft Excel spreadsheet so that you can add to or reorder the data or combine data from different reports into one document.

In some situations, a grid may be displaying too many columns to be viewed in the **Print to screen** viewer or to be printed, even in landscape orientation. It is just situations that exporting to Microsoft Excel provides a solution. Microsoft Excel has the capability to capture all the data on any grid in Sage 100 Contractor.
IMPORTANT: If you do not have access rights to any data included in the export action, you are notified and no export file is created.

IMPORTANT: If support for Microsoft Excel Object Library is not present on the machine that initiates the export action, you are notified and no further actions are performed.

The exported data includes the following information:

- Company name
- Report title (grid or query name)
- Selection criteria
- Column headers
- Labels
- Data
- Formulas
- User name
- Report number (for example, 3-5-0-21)
- Date and time

The exported data excludes the following information:

- Graphics, lines, double lines, boxes
- Pagination
- Checks

To export report data to Excel
1. From a main window, for example 4-2 Payable Invoices, on the tool bar, click the Print Records button.
3. Select a report that you want to export to Excel.
4. Click the Send report data to Excel button.
5. Your computer launches Excel with a new worksheet populated with the report data.

To export Quick Grid data to Excel
1. Open a Quick Grid window.
2. On the toolbar, click the Print Records button.
4. Click the Send report data to Excel button.
5. Your computer launches Excel with a new worksheet populated with the quick grid data.

To export Find query data to Excel
1. Open a window that supports Find queries.
2. The Query List window opens.
3 Select a query, and click Run.
4 The Run Query window opens.
5 Enter criteria, and click Run.
6 Your computer displays a quick grid populated with the query data.
7 On the tool bar, click the Print Records button.
8 The Report Printing window opens.
9 Click the Send report data to Excel button.
10 Your computer launches Excel with a new worksheet populated with the selected data.

**About exporting to Microsoft Excel**

You may need to get data out of a Sage 100 Contractor report, Quick Report, Quick Grid, or Find query and into a Microsoft Excel spreadsheet so that you can add to or reorder the data or combine data from different reports into one document.

In some situations, a grid may be displaying too many columns to be viewed in the Print to screen viewer or to be printed, even in landscape orientation. It is just situations that exporting to Microsoft Excel provides a solution. Microsoft Excel has the capability to capture all the data on any grid in Sage 100 Contractor.

**IMPORTANT:** If you do not have access rights to any data included in the export action, you are notified and no export file is created.

**IMPORTANT:** If support for Microsoft Excel Object Library is not present on the machine that initiates the export action, you are notified and no further actions are performed.

The exported data includes the following information:

- Company name
- Report title (grid or query name)
- Selection criteria
- Column headers
- Labels
- Data
- Formulas
- User name
- Report number (for example, 3-5-0-21)
- Date and time

The exported data excludes the following information:

- Graphics, lines, double lines, boxes
- Pagination
- Checks
Financial Review

About financial review

At times, financial information is easier to understand when presented in the form of a chart. Sage 100 Contractor can generate charts for you from data in the ledger accounts of the active company. You can then use the charts to review and analyze trends in your company.

You can generate charts on financial data from the current fiscal year, or as a comparison between the current and last fiscal year, for 12 rolling months, or as a comparison between the budgeted costs and actual costs. In addition, you can create line, area, 2-dimensional bar charts, and 3-dimensional bar charts.

After generating a chart, you can print it, save it to file, or copy it to the clipboard so that you can paste the chart in another report or document.

NOTE: On 13-1 Financial Review, when viewing charts, be aware that Mean, Standard Deviation, and Best Fit do not display with bar charts. The statistical methods display as expected only with line and area charts. When working with these statistical methods, select Format > Line or Area, and then select Statistics > Mean, Standard Deviation, or Best Fit.

Financial review—Ratios

Sage 100 Contractor uses the ledger account balances to create the ratio for a fiscal period. Use the ratios to identify long term trends or potential problems.

The list uses standard math symbols, plus (+), minus (−), multiplied by (*), and divided by (/).

The following list provides definitions of menu items under 13-1 Financial Review > Ratio:

- **Current Ratio**—Measures the relationship between the current assets and current liabilities.
  Definition of **Current Ratio**: Current Assets/Current Liabilities by fiscal period.

- **Quick Ratio**—Measures the relationship of liquid assets to current liabilities, indicating the short-term debt paying ability.
  Definition of **Quick Ratio**: (Current Assets – Inventory)/Current Liabilities by fiscal period.

- **Gross Profit/Sales**—Measures the relationship between gross profit and sales dollars.
  Definition of **Gross Profit/Sales**: (Gross Profit + Other Income)/(Total Operating Income + Other Income) by fiscal period.

- **Net Profit/Sales** - Measures the relationship between net profit and sales dollars.
  Definition of **Net Profit/Sales**: Net Income Before Tax/ (Total Operating Income + Other Income) by fiscal period.

- **Net Profit/Equity**—Measures the amount of income earned for each dollar invested.
  Definition of **Net Profit**: (Operating Income + Other Income) – (Direct Expense + Equip/Shop Expense + Overhead Expense + Admin Expense).
  Definition of **Equity**: (Equity + Operating Income + Other Income) – (Direct Expense + Equip/Shop Expense + Overhead Expense + Admin Expense). Note: The Equity amount excludes Owner’s Draw accounts.

- **Current Assets/Total Assets**—Measures the relationship between the short-term assets and long-term assets.
  Definition of **Current Assets**: Cash + Current Assets + WIP.
- Return on Assets—Measures the earning power or the profitability of a company’s assets.

- Debt/Worth - Measures the relationship of debt financing to equity financing, or how much a company is leveraged.
  Definition of Debt: Total liabilities.
  Definition of Worth: Equity + Total Income—(Direct + Shop/Equip + Overhead + Admin Expense).

- Debt/Assets—Measures the percentage of total assets represented by liabilities.
  Definition of Debt: Total liabilities.

- Overhead/Direct Expense—Measures the relationship of overhead expenses to job expenses. Total Indirect Expense/Total Direct Expense.
  Definition of Indirect Expense: Overhead + Administrative Expenses.
  Definition of Direct Expense: Direct +Equipment + Shop Expenses

Financial Review—Trends

Sage 100 Contractor uses the ledger account balances to graph financial trends.

The list uses standard math symbols, plus (+), minus (−), multiplied by (·), and divided by (/).

The following list provides definitions of menu items under 13-1 Financial Review > Trends:

- **Cash**—Charts the balances for all accounts in the cash range by fiscal period. Compares to the 2-4-21 General Ledger report by cash account range and period.

- **A/R**—Charts the Accounts Receivable balance by fiscal period. Compares to the dedicated Accounts Receivable account in 1-7 General Ledger Accounts.

- **A/P**—Charts the Trade Accounts Payable balance by fiscal period. Compares to the dedicated Accounts Payable account in 1-7 General Ledger Accounts.

- **Sales**—Charts the total income. Compare to the Income Statement by period for the Operating Income balance + Other Income balance. Budget numbers by period: compare to menu 1-7 General Ledger Accounts income accounts budgets.

- **Gross Profit**—Charts the Gross Profit + Other Income by fiscal period. Compare to the Gross Profit + Other Income from Income Statement by period.
  Definition of Gross Profit: Operating Income – (Direct Expense + Equip/Shop Expense).

- **Net Profit**—Charts the Net Income before Tax by fiscal period. Compare to the Net Income Before Tax on the Income Statement by period.
  Definition of Net Income: Operating Income + Other Income – Direct & Indirect Expenses.

- **Breakeven Point**—Charts all Expenses by fiscal period. Compare to the Total Direct & Equip/Shop Expenses + Total Indirect Expenses on the Income Statement by period.

- **Working Capital**—Charts Current Assets – Current Liabilities by fiscal period. This trend is often used to secure a line of credit.
  Compare to the Balance Sheet by fiscal period.
  Budget comes from all current assets and liabilities accounts in menu 1-7 General Ledger Accounts.

Financial Review—Statistics

When generating charts, you can use one of the statistical methods provided:
• **Mean**: Calculation derived from the sum of a list of numbers divided by the total number of numbers in a list.

• **Standard Deviation**: Calculation indicating how spread out numbers are from the mean.

• **Best Fit**: Calculation showing a trend line indicated by the values in a series.

On 13-1 Financial Review, when viewing charts, be aware that Mean, Standard Deviation, and Best Fit do not display with bar charts. The statistical methods display as expected only with line and area charts. When working with these statistical methods, select Format > Line or Area, and then select Statistics > Mean, Standard Deviation, or Best Fit.

**Financial review—Ratios**

Sage 100 Contractor uses the ledger account balances to create the ratio for a fiscal period. Use the ratios to identify long term trends or potential problems.

The list uses standard math symbols, plus (+), minus (−), multiplied by ( * ), and divided by (/).

The following list provides definitions of menu items under 13-1 Financial Review > Ratio:

• **Current Ratio**—Measures the relationship between the current assets and current liabilities. Definition of Current Ratio: Current Assets/Current Liabilities by fiscal period.

• **Quick Ratio**—Measures the relationship of liquid assets to current liabilities, indicating the short-term debt paying ability. Definition of Quick Ratio: (Current Assets – Inventory)/Current Liabilities by fiscal period.

• **Gross Profit/Sales**—Measures the relationship between gross profit and sales dollars. Definition of Gross Profit/Sales: (Gross Profit + Other Income)/(Total Operating Income + Other Income) by fiscal period

• **Net Profit/Sales** - Measures the relationship between net profit and sales dollars. Definition of Net Profit/Sales: Net Income Before Tax/(Total Operating Income + Other Income) by fiscal period.

• **Net Profit/Equity**—Measures the amount of income earned for each dollar invested. Definition of Net Profit: (Operating Income + Other Income) – (Direct Expense + Equip/Shop Expense + Overhead Expense + Admin Expense). Definition of Equity: (Equity + Operating Income + Other Income) – (Direct Expense + Equip/Shop Expense + Overhead Expense + Admin Expense). Note: The Equity amount excludes Owner’s Draw accounts.


• **Return on Assets**—Measures the earning power or the profitability of a company’s assets. Definition of Return on Assets: Total Income—Direct + Shop/Equip + Overhead + Admin Expense / Cash + Current Assets + Wip—Accum. Depreciation.

• **Debt/Worth** - Measures the relationship of debt financing to equity financing, or how much a company is leveraged. Definition of Debt: Total liabilities. Definition of Worth: Equity + Total Income—(Direct + Shop/Equip + Overhead + Admin Expense).
• **Debt/Assets**—Measures the percentage of total assets represented by liabilities.  
  Definition of Debt: Total liabilities.  

• **Overhead/Direct Expense**—Measures the relationship of overhead expenses to job expenses. Total Indirect Expense/Total Direct Expense.  
  Definition of Indirect Expense: Overhead + Administrative Expenses.  
  Definition of Direct Expense: Direct +Equipment + Shop Expenses

**Financial Review—Trends**

Sage 100 Contractor uses the ledger account balances to graph financial trends.

The list uses standard math symbols, plus (+), minus (−), multiplied by (∗), and divided by (/).

The following list provides definitions of menu items under **13-1 Financial Review > Trends**:

• **Cash**—Charts the balances for all accounts in the cash range by fiscal period.  
  Compares to the **2-4-21 General Ledger** report by cash account range and period.

• **A/R**—Charts the Accounts Receivable balance by fiscal period.  
  Compares to the dedicated Accounts Receivable account in **1-7 General Ledger Accounts**.

• **A/P**—Charts the Trade Accounts Payable balance by fiscal period.  
  Compares to the dedicated Accounts Payable account in **1-7 General Ledger Accounts**.

• **Sales**—Charts the total income.  
  Compare to the Income Statement by period for the Operating Income balance + Other Income balance.  
  Budget numbers by period: compare to menu 1-7 General Ledger Accounts income accounts budgets.

• **Gross Profit**—Charts the Gross Profit + Other Income by fiscal period.  
  Compare to the Gross Profit + Other Income from Income Statement by period.  
  Definition of Gross Profit: Operating Income – (Direct Expense + Equip/Shop Expense).

• **Net Profit**—Charts the Net Income before Tax by fiscal period.  
  Compare to the Net Income Before Tax on the Income Statement by period.  
  Definition of Net Income: Operating Income + Other Income – Direct & Indirect Expenses.

• **Breakeven Point**—Charts all Expenses by fiscal period.  
  Compare to the Total Direct & Equip/Shop Expenses + Total Indirect Expenses on the Income Statement by period.

• **Working Capital**—Charts Current Assets – Current Liabilities by fiscal period. This trend is often used to secure a line of credit.  
  Compare to the Balance Sheet by fiscal period.  
  Budget comes from all current assets and liabilities accounts in menu **1-7 General Ledger Accounts**.

**Financial Review—Statistics**

When generating charts, you can use one of the statistical methods provided:

• **Mean**: Calculation derived from the sum of a list of numbers divided by the total number of numbers in a list.

• **Standard Deviation**: Calculation indicating how spread out numbers are from the mean.

• **Best Fit**: Calculation showing a trend line indicated by the values in a series.
On **13-1 Financial Review**, when viewing charts, be aware that **Mean**, **Standard Deviation**, and **Best Fit** do not display with bar charts. The statistical methods display as expected only with line and area charts. When working with these statistical methods, select **Format > Line** or **Area**, and then select **Statistics > Mean**, **Standard Deviation**, or **Best Fit**.

**Project Review**

**About project reviews**

At times, project information is easier to understand when presented in the form of a chart. Sage 100 Contractor can generate charts for you from several sources. You can then use the charts to review and analyze trends in your company. You can create several different types of graphs, such as line, area, 2-dimensional bar charts, and 3-dimensional bar charts. After generating a chart, you can print it, save it to file, or copy it to the clipboard so that you can paste the chart in another report or document.

Using the **Graph** option in **13-2 Project Review**, you can generate graphs to analyze the following:

- **Cost/Budget by Type**
  Budget = Job budget + approved budget change orders by cost type.  
  Cost = Job costs by cost type.  (Note that you use the job cost journal by cost type).

- **Cost/Budget by Code** displays job budget + approved budget change orders by cost code.  
  Budget = Job budget plus approved budget change orders by cost code.  
  Cost = Job costs by cost code (Note that you use the job cost journal by cost code).

- **Over/Under by Code**
  Over = Over budget amount by code with positive number above zero.  
  Under = Under budget amount by code with negative number below zero.

- **Gross Profit % by Job** displays (A/R invoices – job costs) / A/R invoices.

- **Gross Profit $ by Job** displays A/R invoices – job costs.

- **Cash Flow** displays A/R invoices – job costs by week.  (Note that one week = 7 days).
Index

1099 71
1099 forms
   about 71
   types 72
   vendor 71

A
Aatrix
   federal and state reports 103
   integration 103
   registration 105

access rights
   supervisor 14
   window and menu-level security 15

account
   clearing 26
   suspense 27-28

accounting
   accounts receivable 35
   general ledger 99

accounts payable
   features 54
   percentage complete accounting 57

accounts receivable
   statements 40

ACH
   about 81

add-on modules
   about 6

advance fiscal year
   what happens in the program 31

advances 78
   about 78

alert notifications 141

Attachments
   about 121
attach Web links 123
drag and drop files 122
functionality 121
network files 123
parent-child 122
printing 123
uses 94, 99, 121
audit
   errors
      about 32
audit books
      about window 32
audit history 33
bid items
   examples of 48
billing
   top customers 139
bonus checks 79
bonuses 79
      about 79
budget
   Budgeted Expenses 136
   versus Actual Expense 135
   versus Actual Income 135
budgets
   about 110
   effect of change orders on 113
calculations
   adding 87
creating standard 85
defaults 91
in employee records 80, 86
in payroll records
  about 75
pre-built standard 84, 93
prevailing-wage jobs
  and non-union shops 75
setup 85
taxes
tables 87, 93, 95
types 88
  1-Deduct from Employee 88, 96
  2-Add to Gross 90, 94, 97
  3-Employer Cost 90, 98
  4-Add-Deduct 91, 99
  5-Accrued Hours 91, 99
Cash Accounts
  Dashboard 134
Cash Position
  Dashboard 135
cash receipts 44
  receivable
    about 44
  certificates and licenses
    vendor 63
change orders
  about 111
  about subcontract change order 115
automatic numbering 114
effect on budgets and proposals 113
entering
  about 113
outstanding 140
upgrade option 111
change period
  about window 31
chart of accounts
  pre-built 18-19
  ranges 22
check transmittals
  report 60
checks
  and bank charges 23
  bonus 79
  checking accounts
    entering direct transfers 26
transferring funds among
about 25
hand-computed 80
joint 66
payroll
    bonus 79
    hand-computed 80
printing vendor 60
two-party 66
classes
lumber
    board footage 130, 132
clearing account 26
create 99
entering transfers 26
clearing accounts
about 25, 27
computer name
determine 99
concepts
    accounting-related
department 23
    job-related
    job 99
contact manager 125
controlling accounts
    about 22
    and subsidiary accounts 22
correspondence
    about 125
cost code
    numbering systems
    about 116
cost codes 130, 132
cost codes and divisions
    about 116
cost to complete
    about 119
    entering
costs
    costs 99
cost type 140
    job costs 99, 140
costs
    codes
    for general contractors 117
    for subcontractors 117
    jobs
    about 110
salaried employees 78
credit card
pay 58
Credit Card Accounts
Dashboard 137
credits
payable
about 55
receivable
about 38
recalculating 38
customer support
knowledgebase 3
customers
contract 139
cycle
symbols 159-162
D
daily field reports
about 125
Dashboard 135-141
about 132
Budget vs. Actual Expense 135
Budget vs. Actual Income 135
Budgeted Expenses 136
Cash Accounts 134
Cash Position 135
Credit Card Accounts 137
Department Budget vs. Actual Expense 136
Department Budget vs. Actual Income 136
Department Income and Expenses 136
Expiring Vendor Discounts 137
Income and Expenses 135
Income from Operations 135
Job Contract, Budget, and Costs to Date 140
Job Costs by Cost Type 140
Job Uncommitted Budget 141
Outstanding Change Orders 140
Payable Retention by Job 141
Payables 72, 136
Payables Aging 137
Previous Year Expense Comparison 135
Previous Year Income Comparison 135
Receivable Retention 141
Receivables 138
Receivables Aging 138
security 133
Service Receivables Aging 139
Today's Job Tasks 141
Tomorrow's Job Tasks 141
Top Customers by $ Owed 139
Top Customers by Billing 139
Top Customers by Contract 139
Top Service Customers 139
Top Vendors 137
Under-billed Jobs 140
data
  maintenance
general 99
Davis-Bacon Act 75
dedicated accounts 21
department
  income and expenses 136
departments 23, 130, 132, 136
  about 23
deposits
  and interest 24

on jobs 24
details
accounting
general contractor 20
home builder 20
remodeler 20
subcontractor 20
direct deposit
about 81
file 81
information options
account type 18
rate 94
setup 82
direct deposit report
reprint 81
document control
features 120
documentation
conventions 8
Help navigation 2
note styles and meaning 9
using Help 2
documents
job 99
drill down
cash accounts 134
cash position 135
Dashboard 132
income from operations 135
outstanding change orders 140
payables 72, 136
receivables 138
single contact record 125
under-billed jobs 140

E

employees
records
about 74
salaried
job costing 78
equipment
entering
time 99
historical record entry
costs 99
records 124
Excel 156, 158
exclusive access
about 16
expenses
budgeted 136
comparison 135
expiring
vendor discounts 137
exporting
about 120
to Microsoft Excel
about 156, 158

electronic receipts
receivable
about 44
employee license
track 99
employee loans 78
employee positions
about 101
employee training
track 99
fax line access selection 156
fax service component
  Windows 155
features
  accounts payable 54
  add-on modules 6
  document control 120
  general ledger 99
  payroll 74
  utilities 10
federal tax 104
field properties
  locked fields 12
fields 148
  about 148
  locked 12
  properties
  about 12
financial and project reviews
  project reviews 163
financial review 159, 161-162
financial reviews
  ratios 159, 161
Financial Reviews
  trends 160, 162
fiscal year-end
  and posting periods 20
flat rate 41
  entering retention 41
form designs
  13-5 Form-Report Page Design 142
  assigning reports to 149
  creating
    using existing forms 142
  editing
    existing 143
  fields
    about 148
  pages
    about format 148
  previewing 144
  reducing display size 144
  setting object properties 144
  format 144
forms
check 6
tax 6

GAAP-standard reports 128, 131
general ledger 99
deposits
on jobs 24
ledger accounts
about 17
setup
about 19
considerations 18
glossary
fields 148
margin 145
task 130, 132
guides
printing 2
printing
guides 8
Sage 100 Contractor and Your Business 1
User Guide 1

hand-computed checks 80
about 80
Help 2
hours to complete
about 119
importing
about 120
income
comparison 135
install
component
documentation 1
insurance 90, 98
invoices
payable
about 55
credit 55, 73
purchase order sales tax 56
release retention 70
use taxes 56
Workers’ Compensation costs 63
receivable
creating based on contract balance 37
entering 36
recalculating 38
status 35
types 36
voiding 37
IP Address
determine 99

journal transactions 28
about 28
recurring 28, 72

ledger accounts
about 17
account ranges 22
clearing 25, 27
controlling 22
departments 23
numbering 18
posting
payable invoices 58
pre-built chart of accounts 18-19
renaming 18
starting balances 21
subsidary 18, 22
summary 18
ledger balances 33
liability 90, 98
lien waivers
about 61
printing 61

joint checks 65-68
report  60

loan draws

about  51

local payroll taxes

about  88, 102

locked

check box  12

columns  12

fields  12

text boxes  12

lumber

board footage  130, 132

Percent Disposable Income (net)  95

Percent Gross + Paygroup Benefits  95

Percent Gross Pay (unadjusted)  94-95

Percent Other Calculation  94-95

Percent Regular Pay (all hours)  95

Percent Regular Pay (regular hours only)  95

Percent Total Taxable Wages  94-95

Regular/Overtime/Premium (0*, 1*, 1*)  96

Regular/Overtime/Premium (0*, 1.5*, 2*)  96

Regular/Overtime/Premium (1*, 1.5*, 1.5*)  96

Regular/Overtime/Premium (1*, 1.5*, 2*)  96

Regular/Overtime/Premium (1*, 2*, 2*)  96

Tables  95-96

Variable (manual calculation)  96

non-union shops  75

M

manage contacts  125

margin  145

menu-level security

about  15

methods

calculation  88, 90-91, 94, 96-97, 99

Per Day  94, 96

Per Hour (all hours)  96

Per Hour (regular hours only)  96

Per Pay Period  94, 96

N

N
objects
  setting properties 144
operating system
  fax service component 155
Outlook 122, 153, 155

parts
  updating
    costs 99
payable invoice 137
paygroups 101
  benefits 91, 98
payments
  by voucher 62
  vendor
    printing checks 60
    reports 60
payroll
  advances 78
  bonuses 79
  calculations
    types 88

employee loans 78
features 74
hand-computed 80
paygroups 101
post 99
posting 83
  processing
    computing records 81
records
  about 76
  entering 77
  errors 77
  third-party sick pay 80
payroll calculations
  create 85, 99
  maximum only 99
  update calculations 99
percentage complete accounting 57
plan records
  about 124
posting
  payroll 83
    about 83
periods
  about 20
  period 0 archive 24
pre-built chart of accounts 18
  about 19
pre-built standard payroll calculations 84, 93
prevailing-wage jobs
  and non-union shops 75
previous year 135
  expense comparison 135
  income comparison 135
print preview
  reports 152
printing
  checks
    general ledger 99
    vendor 60
lien waivers 61
reports
  about 150
  financial 161-162
progress billing
  about 51
Project Hot List
  about 109
Project Reviews
  statistics 160, 162
Project Work Center
  about 107
  job contact and financial information 108
properties
  setting for objects 144
proposals
  about 119
  creating 120
  effect of change orders on 113
  exporting and importing 120
punch lists
  about 125
purchase orders
  about 117
  master
    about 118
    sales tax on payable invoices 56

quarters 105
R

recalculate 33, 42
Recalculate Balances 33
receivables aging
  job 99
records 124
recurring journal transactions
  about 28
  examples of 28
recurring payables
  about 72
recurring receivables
  about 53
releasing retention
  for jobs 42
removing
  closed purchase orders 118
  paid and void invoices 55
repairing balances 33
report
  direct deposit 81
report printing
  fax line access selection 156

---

report scheduling 152
Report Writer
  about 149
reports 105
  assigning to form designs 149
check transmittals 60
creating
  shortcuts to 131
emailing and faxing
  fax distribution lists 156
faxing and emailing
  setup 153-154
GAAP-standard 128, 131
lien waivers 60
print preview 152
print to screen 152
printing
  about 150
  financial 161-162
saving and naming 150
selection criteria 128, 131
Set to Pay 60
state quarterly 105
vendor payments 58, 60
viewing
  samples 130
requests for information
  about 124
requests for proposal
  about 121
retention 43, 141
  accounts receivable 43
  by job 141
change for jobs 41
entering as a flat rate 41
flat-rate 41
payable
  about 69-70
  paying 69
  releasing 70
receivable 141
  about 43
release 42, 70
release and print statement 42
release for jobs 42
release when complete 42
retention rates 41
  changing for jobs 41
review and reporting 127
  overview 127
RFI
  create 99
RFP
  about 121
  create 99
S
Sage 100 Contractor 1
Sage CRE
  cheques 6
  forms 6
salaried employees
  job costing 78
secondary payees
  about 68
invoices
  adding to existing 66
  decreasing payable amounts 67
  entering 65
  increasing payable amounts 67
security
  access rights 15
Dashboard 133
  features 11
  field properties
    about 12
  groups
    about 11
  menu-level
    about 15
  supervisor user 14
  user names
    about 14
  window-level
    about 15
  window and menu-level 15
service receivable
  records 124
  service receivables
    aging 139
    statements 40
set to pay
  report 60
setting up
  vacation 99
simple mail transfer protocol 153, 155
SMTP 153, 155
starting balances
  about 21
dedicated accounts 21
state quarterly reports 105
state tax 104
statements
  accounts receivable 40
statistics
  Project Reviews 160, 162
subcontracts 121
  about 118
  Workers' Compensation
    rate setup 63
submittals
  about 124
subsidary accounts
  about 22
supervisor user 14
suspense
  accounts 27-28
task 130, 132
tasks
today 141
tomorrow 141
tax forms 104
federal 104
state 104
taxes
sales and use
on payable invoices 56
purchase order sales tax 56
tables
setup 87, 93
templates
saving 150
third-party sick pay
about 80
time and materials billing
about 52
training 6
getting started 6
transactions
cash 44, 160, 162
transferring funds
among checking accounts 25
entering direct transfers 26
transmittals
about 124
trends
Financial Reviews 160, 162
two-party checks 65-68
unitary billing
about 52
unitary proposals
about 120
units to complete
about 119
unprinted checks
find 8
upgrade
change orders 111
user-defined
cost types 140
user names
about 14
users
supervisor 14
utilities
  features 10
  overview 10

vacation 99
valuation methods
  about 21
vendor 58
  payments 58
vendor discounts
  expiring 137
vendor invoices
  select 58
vendors 62, 137
  certificates and licenses
    about 63
  payments 59
    printing checks 60
    reports 60
    select invoice to pay 59
vouchers
  paying by 62

window-level security
  about 15
window and menu-level security
  access rights 15
Windows
  fax service component 155
WIP
  about 56
  accounting 56
  verification 110
Workers’ Compensation
  calculations 100
  codes
    about 116
  rates
    setup for payable invoices 63
  subcontractors 101

year-end close (archiving)
  general ledger 99
year end
  calendar year 30